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Introduction
This manual describes how to connect the Display and the External Device (target PLC).

In this manual, the connection procedure will be described in the sections identified below.

• The below Displays are no longer sold nor maintained by Pro-face. To reduce 
unplanned downtime due to aged hardware and to maximize your cyber security 
environment we recommend replacing your devices with a new, successor model.
For details, please visit our homepage for "Recommended Substitution".
Discontinued from GP-Pro EX 5.00 onwards: GP3000 Series, LT3000 Series, 
ST3000 Series, GP-4100 Series (Monochrome model), PL Series, PS3000/4000 
Series, PE4000 Series.

• For details on the Displays supported by the driver, please check the "Connectable 
Devices" on our website.
http://www.pro-face.com/trans/en/manual/1064.html

1 System Configuration
This section lists the types of External 
Devices and SIO that you can connect.

"2 System Configuration" (page 4)

2 External Device Selection
Select the model (series) of the External 
Device and its connection method.

"3 External Device Selection" (page 12)

3 Communication Settings
This section shows setting examples for 
communicating between the Display and 
the External Device.

"4 Communication Setting" (page 13)

4 Setup Items
This section describes communication 
setup items on the Display.
Set the communication settings of the 
Display with GP-Pro EX or in offline mode.

"5 Setup Items" (page 79)

5 Cable Diagrams
This section shows cables and adapters 
used to connect the Display and the 
External Device.

"6 Cable Diagrams" (page 91)

Operation

http://www.pro-face.com/trans/en/manual/1064.html
http://www.pro-face.com/trans/en/manual/1064.html
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1 General MODBUS SIO Master Driver

The general MODBUS SIO Master Driver is used to connect the Display to a MODBUS-compatible External 

Device for general purpose.

The function code and boundary required for communication can be changed according to the External Device.

Up to 31 units of the External Device can be connected to the Display when one COM port of the Display is used. 

Up to 32 units are available when two or more COM ports are used.
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2 System Configuration

The system configuration in the case when the External Device and the Display are connected is shown.

• External Device used to confirm connection

Series CPU Link I/F SIO Type
Setting 

Example
Cable 

Diagram

MODBUS Slave Device*1

*1 To connect with External Device using the Modbus protocol, configure the [Device Setting] to match the
specifications on the External Device.
Setup Items (page 79)

RS-232C
Setting 
Example 1 
(page 13)

Cable 
Diagram 1 
(page 91)

RS-422/485
 (4 wire)

Setting 
Example 2 
(page 15)

Cable 
Diagram 2 
(page 97)

RS-422/485
 (2 wire)

Setting 
Example 3 
(page 17)

Cable 
Diagram 3 
(page 108)

Series CPU Link I/F SIO Type
Setting 

Example
Cable 

Diagram

MICRO-EHV 
Series by 
Hitachi IES Co., 
Ltd.

MVH-A64
MVH-D64
MVH-A40
MVH-D40
MVL-A64
MVL-D64
MVL-A40
MVL-D40

Communication port on 
OBV-NES

RS-422/485
 (2 wire)

Setting 
Example 4 
(page 19)

Cable 
Diagram 4 
(page 121)

MELSEC-FX 
Series by 
Mitsubishi Electric 
Corporation

FX3S-M/

FX3U-232ADP-MB + 
FX3S-CNV-ADP RS-232C

Setting 
Example 5 
(page 21)

Cable 
Diagram 5 
(page 134)

FX3U-485ADP-MB + 
FX3S-CNV-ADP

RS-422/485
 (4 wire)

Setting 
Example 6 
(page 23)

Cable 
Diagram 6 
(page 136)

RS-422/485
 (2 wire)

Setting 
Example 7 
(page 25)

Cable 
Diagram 7 
(page 144)

MSEP-LC by 
IAI Corporation MSEP-LC SIO connector on 

MSEP-LC RS-232C
Setting 
Example 8 
(page 27)

Cable 
Diagram 8 
(page 157)

RCON Series by 
IAI Corporation

RCON-PC-
RCON-PCF-
RCON-AC-
RCON-DC-
RCON-SC-

SIO port on 
RCON-GW/GWG- RS-232C

Setting 
Example 9 
(page 29)

Cable 
Diagram 8 
(page 157)
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KV-7000 Series by 
KEYENCE 
Corporation

KV-7300 KV-XL402 RS-422/485
 (4 wire)

Setting 
Example 10 
(page 31)

Cable 
Diagram 9 
(page 159)

KV-8000 Series by 
KEYENCE 
Corporation

KV-8000 KV-XL402 RS-422/485
 (4 wire)

Setting 
Example 11 
(page 33)

Cable 
Diagram 9 
(page 159)

CP Series by 
OMRON 
Corporation

CP2E-N14DR-A
CP2E-N14DT-A
CP2E-N14DR-D
CP2E-N14DT-D
CP2E-N14DT1-D
CP2E-N20DR-A
CP2E-N20DT-A
CP2E-N20DR-D
CP2E-N20DT-D
CP2E-N20DT1-D
CP2E-N30DR-A
CP2E-N30DT-A
CP2E-N30DR-D
CP2E-N30DT-D
CP2E-N30DT1-D
CP2E-N40DR-A
CP2E-N40DT-A
CP2E-N40DR-D
CP2E-N40DT-D
CP2E-N40DT1-D
CP2E-N60DR-A
CP2E-N60DT-A
CP2E-N60DR-D
CP2E-N60DT-D
CP2E-N60DT1-D

CP1W-CIF11 RS-422/485
 (4 wire)

Setting 
Example 12 
(page 35)

Cable 
Diagram 10 
(page 165)

CP2W-CIFD2 RS-422/485
 (2 wire)

Setting 
Example 13 
(page 37)

Cable 
Diagram 11 
(page 174)

CP2W-CIFD2 RS-232C
Setting 
Example 14 
(page 39)

Cable 
Diagram 12 
(page 187)

CP2E-S30DR-A
CP2E-S30DT-D
CP2E-S30DT1-D
CP2E-S40DR-A 
CP2E-S40DT-D
CP2E-S40DT1-D
CP2E-S60DR-A
CP2E-S60DT-D
CP2E-S60DT1-D

Built-in RS-422/485 
port

RS-422/485
 (2 wire)

Setting 
Example 13 
(page 37)

Cable 
Diagram 11 
(page 174)

Built-in RS-232C port RS-232C
Setting 
Example 14 
(page 39)

Cable 
Diagram 13 
(page 189)

Series CPU Link I/F SIO Type
Setting 

Example
Cable 

Diagram
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FP0H Series by 
Panasonic 
Industrial Devices 
SUNX Co., Ltd.

AFP0HC32P
AFP0HC32T
AFP0HC32EP
AFP0HC32ET

RS232C port of the 
control unit RS-232C

Setting 
Example 15 
(page 41)

Cable 
Diagram 14 
(page 191)

AFP0HCCS1 RS-232C
Setting 
Example 15 
(page 41)

Cable 
Diagram 15 
(page 193)

AFP0HCCS2 RS-232C
Setting 
Example 15 
(page 41)

Cable 
Diagram 16 
(page 195)

AFP0HCCS1M1

RS-232C
Setting 
Example 15 
(page 41)

Cable 
Diagram 17 
(page 198)

RS-422/485
 (2 wire)

Setting 
Example 16 
(page 43)

Cable 
Diagram 18 
(page 200)

AFP0HCCM1 RS-422/485
 (2 wire)

Setting 
Example 16 
(page 43)

Cable 
Diagram 19 
(page 213)

FREQROL 
FR-A800 Series by 
Mitsubishi Electric 
Corporation

FR-A820-K
FR-A840-K
FR-A842-K
FR-A846-K

RS-485 terminal on the 
Inverter

RS-422/485
 (4 wire)

Setting 
Example 17 
(page 45)

Cable 
Diagram 20 
(page 226)

RS-422/485
 (2 wire)

Setting 
Example 18 
(page 47)

Cable 
Diagram 21 
(page 235)

FREQROL 
FR-F800 Series by 
Mitsubishi Electric 
Corporation

FR-F820-K
FR-F840-K
FR-F842-K
FR-F846-K

RS-485 terminal on the 
Inverter

RS-422/485
 (4 wire)

Setting 
Example 17 
(page 45)

Cable 
Diagram 20 
(page 226)

RS-422/485
 (2 wire)

Setting 
Example 18 
(page 47)

Cable 
Diagram 21 
(page 235)

FREQROL 
A800Pluse Series by 
Mitsubishi Electric 
Corporation

FR-A820-CRN
FR-A840-CRN
FR-A842-CRN
FR-A820-R2R
FR-A840-R2R
FR-A842-R2R

RS-485 terminal on the 
Inverter

RS-422/485
 (4 wire)

Setting 
Example 17 
(page 45)

Cable 
Diagram 20 
(page 226)

RS-422/485
 (2 wire)

Setting 
Example 18 
(page 47)

Cable 
Diagram 21 
(page 235)

FREQROL 
FR-E800 Series by 
Mitsubishi Electric 
Corporation

FR-E820-0.4K-1
FR-E810-K-
FR-E820-K-
FR-E840-K-
FR-E860-K-

PU connector on the 
Inverter

RS-422/485
 (4 wire)

Setting 
Example 19 
(page 49)

Cable 
Diagram 22 
(page 248)

ACD-13A Series by 
Shinko Technos 
Co.,Ltd.

ACD-13A-R/M, C5 Terminal of back panel

RS-422/485
 (2 wire) 
ASCII

Setting 
Example 20 
(page 51)

Cable 
Diagram 23 
(page 252)

RS-422/485
 (2 wire) 
RTU

Setting 
Example 21 
(page 53)

Cable 
Diagram 23 
(page 252)

Series CPU Link I/F SIO Type
Setting 

Example
Cable 

Diagram
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ACR-13A Series by 
Shinko Technos 
Co.,Ltd.

ACR-13A-R/M, C5 Terminal of back panel

RS-422/485
 (2 wire) 
ASCII

Setting 
Example 20 
(page 51)

Cable 
Diagram 23 
(page 252)

RS-422/485
 (2 wire) 
RTU

Setting 
Example 21 
(page 53)

Cable 
Diagram 23 
(page 252)

BC2 Series by 
Shinko Technos 
Co.,Ltd.

BCD2R00-06 Terminal of back panel

RS-422/485
 (2 wire) 
ASCII

Setting 
Example 22 
(page 55)

Cable 
Diagram 23 
(page 252)

RS-422/485
 (2 wire) 
RTU

Setting 
Example 23 
(page 57)

Cable 
Diagram 23 
(page 252)

BCR2R00-06 Terminal of back panel

RS-422/485
 (2 wire) 
ASCII

Setting 
Example 22 
(page 55)

Cable 
Diagram 23 
(page 252)

RS-422/485
 (2 wire) 
RTU

Setting 
Example 23 
(page 57)

Cable 
Diagram 23 
(page 252)

BCS2R00-06 Terminal of back panel

RS-422/485
 (2 wire) 
ASCII

Setting 
Example 24 
(page 59)

Cable 
Diagram 23 
(page 252)

RS-422/485
 (2 wire) 
RTU

Setting 
Example 25 
(page 61)

Cable 
Diagram 23 
(page 252)

PCA1 Series by 
Shinko Technos 
Co.,Ltd.

PCA1R00-200 Terminal of back panel

RS-422/485
 (2 wire) 
ASCII

Setting 
Example 26 
(page 63)

Cable 
Diagram 23 
(page 252)

RS-422/485
 (2 wire) 
RTU

Setting 
Example 27 
(page 65)

Cable 
Diagram 23 
(page 252)

PCB1 Series by 
Shinko Technos 
Co.,Ltd.

PCB1R00-06 Terminal of back panel

RS-422/485
 (2 wire) 
ASCII

Setting 
Example 28 
(page 67)

Cable 
Diagram 23 
(page 252)

RS-422/485
 (2 wire) 
RTU

Setting 
Example 29 
(page 69)

Cable 
Diagram 23 
(page 252)

QTC1-4 Series by 
Shinko Technos 
Co.,Ltd.

QTC1-4PT-
RRRRMMMM-00 Terminal of back panel

RS-422/485
 (2 wire) 
RTU

Setting 
Example 30 
(page 71)

Cable 
Diagram 23 
(page 252)

QTC1-40T-
RRRRMMMM-00

QTC1-4PT-
RRRRMMMM-00

RS-422/485
 (2 wire) 
RTU

Setting 
Example 31 
(page 73)

Cable 
Diagram 23 
(page 252)

QMC1-C50-0
RS-422/485
 (2 wire) 
RTU

Setting 
Example 32 
(page 75)

Cable 
Diagram 24 
(page 265)

QMC1 Series by 
Shinko Technos 
Co.,Ltd.

QMC1-C50-0 RJ45 port
RS-422/485
 (2 wire) 
RTU

Setting 
Example 33 
(page 77)

Cable 
Diagram 24 
(page 265)

Series CPU Link I/F SIO Type
Setting 

Example
Cable 

Diagram
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 Connection Configuration

1:1 Connection

1: n Connection

• Using 1 port

• Using 2 or more ports

Display
External Device

Display

External
Device

External
Device

External
Device

Maximum 31 units

Display

External
Device

External
Device

External
Device Maximum

32 units

External
Device

External
Device

External
Device
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 IPC COM Port
When connecting IPC with an External Device, the COM port used depends on the series and SIO type. Please 

refer to the IPC manual for details.

Usable port

Series
Usable Port

RS-232C RS-422/485(4 wire) RS-422/485(2 wire)

PS-2000B COM1*1 , COM2, 
COM3*1, COM4

*1 The RI/5V can be switched. Use the IPC’s switch to change if necessary.

- -

PS-3450A, PS-3451A,
PS3000-BA, PS3001-BD COM1, COM2*1*2 COM2*1*2 COM2*1*2

PS-3650A (T41 model),
PS-3651A (T41 model) COM1*1 - -

PS-3650A (T42 model),
PS-3651A (T42 model) COM1*1*2, COM2 COM1*1*2 COM1*1*2

PS-3700A (Pentium®4-M)
PS-3710A

COM1*1, COM2*1, 
COM3*2 , COM4

*2 Set up the SIO type with the DIP Switch. Please set up as follows according to SIO type to be used.

COM3*2 COM3*2

PS-3711A COM1*1, COM2*2 COM2*2 COM2*2

PS4000*3 COM1, COM2 - -

PL3000 COM1*1*2, COM2*1, 
COM3, COM4 COM1*1*2 COM1*1*2

PE-4000B Atom N270 COM1, COM2 - -

PE-4000B Atom N2600 COM1, COM2 COM3*4 , COM4*4, 
COM5*4, COM6*4

COM3*4, COM4*4, 
COM5*4, COM6*4

PS5000 (Slim Panel Type 
Core i3 Model) *5 *6 COM1, COM2*4 COM2*4 COM2*4

PS5000 (Slim Panel Type 
Atom Model) 
*5 *6

COM1, COM2*7 COM2*7 COM2*7

PS5000 (Enclosed Panel 
Type)*8 COM1 - -

PS5000 (Modular Type 
PFXPU/PFXPP)*5 *6

PS5000 (Modular Type 
PFXPL2B5-6)

COM1*7 COM1*7 COM1*7

PS5000 (Modular Type 
PFXPL2B1-4) COM1, COM2*7 COM2*7 COM2*7

PS6000 (Advanced Box)
PS6000 (Standard Box) COM1*9 *10 *10

PS6000 (Basic Box) COM1*9 COM1*9 COM1*9
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DIP Switch settings (PL3000 / PS3000 Series)
RS-232C

*3 When making communication between an External Device and COM port on the Expansion slot,
only RS-232C is supported. However, ER (DTR/CTS) control cannot be executed because of the
specification of COM port.
For connection with External Device, use user-created cables and disable Pin Nos. 1, 4, 6 and 9.
Please refer to the IPC manual for details of pin layout.

*4 Set up the SIO type with the BIOS. Please refer to the IPC manual for details of BIOS.

*5 When setting up communication between an External Device and the RS-232C/422/485 interface
module, use the IPC (RS-232C) or PS5000 (RS-422/485) cable diagrams. However, when using
PFXZPBMPR42P2 in a RS-422/485 (4-wire) configuration with no flow control, connect 7.RTS+
and 8.CTS+, and connect 6.RTS- and 9.CTS-.
When using RS-422/485 communication with External Devices, you may need to reduce the
transmission speed and increase the TX Wait time.

*6 To use RS-422/485 communication on the RS-232C/422/485 interface module, the DIP Switch
setting is required. Please refer to "Knowledge Base" (FAQs) on the support site. (http://www.pro-
face.com/trans/en/manual/1001.html)

*7 Set up the SIO type with the DIP Switch. Please refer to the IPC manual for details of DIP Switch.
The BOX Atom has not a switch to set the RS-232C, RS-422/485 mode. Use the BIOS for the
setting.

*8 For the connection with the External Device, on the user-created cable read as if the connector on
the Display-side is a M12 A-coding 8 pin socket. The pin assignment is the same as described in
the cable diagram. For the M12 A-coding connector, use PFXZPSCNM122.

*9 In addition to COM1, you can also use the COM port on the optional interface.

*10 Install the optional interface in the expansion slot.

DIP Switch Setting Description

1 OFF*1

*1 When using PS-3450A, PS-3451A, PS3000-BA and PS3001-BD, turn ON the set value.

Reserved (always OFF)

2 OFF
SIO type: RS-232C

3 OFF

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220)  insertion to SD (TXD): None

6 OFF Terminal resistance (220)  insertion to RD (RXD): None

7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available

8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available

9 OFF
RS (RTS) Auto control mode: Disabled

10 OFF

Settings FAQ ID

PFXZPBMPR42P2, RS422/485 change method FA263858

PFXZPBMPR42P2 termination resistor setting FA263974

PFXZPBMPR44P2, RS422/485 change method FA264087

PFXZPBMPR44P2 termination resistor setting FA264088
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RS-422/485 (4 wire)

RS-422/485 (2 wire)

DIP Switch Setting Description

1 OFF Reserved (always OFF)

2 ON
SIO type: RS-422/485

3 ON

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220)  insertion to SD (TXD): None

6 OFF Terminal resistance (220)  insertion to RD (RXD): None

7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available

8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available

9 OFF
RS (RTS) Auto control mode: Disabled

10 OFF

DIP Switch Setting Description

1 OFF Reserved (always OFF)

2 ON
SIO type: RS-422/485

3 ON

4 OFF Output mode of SD (TXD) data: Always output

5 OFF Terminal resistance (220)  insertion to SD (TXD): None

6 OFF Terminal resistance (220)  insertion to RD (RXD): None

7 ON Short-circuit of SDA (TXA) and RDA (RXA): Available

8 ON Short-circuit of SDB (TXB) and RDB (RXB): Available

9 ON
RS (RTS) Auto control mode: Enabled

10 ON
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3 External Device Selection

Select the External Device to be connected to the Display.

Setup Items Setup Description

Number of Devices/
PLCs Use an integer from 1 to 4 to enter the number of Devices/PLCs to connect to the display.

Manufacturer Select the manufacturer of the External Device to be connected. Select "Modbus-IDA".

Series

Select a model (series) of the External Device to be connected and connection method. Select 
"General MODBUS SIO Master".
In System configuration, check to make sure the external device to which you are connecting 
is supported in "General MODBUS SIO Master".
"2 System Configuration" (page 4)

Port Select the Display port to be connected to the External Device.

Use System Area

Check this option to synchronize the system data area of the Display and the device (memory) 
of the External Device. When synchronized, you can use the External Device’s ladder 
program to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
This feature can also be set in GP-Pro EX or in the Display's offline mode.

Cf. GP-Pro EX Reference Manual "System Settings [Display Unit] - [System 
Area] Settings Guide"

Cf. Maintenance/Troubleshooting Guide "Main Unit - System Area Settings"
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4 Communication Setting

Examples of communication settings of the Display and the External Device, recommended by Pro-face, are 

shown.

4.1 Setting Example 1

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

• Select "NONE" or "ER (DTR/CTS)" for the flow control according to the cable to use.
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 External Device Settings
External Device settings vary depending on the device. Refer to your External Device manual for details.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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4.2 Setting Example 2

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 External Device Settings
External Device settings vary depending on the device. Refer to your External Device manual for details.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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4.3 Setting Example 3

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 External Device Settings
External Device settings vary depending on the device. Refer to your External Device manual for details.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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4.4 Setting Example 4

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 External Device Settings (serial communication port on standard unit)
Use the programming software (Control Editor) for communication settings. Please refer to the manual of the 

External Device for more details.

Procedure

1. Start the programming software and create the project. The project appears in offline mode.

2. In the tree view, from the [CPU Parameters] double-click [Option board settings]. The [Option board settings] 

dialog box appears.

3. Define the settings in the [RS-485 communication] tab as follows, and click [OK].

4. Enter online mode, and transfer the settings to the External Device.

5. Restart the External Device.

Setup Items Setting Remarks

Purpose Modbus Slave

Baudrate 38.4kbps Select the communication speed from one of the following.: 
4.8kbps, 9.6kbps, 19.2kbps, 38.4kbps, 57.6kbps, 115.2kbps

Station No. 1

Format 8-E-1 Data length: 8-bit, None parity, Stop bit: 1-bit

Analog input filter 1

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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4.5 Setting Example 5

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 External Device Settings
Use the ladder software (GX Works2) for communication settings. Write the data to the following special data 

register in the ladder software.

After setting the data, turn the External Device off then back on. Please refer to the manual of the External Device 

for more details.

Special Data 
Register

Setting Remarks

D8400 0x99
Communication Format
Data length: 8-bit, None parity, Stop bit: 1-bit, 
Baud rate (bps): 19200, H/W type: RS232C

D8401 0x11

Protocol
Protocol Selection: MODBUS serial line, 
Master/slave setting: MODBUS Slave, 
RTU/ASCII mode setting: RTU

D8411 0x02 Message to Message Delay

D8414 0x01 Slave Node Address

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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4.6 Setting Example 6

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 External Device Settings
Use the ladder software (GX Works2) for communication settings. Write the data to the following special data 

register in the ladder software.

After setting the data, turn the External Device off then back on. Please refer to the manual of the External Device 

for more details.

Special Data 
Register

Setting Remarks

D8400 0x1099
Communication Format
Data length: 8-bit, None parity, Stop bit: 1-bit, 
Baud rate (bps): 19200, H/W type: RS485

D8401 0x11

Protocol
Protocol Selection: MODBUS serial line, 
Master/slave setting: MODBUS Slave, 
RTU/ASCII mode setting: RTU

D8411 0x02 Message to Message Delay

D8414 0x01 Slave Node Address

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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4.7 Setting Example 7

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 External Device Settings
Use the ladder software (GX Works2) for communication settings. Write the data to the following special data 

register in the ladder software.

After setting the data, turn the External Device off then back on. Please refer to the manual of the External Device 

for more details.

Special Data 
Register

Setting Remarks

D8400 0x1099
Communication Format
Data length: 8-bit, None parity, Stop bit: 1-bit, 
Baud rate (bps): 19200, H/W type: RS485

D8401 0x11

Protocol
Protocol Selection: MODBUS serial line, 
Master/slave setting: MODBUS Slave, 
RTU/ASCII mode setting: RTU

D8411 0x02 Message to Message Delay

D8414 0x01 Slave Node Address

[Equipment Configuration] Tab          [Function Code and Max Query] Tab



General MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 27

4.8 Setting Example 8

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].
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Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

 External Device Settings (serial communication port on standard unit)
Communication settings are fixed, as follows.

Setup Items Setting

Baud rate 115.2 Kbps

Slave address 208

Data length 8 bit

Parity bit None

Start bit 1 bit

Stop bit 1 bit

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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4.9 Setting Example 9

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the MODE selector switch on the RCON-GW and the Parameter Configuration Tool in the IAI GateWay Unit 

Software for defining communication settings. Please refer to the manual of the External Device for more details.

Procedure

1. Set the RCON-GW’s MODE selector switch to "MANU".

2. Start the Parameter Configuration Tool.

3. From SelectGwType, select "RCON".

4. Click [Port Config] to set the COM port to use for communication.

5. Click [OK].

6. Click [Read].

7. Click [Detail setting].

8. From the Axis No.assgnmt / unit config, click [Manual].

To change the axis number assignment and edit the driver unit, click [Change].

9. Set the axis number assignment and click [OK].

10. Click [Write].
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4.10 Setting Example 10

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use ladder software KV STUDIO Ver. 8 or later to define the External Device communication settings. Refer to 

your External Device manual for details.

Procedure

1. Start up the ladder software.

2. From the [File] menu, select [New project] to display the [New project] dialog box.

3. In the [Project name] field enter the project name, in the [PLC model] property select the External Device, and 

click [OK].

4. In the [Confirm unit setting information] dialog box click [Yes], and the [Unit Editor] window will display.

5. On the [Select unit] tab, from the displayed list of units select "[1] KV-XL402", then drag & drop to the unit 

placement area.

6. In the unit placement area click "[1] KV-XL402" and then select the [Setup unit] tab.

7. Configure the setup items as follows.

8. From the [Convert] menu, select [Auto-assign relay/DM].

9. From the [File] menu, select [Close] and display the [Unit Editor] dialog box.

10. Click [Yes].

11. From the [Monitor/Simulator] menu, select [Transfer to PLC] to display the [Transfer Program] dialog box.

12. Select the [Unit setting info] and [Program] check boxes, and then click [Execute]. 

The settings are transferred.

This completes the setting of the External Device.

Setup Items Setup Description

Operation Mode Modbus Slave Mode

Interface RS-422A/485 (4-wire)

Baud Rate 19200bps

Data Bit Length 8 bits (Fixed value)

Start Bit 1 bit (Fixed value)

Stop Bit 1 bit 

Parity Even

Check Sum None (Fixed value)

Modbus slave Station No. setting method Unit Editor

Modbus slave Station No. 1
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4.11 Setting Example 11

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use ladder software KV STUDIO Ver. 8 or later to define the External Device communication settings. Refer to 

your External Device manual for details.

Procedure

1. Start up the ladder software.

2. From the [File] menu, select [New project] to display the [New project] dialog box.

3. In the [Project name] field enter the project name, in the [PLC model] property select the External Device, and 

click [OK].

4. In the [Confirm unit setting information] dialog box click [Yes], and the [Unit Editor] window will display.

5. On the [Select unit] tab, from the displayed list of units select "[1] KV-XL402", then drag & drop to the unit 

placement area.

6. In the unit placement area click "[1] KV-XL402" and then select the [Setup unit] tab.

7. Configure the setup items as follows.

8. From the [Convert] menu, select [Auto-assign relay/DM].

9. From the [File] menu, select [Close] and display the [Unit Editor] dialog box.

10. Click [Yes].

11. From the [Monitor/Simulator] menu, select [Transfer to PLC] to display the [Transfer Program] dialog box.

12. Select the [Unit setting info] and [Program] check boxes, and then click [Execute]. 

The settings are transferred.

This completes the setting of the External Device.

Setup Items Setup Description

Operation Mode Modbus Slave Mode

Interface RS-422A/485 (4-wire)

Baud Rate 9600bps

Data Bit Length 8 bits (Fixed value)

Start Bit 1 bit (Fixed value)

Stop Bit 1 bit 

Parity Even

Check Sum None (Fixed value)

Modbus slave Station No. setting method Unit Editor

Modbus slave Station No. 1
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4.12 Setting Example 12

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
For External Device communication settings, use the ladder software (CX-Programmer).

Refer to your External Device manual for details.

Procedure

1. Start up the ladder software.

2. Select [New] in the [File] menu to display [Change PLC] dialog box.

3. Select External Device in the [Device Type].

4. Click [Settings...] in the [Device Type] to display the [Device Type Settings] dialog box.

5. Select CPU type in the [CPU Type] and click [OK].

6. Select connection type in the [Network Type].

7. Click [OK].

8. Double click [Settings] in the tree view of the work space to display the [PLC Settings] dialog box.

9. Check "Custom" in the [Communications Settings] of the [Serial Port 1] tab.

10. Set the setup items  as below..

11. Close the [PLC Settings] dialog box.

12. Transfer the communication settings to External Device.

13. Reboot the External Device.

Notes

• Do not set the duplicate node address in the same network address group.

Setup Items Setting Value

Baud 9600

Format 8,1,E

Mode Modbus RTU Slave

Modbus Slave Address 1
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4.13 Setting Example 13

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
For External Device communication settings, use the ladder software (CX-Programmer).

Refer to your External Device manual for details.

Procedure

1. Start up the ladder software.

2. Select [New] in the [File] menu to display [Change PLC] dialog box.

3. Select External Device in the [Device Type].

4. Click [Settings...] in the [Device Type] to display the [Device Type Settings] dialog box.

5. Select CPU type in the [CPU Type] and click [OK].

6. Select connection type in the [Network Type].

7. Click [OK].

8. Double click [Settings] in the tree view of the work space to display the [PLC Settings] dialog box.

9. Select the tab for the port to be used, and check "Custom" in the [Communications Settings].

10. Set the setup items as below..

11. Close the [PLC Settings] dialog box.

12. Transfer the communication settings to External Device.

13. Reboot the External Device.

Notes

• Do not set the duplicate node address in the same network address group.

Setup Items Setting Value

Baud 9600

Format 8,1,E

Mode Modbus RTU Slave

Modbus Slave Address 1
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4.14 Setting Example 14

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
For External Device communication settings, use the ladder software (CX-Programmer).

Refer to your External Device manual for details.

Procedure

1. Start up the ladder software.

2. Select [New] in the [File] menu to display [Change PLC] dialog box.

3. Select External Device in the [Device Type].

4. Click [Settings...] in the [Device Type] to display the [Device Type Settings] dialog box.

5. Select CPU type in the [CPU Type] and click [OK].

6. Select connection type in the [Network Type].

7. Click [OK].

8. Double click [Settings] in the tree view of the work space to display the [PLC Settings] dialog box.

9. Select the tab for the port to be used, and check "Custom" in the [Communications Settings].

10. Set the setup items as below..

11. Close the [PLC Settings] dialog box.

12. Transfer the communication settings to External Device.

13. Reboot the External Device.

Notes

• Do not set the duplicate node address in the same network address group.

Setup Items Setting Value

Baud 9600

Format 8,1,E

Mode Modbus RTU Slave

Modbus Slave Address 1
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4.15 Setting Example 15

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the programming software (FPWIN GR7) to set up communication settings on the External Device.

For details on communication settings, please refer to the manual of the External Device.

Procedure

1. Start up the programming software.

2. Select the series for the External Device.

3. Click [OK] to display a new project.

4. From the menu bar, select [Option]-[System register settings...].

5. Click the port ("COM0 Port", "COM1 Port" or "COM2 Port") to be used in [PLC Configuration].

7. Set the each item as follows, and click [OK].

Setup Items Setting Value

Unit No. 1

Communication Mode MODBUS RTU

Modem Enabled Disable

Baud Rate 115200 bps

Communication 
format

Char. Bit 8 bits

Parity Even

Stop Bit 1
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4.16 Setting Example 16

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the programming software (FPWIN GR7) to set up communication settings on the External Device.

For details on communication settings, please refer to the manual of the External Device.

Procedure

1. Start up the programming software.

2. Select the series for the External Device.

3. Click [OK] to display a new project.

4. From the menu bar, select [Option]-[System register settings...].

5. Click the port ("COM0 Port", "COM1 Port" or "COM2 Port") to be used in [PLC Configuration].

7. Set the each item as follows, and click [OK].

Setup Items Setting Value

Unit No. 1

Communication Mode MODBUS RTU

Modem Enabled Disable

Baud Rate 115200 bps

Communication 
format

Char. Bit 8 bits

Parity Even

Stop Bit 1
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4.17 Setting Example 17

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the PU/EXT key, MODE key, M dial and SET key in the operation panel of the CPU unit for External Device 

communication settings.

Refer to your External Device manual for details.

Procedure

1. Turn ON the power supply.

2. Press PU/EXT key to select the PU operation mode.

3. Press MODE key to select the parameter setting mode.

4. Display the setting parameter number with M dial.

5. Press SET key to display the current setting value.

6. Set the setting value with M dial.

7. Press SET key to confirm the setting value.

Setting Parameter 
Number

Setting Value Setup Description

331
(N030) 1 Inverter station number

332
(N031) 1152 RS-485 communication speed

N032 0 RS-485 communication data length:
    8 bits (fixed)

334
(N034) 2

RS-485 communication parity check selection:
    Even parity check available.
    Stop bit length: 1 bit.

549 1 Protocol Selection:
    MODBUS RTU protocol

• Always restart the Eternal Device after changing parameters.
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4.18 Setting Example 18

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the PU/EXT key, MODE key, M dial and SET key in the operation panel of the CPU unit for External Device 

communication settings.

Refer to your External Device manual for details.

Procedure

1. Turn ON the power supply.

2. Press PU/EXT key to select the PU operation mode.

3. Press MODE key to select the parameter setting mode.

4. Display the setting parameter number with M dial.

5. Press SET key to display the current setting value.

6. Set the setting value with M dial.

7. Press SET key to confirm the setting value.

Setting Parameter 
Number

Setting Value Setup Description

331
(N030) 1 RS-485 communication station number:

    Inverter station number

332
(N031) 1152 RS-485 communication speed

N032 0 RS-485 communication data length:
    8 bits (fixed)

334
(N034) 2

RS-485 communication parity check selection:
    Even parity check available.
    Stop bit length: 1 bit.

549 1 Protocol Selection:
    MODBUS RTU protocol

• Always restart the Eternal Device after changing parameters.
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4.19 Setting Example 19

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the PU/EXT key, MODE key, M dial and SET key in the operation panel of the CPU unit for External Device 

communication settings.

Refer to your External Device manual for details.

Procedure

1. Turn ON the power supply.

2. Press PU/EXT key to select the PU operation mode.

3. Press MODE key to select the parameter setting mode.

4. Display the setting parameter number with M dial.

5. Press SET key to display the current setting value.

6. Set the setting value with M dial.

7. Press SET key to confirm the setting value.

Setting Parameter 
Number

Setting Value Setup Description

549
N000 1 Protocol Selection:

    MODBUS RTU protocol

117
N020 1 PU communication station number:

    Inverter station number

118
N021 1152 PU communication speed

120
N024 2

PU communication parity check:
    Even parity check available.
    Stop bit length: 1 bit.

122
N026 0 PU communication check time interval

• Always restart the Eternal Device after changing parameters.
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4.20 Setting Example 20

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the SET key, MODE key, UP key and DOWN key of the External Device for communication settings of the 

External Device.

Please refer to the manual of the External Device for more details.

1. Turn ON the power supply.

Press the SET key 4 times in PV/SV Display Mode.

2. Change to Engineering group.

Press the MODE key.

3. Change to Input group.

Press the SET key multiple times.

4. Change to Communication group.

Press the MODE key.

5. Change to Communication protocol.
Set to “MODA” (MODBUS ASCII protocol) with the UP key or the DOWN key, and press the MODE 
key.

6. Set Instrument number.

Set to “1” with the UP key or the DOWN key, and press the MODE key.

7. Set Communication speed.

Set to “192” (19200 bps) with the UP key or the DOWN key, and press the MODE key.

8. Set Data bit/Parity.

Set to “8EVN” (8 bits/Even) with the UP key or the DOWN key, and press the MODE key.

9. Set Stop bit.

Set to “1” (1 bit) with the UP key or the DOWN key, and press the MODE key.

10. Set SVTC bias.

Press the MODE key.

Completion of setting
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4.21 Setting Example 21

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the SET key, MODE key, UP key and DOWN key of the External Device for communication settings of the 

External Device.

Please refer to the manual of the External Device for more details.

1. Turn ON the power supply.

Press the SET key 4 times in PV/SV Display Mode.

2. Change to Engineering group.

Press the MODE key.

3. Change to Input group.

Press the SET key multiple times.

4. Change to Communication group.

Press the MODE key.

5. Change to Communication protocol.
Set to “MODR” (MODBUS RTU protocol) with the UP key or the DOWN key, and press the MODE 
key.

6. Set Instrument number.

Set to “1” with the UP key or the DOWN key, and press the MODE key.

7. Set Communication speed.

Set to “192” (19200 bps) with the UP key or the DOWN key, and press the MODE key.

8. Set Data bit/Parity.

Set to “8NON” (8 bits/No parity) with the UP key or the DOWN key, and press the MODE key.

9. Set Stop bit.

Set to “1” (1 bit) with the UP key or the DOWN key, and press the MODE key.

10. Set SVTC bias.

Press the MODE key.

Completion of setting
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4.22 Setting Example 22

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the MODE key, UP key key and DOWN key in front of the External Device for communication settings of 

the External Device.

Please refer to the manual of the External Device for more details.

1. Turn ON the power supply.

Press the UP key and the DOWN key (in that order) together for approx. 3 seconds in RUN mode.

2. Change to Engineering Mode 1.

Press the MODE key several times.

3. Change to Communication protocol.
Set to “MODA” (MODBUS ASCII protocol) with the UP key or the DOWN key, and press the MODE 
key.

4. Set Instrument number.

Set to “1” with the UP key or the DOWN key, and press the MODE key.

5. Set Communication speed.

Set to “96” (9600bps) with the UP key or the DOWN key, and press the MODE key.

6. Set Data bit/Parity.

Set to “8EVN” (8 bits/Even) with the UP key or the DOWN key, and press the MODE key.

7. Set Stop bit.

Set to “1” (1 bit) with the UP key or the DOWN key, and press the MODE key.

8. Set Response delay time.

Set to “10” (10 ms) with the UP key or the DOWN key, and press the MODE key several times.

9. Change to RUN mode.

Completion of setting
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4.23 Setting Example 23

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the MODE key, UP key key and DOWN key in front of the External Device for communication settings of 

the External Device.

Please refer to the manual of the External Device for more details.

1. Turn ON the power supply.

Press the UP key and the DOWN key (in that order) together for approx. 3 seconds in RUN mode.

2. Change to Engineering Mode 1.

Press the MODE key several times.

3. Change to Communication protocol.
Set to “MODR” (MODBUS RTU protocol) with the UP key or the DOWN key, and press the MODE 
key.

4. Set Instrument number.

Set to “1” with the UP key or the DOWN key, and press the MODE key.

5. Set Communication speed.

Set to “96” (9600bps) with the UP key or the DOWN key, and press the MODE key.

6. Set Data bit/Parity.

Set to “8EVN” (8 bits/Even) with the UP key or the DOWN key, and press the MODE key.

7. Set Stop bit.

Set to “1” (1 bit) with the UP key or the DOWN key, and press the MODE key.

8. Set Response delay time.

Set to “10” (10 ms) with the UP key or the DOWN key, and press the MODE key several times.

9. Change to RUN mode.

Completion of setting
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4.24 Setting Example 24

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the MODE key, UP key key and DOWN key in front of the External Device for communication settings of 

the External Device.

Please refer to the manual of the External Device for more details.

1. Turn ON the power supply.

Press the UP key and the DOWN key (in that order) together for approx. 3 seconds in RUN mode.

2. Change to Engineering Mode 1.

Press the MODE key several times.

3. Change to Communication protocol.
Set to “MODA” (MODBUS ASCII protocol) with the UP key or the DOWN key, and press the MODE 
key.

4. Set Instrument number.

Set to “1” with the UP key or the DOWN key, and press the MODE key.

5. Set Communication speed.

Set to “192” (19200bps) with the UP key or the DOWN key, and press the MODE key.

6. Set Data bit/Parity.

Set to “8EVN” (8 bits/Even) with the UP key or the DOWN key, and press the MODE key.

7. Set Stop bit.

Set to “1” (1 bit) with the UP key or the DOWN key, and press the MODE key.

8. Set Response delay time.

Set to “10” (10 ms) with the UP key or the DOWN key, and press the MODE key several times.

9. Change to RUN mode.

Completion of setting
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4.25 Setting Example 25

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the MODE key, UP key key and DOWN key in front of the External Device for communication settings of 

the External Device.

Please refer to the manual of the External Device for more details.

1. Turn ON the power supply.

Press the UP key and the DOWN key (in that order) together for approx. 3 seconds in RUN mode.

2. Change to Engineering Mode 1.

Press the MODE key several times.

3. Change to Communication protocol.
Set to “MODR” (MODBUS RTU protocol) with the UP key or the DOWN key, and press the MODE 
key.

4. Set Instrument number.

Set to “1” with the UP key or the DOWN key, and press the MODE key.

5. Set Communication speed.

Set to “192” (19200bps) with the UP key or the DOWN key, and press the MODE key.

6. Set Data bit/Parity.

Set to “8EVN” (8 bits/Even) with the UP key or the DOWN key, and press the MODE key.

7. Set Stop bit.

Set to “1” (1 bit) with the UP key or the DOWN key, and press the MODE key.

8. Set Response delay time.

Set to “10” (10 ms) with the UP key or the DOWN key, and press the MODE key several times.

9. Change to RUN mode.

Completion of setting
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4.26 Setting Example 26

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the SET/RESET key, STOP/MODE key, HOLD/ENTER key, ADVANCE/DOWN key and PATTERN/UP 

key in front of the External Device for communication settings of the External Device.

Please refer to the manual of the External Device for more details.

1. Turn ON the power supply.

Press the SET/RESET key in RUN mode.

2. Change to Group selection mode.

Press the STOP/MODE key 4 times.

3. Change to Engineering setting group.

Press the HOLD/ENTER key.

4. Change to Input parameter setting group.

Press the STOP/MODE key several times.

5. Change to Communication parameter setting group.

Press the HOLD/ENTER key.

6. Change to Communication protocol.
Set to “MODA” (MODBUS ASCII protocol) with the PATTERN/UP key or the ADVANCE/DOWN 
key, and press the HOLD/ENTER key.

7. Set Instrument number.

Set to “1” with the PATTERN/UP key or the ADVANCE/DOWN key, and press the HOLD/ENTER key.

8. Set Communication speed.
Set to “192” (19200 bps) with the PATTERN/UP key or the ADVANCE/DOWN key, and press the 
HOLD/ENTER key.

9. Set Data bit/Parity.
Set to “8EVN” (8 bits/Even) with the PATTERN/UP key or the ADVANCE/DOWN key, and press the 
HOLD/ENTER key.

10. Set Stop bit.
Set to “1” (1 bit) with the PATTERN/UP key or the ADVANCE/DOWN key, and press the HOLD/
ENTER key.

11. Set Response delay time.
Set to “10” (10 ms) with the PATTERN/UP key or the ADVANCE/DOWN key, and press the HOLD/
ENTER key.

Completion of setting
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4.27 Setting Example 27

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab



General MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 66

 External Device Settings
Use the SET/RESET key, STOP/MODE key, HOLD/ENTER key, ADVANCE/DOWN key and PATTERN/UP 

key in front of the External Device for communication settings of the External Device.

Please refer to the manual of the External Device for more details.

1. Turn ON the power supply.

Press the SET/RESET key in RUN mode.

2. Change to Group selection mode.

Press the STOP/MODE key 4 times.

3. Change to Engineering setting group.

Press the HOLD/ENTER key.

4. Change to Input parameter setting group.

Press the STOP/MODE key several times.

5. Change to Communication parameter setting group.

Press the HOLD/ENTER key.

6. Change to Communication protocol.
Set to “MODR” (MODBUS RTU protocol) with the PATTERN/UP key or the ADVANCE/DOWN key, 
and press the HOLD/ENTER key.

7. Set Instrument number.

Set to “1” with the PATTERN/UP key or the ADVANCE/DOWN key, and press the HOLD/ENTER key.

8. Set Communication speed.
Set to “192” (19200 bps) with the PATTERN/UP key or the ADVANCE/DOWN key, and press the 
HOLD/ENTER key.

9. Set Data bit/Parity.
Set to “8NON” (8 bits/No parity) with the PATTERN/UP key or the ADVANCE/DOWN key, and press 
the HOLD/ENTER key.

10. Set Stop bit.
Set to “1” (1 bit) with the PATTERN/UP key or the ADVANCE/DOWN key, and press the HOLD/
ENTER key.

11. Set Response delay time.
Set to “10” (10 ms) with the PATTERN/UP key or the ADVANCE/DOWN key, and press the HOLD/
ENTER key.

Completion of setting
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4.28 Setting Example 28

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the UP key, DOWN key and MODE key in front of the External Device for communication settings of the 

External Device.

Please refer to the manual of the External Device for more details.

1. Turn ON the power supply.

Press the DOWN key and the MODE key (in that order) together for approx. 3 seconds in RUN mode.

2. Change to Engineering setting mode 1.

Press the MODE key several times.

3. Change to Communication protocol.
Set to “MODA” (MODBUS ASCII protocol) with the UP key or the DOWN key, and press the MODE 
key.

4. Set to Instrument number.

Set to “1” with the UP key or the DOWN key, and press the MODE key.

5. Set Communication speed.

Set to “96” (9600bps) with the UP key or the DOWN key, and press the MODE key.

6. Set Data bit/Parity.

Set to “8EVN” (8 bits/Even) with the UP key or the DOWN key, and press the MODE key.

7. Set Stop bit.

Set to “1” (1 bit) with the UP key or the DOWN key, and press the MODE key.

8. Set Response delay time.

Set to “10” (10 ms) with the UP key or the DOWN key, and press the MODE key.

Completion of setting
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4.29 Setting Example 29

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the UP key, DOWN key and MODE key in front of the External Device for communication settings of the 

External Device.

Please refer to the manual of the External Device for more details.

1. Turn ON the power supply.

Press the DOWN key and the MODE key (in that order) together for approx. 3 seconds in RUN mode.

2. Change to Engineering setting mode 1.

Press the MODE key several times.

3. Change to Communication protocol.
Set to “MODR” (MODBUS RTU protocol) with the UP key or the DOWN key, and press the MODE 
key.

4. Set to Instrument number.

Set to “1” with the UP key or the DOWN key, and press the MODE key.

5. Set Communication speed.

Set to “96” (9600bps) with the UP key or the DOWN key, and press the MODE key.

6. Set Data bit/Parity.

Set to “8EVN” (8 bits/Even) with the UP key or the DOWN key, and press the MODE key.

7. Set Stop bit.

Set to “1” (1 bit) with the UP key or the DOWN key, and press the MODE key.

8. Set Response delay time.

Set to “10” (10 ms) with the UP key or the DOWN key, and press the MODE key.

Completion of setting
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4.30 Setting Example 30

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the communication specification selection dip switch and module address selection rotary switch for 

communication settings of the External Device.

Please refer to the manual of the External Device for more details.

Setup Items

• Communication specification selection dip switch

• Module address selection rotary switch

Dip Switch Setting Setup Description

SW1 OFF
Communication speed: 19200bps

SW2 ON

SW3 OFF
Data bit: 8 bits
Parity: None
Stop bit: 1 bit

SW4 OFF

SW5 ON

SW6 OFF Communication protocol: MODBUS specification

SW7 OFF Not used. 
Leave it OFF.SW8 OFF

Setting Setup Description

0 When setting the module address to 1, set it to 0.
This is the same number as [Slave Equipment Address] in the Display.
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4.31 Setting Example 31

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the communication specification selection dip switch and module address selection rotary switch on the 

QTC1-4PT-RRRRMMMM-00 for communication settings of the External Device.

Please refer to the manual of the External Device for more details.

Setup Items

• Communication specification selection dip switch

• Module address selection rotary switch

Dip Switch Setting Setup Description

SW1 OFF
Communication speed: 19200bps

SW2 ON

SW3 OFF
Data bit: 8 bits
Parity: None
Stop bit: 1 bit

SW4 OFF

SW5 ON

SW6 OFF Communication protocol: MODBUS specification

SW7 OFF Not used. 
Leave it OFF.SW8 OFF

Setting Setup Description

0 When setting the module address to 1, set it to 0.
This is the same number as [Slave Equipment Address] in the Display.
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4.32 Setting Example 32

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the communication specification selection dip switch and module address selection rotary switch on the 

QMC1-C50-0 for communication settings of the External Device.

Please refer to the manual of the External Device for more details.

Setup Items

• Communication specification selection dip switch

• Module address selection rotary switch

Dip Switch Setting Setup Description

SW1 ON
Communication speed: 19200bps

SW2 OFF

SW3 OFF Data bit: 8 bits

SW4 ON Parity: None

SW5 OFF Parity: Even

SW6 OFF Stop bit: 1 bit

SW7 OFF Not used. 
Leave it OFF.SW8 OFF

Setting Setup Description

0 When setting the module address to 1, set it to 0.
This is the same number as [Slave Equipment Address] in the Display.
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4.33 Setting Example 33

 GP-Pro EX Settings

Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

[Equipment Configuration] Tab          [Function Code and Max Query] Tab
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 External Device Settings
Use the communication specification selection dip switch and module address selection rotary switch for 

communication settings of the External Device.

Please refer to the manual of the External Device for more details.

Setup Items

• Communication specification selection dip switch

• Module address selection rotary switch

Dip Switch Setting Setup Description

SW1 ON
Communication speed: 19200bps

SW2 OFF

SW3 OFF Data bit: 8 bits

SW4 ON Parity: None

SW5 OFF Parity: Even

SW6 OFF Stop bit: 1 bit

SW7 OFF Not used. 
Leave it OFF.SW8 OFF

Setting Setup Description

0 When setting the module address to 1, set it to 0.
This is the same number as [Slave Equipment Address] in the Display.
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5 Setup Items

Set up the Display’s communication settings in GP-Pro EX or in the Display’s offline mode.

The setting of each parameter must match that of the External Device.

"4 Communication Setting" (page 13)

5.1 Setup Items in GP-Pro EX

 Communication Settings
To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Setup Items Setup Description

SIO Type Select the SIO type for communicating with the External Device.

Speed Select the communication speed between the External Device and the Display.

Data Length Select a data length.

Parity Select how to check parity.

Stop Bit Select a stop bit length.

Flow Control Select the communication control method to prevent overflow of transmission and 
reception data.

Timeout Use an integer from 1 to 127 to enter the time(s) for which the Display waits for the 
response from the External Device.

Retry In case of no response from the External Device, enter how many times the Display 
retransmits the command, from "0 to 255".
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Wait To Send

Enter the standby time (ms) from when the Display receives packets until it transmits the 
next command, from "0 to 5000".
When [RTU] is selected for [Mode] and the check box of the default value is checked, the 
Wait To Send value automatically changes according to the formula below by changing 
each value for Speed/Data Length/Parity/Stop Bit.

Wait To Send (ms) =

Value for the parity setting is shown below.
  No Parity = 0
  Parity Even = 1
  Parity Odd = 1

Mode Select either [RTU] or [ASCII] for the communication mode.

RI/VCC
You can switch between RI/VCC on the 9th pin when you select RS-232C for SIO type.
To connect to the IPC, you need to switch between RI/5V using the IPC selector switch. 
Refer to your IPC manual for details.

• Refer to the GP-Pro EX Reference Manual for Indirect Device.
Cf. GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect 

Device)"

Setup Items Setup Description

3500 x (1 + Data Length + Stop Bit + Parity)
Speed (bps)
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 Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC] 

window, select the external device and click [Settings] . 

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add 

Device] to add another External Device.

• [Equipment Configuration] Tab

Setup Items Setup Description

Slave Equipment Address Use an integer from 1 to 247 to enter the slave address of the External 
Device.

Bit manipulation (set/reset) to 
Holding Register Select how other bits in the same word are handled when you manipulate bits in 

the holding register, from "Clear" or "Do not clear".Rest of the bits in 
this word

IEC61131 Syntax Select this item to use the IEC61131 syntax for variables.
If you check this item, select the address mode from "0-based" or "1-based".

Double Word word order Select the order of storing double word data from "Low word first" or "High 
word first".

Import
Import the device settings described in the xml file.

"  Import Procedure in the Device Setting" (page 85)

Export
Export the device settings into the xml file.

"  Export Procedure in the Device Setting" (page 85)
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• [Function Code and Max Query] Tab (when "Auto adjust to frame length" is selected)

Setup Items Setup Description

Auto adjust to frame length
Automatically set each function code and the boundary for one 
communication according to the frame length.
Function codes cannot be changed. To change a function code, use "Custom".

Frame Length

Set the frame length from "6 to 254".
After setting, click the device list to display the boundary of Read and Write.
Specify the frame length so that the value can be within the range of the 
boundary of Read and Write for the external device to be used.

Import
Import the device settings described in the xml file.

"  Import Procedure in the Device Setting" (page 85)

Export
Export the device settings into the xml file.

"  Export Procedure in the Device Setting" (page 85)

• When "Auto adjust to frame length" is selected, use the following function codes. The read/
write boundary is automatically calculated according to "Frame Length".

• Use "Custom" in the following cases:
• When you use a different function code depending on an address.
• When you use the function code "05: Force Single Coil" or "06: Preset Single Register".
• When the read/write boundary depends on the device.

RTU mode ASCII mode

Device
Function Code

Read Write

Coil 01 0F: Force Multiple Coils

Discrete Input 02 Disabled

Input Register 04 Disabled

Holding Register 03 10: Preset Multiple Register
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• [Function Code and Max Query] Tab (when "Custom" is selected)

Setup Items Setup Description
Custom Manually set each function code and the boundary for one communication.

Add
Add the function code and its data boundary settings.
Up to 20 settings can be added.
Add the settings in the [Add setting] dialog box.

Configuration Change the selected device settings.
Change the settings in the [Configuration setting] dialog box.

Delete Delete the selected device settings.

Import
Import the device settings described in the xml file.

"  Import Procedure in the Device Setting" (page 85)

Export
Export the device settings into the xml file.

"  Export Procedure in the Device Setting" (page 85)
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• [Add setting] Dialog Box / [Configuration setting] Dialog Box

Setup Items Setup Description
Start Address Set the start address of the device.

Range Set the range of the device specified in the start address.

Read Set the function codes to be used for read and the read boundary in one 
communication.

Function Code The function code is assigned by the specified start address.

Boundary The boundary depends on the device. Refer to the following table for details.

Write Set the function code to be used for write and the write boundary in one 
communication.

Function Code The function code depends on the device. Refer to the following table for 
details.

Boundary The boundary depends on the device. Refer to the following table for details.

• When "Custom" is selected, use the following function codes.

• If the set device address is disabled to write, you cannot set the write function code and 
boundary.

• When you select the function code "05" or "06", the write boundary will be fixed to "1", and 
cannot be changed.

Device

Function Code (Boundary)

Read
Write

Multiple Single

Coil 01(2000) 0F: Force Multiple Coils (800) 05: Force Single Coil (Fixed to 
1)

Discrete Input 02(2000) Disabled Disabled

Input Register 04(125) Disabled Disabled

Holding Register 03(125) 10: Preset Multiple Register 
(100)

06: Preset Single Register ( Fixed 
to 1)
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 Import Procedure in the Device Setting

1 Create the xml file based on the following format sample.

• Format sample when "Auto adjust to frame length" is selected

• Format sample when "Custom" is selected

2 Click [Import] on the [Individual Device Settings] dialog box to display the [Open] dialog box.

3 Select the created xml file and click [Open].

Export Procedure in the Device Setting

1 Click [Export] on the [Individual Device Settings] dialog box to display the [Save as] dialog box.

2 Enter a name and click [Save].
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5.2 Setup Items in Offline Mode

Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Equipment Settings] in offline mode. 

Touch the External Device you want to set from the displayed list.

• Refer to the Maintenance/Troubleshooting guide for information on how to enter offline mode 
or about the operation.

Cf. Maintenance/Troubleshooting Guide "Offline Mode"

• The number of the setup items to be displayed for 1 page in the offline mode depends on the 
Display in use. Please refer to the Reference manual for details.

Setup Items Setup Description

SIO Type

Select the SIO type for communicating with the External Device.

In the communication settings, set [SIO Type] correctly according to the serial interface 
specifications of the Display.
If you select an SIO type that the serial interface does not support, proper operation cannot 
be guaranteed.
Refer to your Display manual for details on the serial interface specifications.

Speed Select the communication speed between the External Device and the Display.

Data Length Select a data length.

Parity Select how to check parity.

Stop Bit Select a stop bit length.

Flow Control Select the communication control method to prevent overflow of transmission and 
reception data.
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Device Setting

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Equipment Settings]. Touch the 

External Device you want to set from the displayed list, and touch [Device].

(Page 1/22)

Timeout Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the 
response from the External Device.

Retry In case of no response from the External Device, enter how many times the Display 
retransmits the command, from "0 to 255".

Wait To Send

Enter the standby time (ms) from when the Display receives packets until it transmits the 
next command, from "0 to 5000".
When [RTU] is selected for [Mode] and each value for Speed/Data Length/Parity/Stop Bit 
is changed, set the Wait To Send value calculated with the following formula.

Wait To Send (ms) =

Value for the parity setting is shown below.
  No Parity = 0
  Parity Even = 1
  Parity Odd = 1

Mode Select either [RTU] or [ASCII] for the communication mode.

Setup Items Setup Description

Device/PLC Name Select the External Device to set. The device name is the title of the External 
Device set with GP-Pro EX.(Initial value [PLC1])

Slave Address Use an integer from 1 to 247 to enter the slave address of the External Device.

Bit manipulation to HR
Displays how other bits in the same word are handled when you manipulate 
bits in the holding register, as "Rest of bits in word are cleared" or "Rest of 
bits in word are not cleared". (Not available to set in offline mode.)

Setup Items Setup Description

3500  (1 + Data Length + Stop Bit + Parity)
Speed (bps)
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(Page 2/22)

Double Word word order Displays the currently set order of storing double word data as "Low word 
first" or "High word first". (Not available to set in offline mode.)

IEC61131 Syntax Displays the usage status of the currently set IEC61131 syntax in ON/OFF. 
(Not available in offline mode.)

Setup Items Setup Description

Device/PLC Name Select the External Device to set. The device name is the title of the External 
Device set with GP-Pro EX.(Initial value [PLC1])

Function Code and Max Query Displays the option to set the function code and boundary. (Not available to 
set in offline mode.)

Auto adjust Setting Displays the set frame length when "Auto adjust to frame length" is selected 
in the online mode. (Not available to set in offline mode.)Frame Length

• When "Custom" is selected, the setup items of the frame length are invalid.

Setup Items Setup Description
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(Page 3/22 to 22/22)

Setup Items Setup Description

Device/PLC Name Select the External Device to set. The device name is the title of the External 
Device set with GP-Pro EX. (Initial value [PLC1])

Start Address Displays the start address of the device. (Not available to set in offline mode.)

Range Displays the range of the device specified in the start address. (Not available 
to set in offline mode.)

Read Displays the device function codes and boundaries to be read for one 
communication. (Not available to set in offline mode.)

Write Displays the device function codes and boundaries to be written for one 
communication. (Not available to set in offline mode.)

• Page 3 and the following pages display the set descriptions in order.
• When "Auto adjust to frame length" is selected, the Custom setup items are invalid.
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Option

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Equipment Settings]. Touch the 

External Device you want to set from the displayed list, and touch [Option].

Setup Items Setup Description

RI/VCC
You can switch between RI/VCC on the 9th pin when you select RS-232C for SIO type.
To connect to the IPC, you need to switch between RI/5V using the IPC selector switch. 
Refer to your IPC manual for details.

• GP-4100 series, GP-4*01TM, GP-Rear Module, LT-4*01TM and LT-Rear Module do not 
have the [Option] setting in the offline mode.
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6 Cable Diagrams

The following cable diagrams may be different from cable diagrams recommended by External Device 

Manufacturer.

Please be assured there is no operational problem in applying the cable diagram shown in this manual.

• The FG pin of the External Device body must be grounded according to your country’s applicable standard. 

Refer to your External Device manual for details.

• SG and FG are connected inside the Display. When connecting the External Device to SG, design your system 

to avoid short-circuit loops.

• Connect an isolation unit if the communication is not stable due to noise or other factors.

• The connector type or signal name may vary depending on the External Device.

Connect correctly corresponding to the External Device interface specifications.

6.1 Cable Diagram 1

Display
(Connection Port)

Cable Remarks

GP3000 (COM1)
GP4000*1 (COM1)
GP6000 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.
 IPC COM Port (page 9)

1A User created cable (ER (DTR/CTS) control)

The cable length must be 
15m maximum.1B User created cable (without control)

GP-4105  (COM1)
GP-4115T (COM1)
GP-4115T3 (COM1)

1C User created cable (ER (DTR/CTS) control)
The cable length must be 
15m maximum.1D User created cable (without control)

LT-4*01TM (COM1)
LT-Rear Module 
(COM1) 1E

RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21 The cable length must be 

5m maximum.
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1A)
• When the External Device supports RTS/CTS control

• When the External Device supports DTR/DSR control

• The cable length must be 15m maximum.

Display

Shield External Device side

Signal name

RD
SD

RTS

SG

Signal name

SD(TXD)

SG

CS(CTS)

RD(RXD)

ER(DTR)

Pin

3

5

8

2

4 CTS

DTR
DSR

FG

Display side
D-Sub 9 pin (socket)

Display

Shield External Device side

Signal name

RD
SD

DTR

SG

Signal name

SD(TXD)

SG

CS(CTS)

RD(RXD)

ER(DTR)

Pin

3

5

8

2

4 DSR

RTS
CTS

FG

Display side
D-Sub 9 pin (socket)
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1B)

• The cable length must be 15m maximum.

Display

Shield External Device side

Signal name

RD
SD

DSR

SG

Signal name

SD(TXD)

SG

CS(CTS)

RD(RXD)

ER(DTR)

Pin

3

5

8

2

4 DTR

RTS
CTS

FG

Display side
D-Sub 9 pin (socket)
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1C)
• When the External Device supports RTS/CTS control

• When the External Device supports DTR/DSR control

• The cable length must be 15m maximum.

Display

Shield External Device side

Signal name

RD
SD

RTS

SG

Signal name

SD(TXD)

SG

CS(CTS)

RD(RXD)

ER(DTR) CTS

DTR
DSR

FG

 Terminal block
Display side

Display

Shield External Device side

Signal name

RD
SD

DTR

SG

Signal name

SD(TXD)

SG

CS(CTS)

RD(RXD)

ER(DTR) DSR

RTS
CTS

FG

 Terminal block
Display side
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1D)

• The cable length must be 15m maximum.

Display

Shield External Device side

Signal name

RD
SD

DSR

SG

Signal name

SD(TXD)

SG

CS(CTS)

RD(RXD)

ER(DTR) DTR

RTS
CTS

FG

 Terminal block
Display side
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1E)

• The cable length must be 5m maximum.

External Device side 

Signal name 

RD 
SD 

DSR 

SG 

DTR 

RTS 
CTS 

FG 

GND 

TXD 

RXD 

PFXZLMCBRJR21

Display 
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6.2 Cable Diagram 2

Display
(Connection Port)

Cable Remarks

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module (COM1)
ST3000*2 (COM2)
LT3000 (COM1)
IPC*3

2A

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
Connector terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User created cable The cable length 
must be 1000m 
maximum.

2B

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
RS-422 cable by Pro-face

CA3-CBL422-01

2C User created cable

GP3000*4 (COM2)

2D

Online adapter by Pro-face
CA4-ADPONL-01

+
Connector terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User created cable
The cable length 
must be 1000m 
maximum.2E

Online adapter by Pro-face
CA4-ADPONL-01

+
RS-422 cable by Pro-face

CA3-CBL422-01

2F

Online adapter by Pro-face
CA4-ADPONL-01

+
User created cable

GP-4106  (COM1)
GP-4116T (COM1) 2G User created cable

The cable length 
must be 1000m 
maximum.

GP4000*5 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000*6 (COM1/2)
SP-5B00 (COM2)
ST6000*7 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*8 (COM2)
PS6000 (Basic Box) 
(COM1/2)

2H

RS-422 terminal block conversion adapter by Pro-face
PFXZCBADTM1*9

+
User created cable

The cable length 
must be 1000m 
maximum.2B

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
RS-422 cable by Pro-face

CA3-CBL422-01

2C User created cable

PE-4000B*10

PS5000*10

PS6000 (Optional 
Interface)*10

2I User created cable
The cable length 
must be 1000m 
maximum.
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*1  All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 Only the COM port which can communicate by RS-422/485 (4 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 9)

*4 All GP3000 models except GP-3200 series and AGP-3302B

*5 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*6 Except SP-5B00

*7 Except ST-6200

*8 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*9 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 2A.

*10 Only the COM port which can communicate by RS-422/485 (4 wire) can be used.
 IPC COM Port (page 9)

• The RS-422/485 cable length is normally 1000m or less, which depends on the 
External Device. Please refer to the manual of the External Device for more details.

• The connection method and termination resistance depends on the External Device.
• The termination resistance on the Display is not isolated.
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2A)
• 1:1 Connection

• 1:n Connection

• When the RDB terminal of CA3-ADPTRM-01 to the TRM terminal, the termination 
resistance of 100(1/2W) is inserted between RDA and RDB terminals on the Display. 

CA3-ADPCOM-01

CA3-ADPTRM-01

Display

Display side
Terminal block External Device side

Signal name
SD(+)

SD(-)
RD(+)

RD(-)

SG

User created cable

Signal name

RDB

SDB
SG

TRM

RDA

SDA
Ω (1/2W)

Terminal
resistance
100

FG

Shield

External Device side

Signal name
SD(+)

SD(-)
RD(+)

RD(-)

SG

Ω

Terminal
resistance
100

FG

CA3-ADPCOM-01

CA3-ADPTRM-01

Display

Display side
Terminal block External Device side

Signal name
SD(+)

SD(-)
RD(+)

RD(-)

SG

Signal name

RDB

SDB
SG

TRM

RDA

SDA

FG

 (1/2W)

Shield Shield

User created cable
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2B)
• 1:1 Connection

• 1:n Connection

• 100 (1/2W) termination resistance is inserted between RDA and RDB in CA3-CBL422-01.

CA3-ADPCOM-01Display

CA3-CBL422-01

Terminal block

External 
Device side

Signal name

RDA

RDB
SDA

SDB

SG

Signal name

SD(+)

SD(-)
RD(+)

RD(-)

SG

100 Ω  (1/2W)

Terminal
resistance

FG FG

Display side

CA3-ADPCOM-01Display

CA3-CBL422-01

Terminal block

External 
Device side

Signal name

RDA

RDB
SDA

SDB

SG

Signal name

SD(+)

SD(-)
RD(+)

RD(-)

SG
FG FG

External Device side

Signal name
SD(+)

SD(-)
RD(+)

RD(-)

SG

Ω

Terminal
resistance
100

FG

 (1/2W)

ShieldDisplay side
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2C)
• 1:1 Connection

• 1:n Connection

Shield External Device side
Signal name

SD(+)

SD(-)
RD(+)

RD(-)

SG

100Ω  (1/2W)

Terminal
resistance

Display side
D-Sub 9 pin (socket)

Display 100Ω  (1/2W)

Terminal
resistance

FG

Signal name

SDA
RDB

SG
ERA

SDB

ERB
CSB

RDA

CSA

3

2

5

4

7

9
6

1

8

Pin

Shield External Device side

Signal name
SD(+)

SD(-)
RD(+)

RD(-)

SG

100Ω  (1/2W)

Terminal
resistance

Display

FG

Shield External Device side

Signal name
SD(+)

SD(-)
RD(+)

RD(-)

SG

100Ω  (1/2W)

Terminal
resistance

FG

Display side
D-Sub 9 pin (socket)

Signal name

SDA
RDB

SG
ERA

SDB

ERB
CSB

RDA

CSA

3

2

5

4

7

9
6

1

8

Pin



General MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 102

2D)
• 1:1 Connection

• 1:n Connection

• When the RDB terminal of CA3-ADPTRM-01 to the TRM terminal, the termination 
resistance of 100(1/2W) is inserted between RDA and RDB terminals on the Display. 

CA4-ADPONL-01

CA3-ADPTRM-01

Display

Display side
Terminal block External Device side

Signal name
SD(+)

SD(-)
RD(+)

RD(-)

SG

User created cable

Signal name

RDB

SDB
SG

TRM

RDA

SDA
Ω (1/2W)

Terminal
resistance100

FG

Shield

100

External Device side

Signal name
SD(+)

SD(-)
RD(+)

RD(-)

SG

Ω

Terminal
resistance
100

FG

CA4-ADPONL-01

CA3-ADPTRM-01

Display

Display side
Terminal block External Device side

Signal name
SD(+)

SD(-)
RD(+)

RD(-)

SG

Signal name

RDB

SDB
SG

TRM

RDA

SDA

FG

 (1/2W)

Shield Shield

User created cable



General MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 103

2E)
• 1:1 Connection

• 1:n Connection

• 100 (1/2W) termination resistance is inserted between RDA and RDB in CA3-CBL422-01.

CA4-ADPONL-01
Display

CA3-CBL422-01

Terminal block

External 
Device side

Signal name

RDA

RDB
SDA

SDB

SG

Signal name

SD(+)

SD(-)
RD(+)

RD(-)

SG

100 Ω  (1/2W)

Terminal
resistance

FG FG

Display side

CA4-ADPONL-01
Display

CA3-CBL422-01

Terminal block

External 
Device side

Signal name

RDA

RDB
SDA

SDB

SG

Signal name

SD(+)

SD(-)
RD(+)

RD(-)

SG
FG FG

External Device side
Signal name

SD(+)

SD(-)
RD(+)

RD(-)

SG

Ω

Terminal
resistance
100

FG

 (1/2W)

Shield

 

Display side
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2F)
• 1:1 Connection

• 1:n Connection

• When the RDB terminal of CA4-ADPONL-01 to the TRMRX terminal, the termination 
resistance of 100(1/2W) is inserted between RDA and RDB terminals on the Display. 

CA4-ADPONL-01

Display

External Device side

Signal name
SD(+)

SD(-)
RD(+)

RD(-)

SG

User-created cable

Signal name
RDA

SDA
SDB
SG

TRMRX

RDB
Ω (1/2W)

Terminal
resistance
100

Pin
2

3
8
5

1

7

Shield

FG

Display side
D-Sub 9 pin (plug)

CA4-ADPONL-01

Display

External Device side

Signal name
SD(+)

SD(-)
RD(+)

RD(-)

SG

User-created cable

Signal name
RDA

SDA
SDB
SG

TRMRX

RDB

Pin
2

3
8
5

1

7

Shield

FG

Display side
D-Sub 9 pin (plug) External Device side

Signal name
SD(+)

SD(-)
RD(+)

RD(-)

SG

Ω (1/2W)

Terminal
resistance
100

Shield

FG
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2G)
• 1:1 Connection

• 1:n Connection

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

Shield External Device side
Signal name

SD(+)

SD(-)
RD(+)

RD(-)

SG

 
Terminal
resistance*1

Display 100Ω  (1/2W)

Terminal
resistance

FG

 Terminal block
Display side

Signal name

SDA
RDB

SG
ERA

SDB

ERB
CSB

RDA

CSA

Shield External Device side

Signal name
SD(+)

SD(-)
RD(+)

RD(-)

SG

 
Terminal
resistance*1

Display

FG

Shield External Device side

Signal name
SD(+)

SD(-)
RD(+)

RD(-)

SG

100Ω  (1/2W)

Terminal
resistance

FG

 Terminal block
Display side

Signal name

SDA
RDB

SG
ERA

SDB

ERB
CSB

RDA

CSA
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2H)
• 1:1 Connection

• 1:n Connection

• When the RDB terminal of PFXZCBADTM1 to the TRM terminal, the termination resistance 
of 100(1/2W) is inserted between RDA and RDB terminals on the Display. 

PFXZCBADTM1

Display

Display side
Terminal block External Device side

Signal name
SD(+)

SD(-)
RD(+)

RD(-)

SG

User created cable

Signal name

RDB

SDB
SG

TRM

RDA

SDA
Ω (1/2W)

Terminal
resistance
100

FG

Shield

External Device side

Signal name
SD(+)

SD(-)
RD(+)

RD(-)

SG

Ω

Terminal
resistance
100

FG

PFXZCBADTM1

Display

Display side
Terminal block External Device side

Signal name
SD(+)

SD(-)
RD(+)

RD(-)

SG

Signal name

RDB

SDB
SG

TRM

RDA

SDA

FG

 (1/2W)

Shield Shield

User created cable
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2I)
• 1:1 Connection

• 1:n Connection

Shield External Device side
Signal name

SD(+)

SD(-)
RD(+)

RD(-)

SG

100Ω  (1/2W)

Terminal
resistance

Display side
D-Sub 9 pin (socket)

Display 100Ω  (1/2W)

Terminal
resistance

FG

Signal name

Rx-
Rx+

Tx-

GND
NC

NC
NC

NC

Tx+2

4

5

7

1

9
6

3

8

Pin

Shield External Device side

Signal name
SD(+)

SD(-)
RD(+)

RD(-)

SG

100Ω  (1/2W)

Terminal
resistance

Display

FG

Shield External Device side

Signal name
SD(+)

SD(-)
RD(+)

RD(-)

SG

100Ω  (1/2W)

Terminal
resistance

FG

Display side
D-Sub 9 pin (socket)

Signal name

Rx-
Rx+

Tx-

GND
NC
NC

NC
NC

Tx+2

4

5

7

1

9
6

3

8

Pin
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6.3 Cable Diagram 3

Display
(Connection Port)

Cable Remarks

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module (COM1)
ST3000*2 (COM2)
LT3000 (COM1)

3A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User created cable

The cable length 
must be 1000m 
maximum.

3B User created cable

GP3000*3 (COM2)

3C

Online adapter by Pro-face
CA4-ADPONL-01

+
Connector terminal block conversion adapter by 

Pro-face
CA3-ADPTRM-01

+
User created cable

The cable length 
must be 1000m 
maximum.

3D

Online adapter by Pro-face
CA4-ADPONL-01

+
User created cable

IPC*4 3E

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User created cable

The cable length 
must be 1000m 
maximum.

3F User created cable

GP-4106  (COM1)
GP-4116T (COM1) 3G User created cable

The cable length 
must be 1000m 
maximum.

GP-4107  (COM1)
GP-4*03T*5 (COM2)
GP-4203T (COM1) 3H User created cable

The cable length 
must be 1000m 
maximum.

GP4000*6 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000*7 (COM1/2)
SP-5B00 (COM2)
ST6000*8 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*9 (COM2)
PS6000 (Basic Box) 
(COM1/2)

3I

RS-422 terminal block conversion adapter by Pro-face
PFXZCBADTM1*10

+
User created cable

The cable length 
must be 1000m 
maximum.

3B User created cable
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LT-4*01TM (COM1)
LT-Rear Module (COM1) 3J

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81

The cable length 
must be 200m 
maximum.

PE-4000B*11

PS5000*11

PS6000 (Optional 
Interface)*11

3K User created cable
The cable length 
must be 1000m 
maximum.

*1  All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 All GP3000 models except GP-3200 series and AGP-3302B

*4 Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 9)

*5 Except GP-4203T

*6 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7 Except SP-5B00

*8 Except ST-6200

*9 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*10 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 3A.

*11 Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
 IPC COM Port (page 9)

• The RS-422/485 cable length is normally 1000m or less (for LT-4*01TM and LT-Rear 
Module, 200m or less), which depends on the External Device. Please refer to the 
manual of the External Device for more details.

• The connection method and termination resistance depends on the External Device.
• The termination resistance on the Display is not isolated.

Display
(Connection Port)

Cable Remarks
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3A)
• 1:1 Connection

• 1: n Connection

• When the RDB terminal of CA3-ADPTRM-01 to the TRM terminal, the termination 
resistance of 100(1/2W) is inserted between RDA and RDB terminals on the Display.

RDB

SDB

SG

TRM

CA3-ADPCOM-01

CA3-ADPTRM-01

RDA

SDA

A(+)

B(-)

User-created cable

External Device side
Signal name

SG

Display

Display side
Terminal block
Signal name

Shield

FG

Ω (1/2W)

Terminal
resistance
100

RDB

SDB

SG

TRM

CA3-ADPCOM-01

CA3-ADPTRM-01

RDA

SDA

A(+)

B(-)

External Device side
Signal name

SG

Display

Display side
Terminal block
Signal name

Shield

FG

A(+)

B(-)

External Device side
Signal name

SG

Shield

FG

Ω (1/2W)

Terminal
resistance
100

User-created cable
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3B)
• 1:1 Connection

• 1: n Connection

100Ω  (1/2W)

Terminal
resistance

Display side
D-Sub 9 pin (socket)

Display  

A(+)

B(-)

External Device side
Signal name

SG

Shield

FG

Ω (1/2W)

Terminal
resistance
100

Signal name

SDA
RDB

SG
ERA

SDB

ERB
CSB

RDA

CSA

3

2

5

4

7

9
6

1

8

Pin

100Ω  (1/2W)

Terminal
resistance

Display

A(+)

B(-)

External Device side
Signal name

SG

Shield

FG

A(+)

B(-)

External Device side
Signal name

SG

Shield

FG

Ω (1/2W)

Terminal
resistance
100

Display side
D-Sub 9 pin (socket)

Signal name

SDA
RDB

SG
ERA

SDB

ERB
CSB

RDA

CSA

3

2

5

4

7

9
6

1

8

Pin
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3C)
• 1:1 Connection

• 1: n Connection

• When the RDB terminal of CA3-ADPTRM-01 to the TRM terminal, the termination 
resistance of 100(1/2W) is inserted between RDA and RDB terminals on the Display.

RDB

SDB

SG

TRM

CA4-ADPONL-01

CA3-ADPTRM-01

RDA

SDA

A(+)

B(-)

External Device side
Signal name

SG

Display

Display side
Terminal block
Signal name

Shield

FG

Ω (1/2W)

Terminal
resistance
100

User-created cable

RDB

SDB

SG

TRM

CA4-ADPONL-01

CA3-ADPTRM-01

RDA

SDA

A(+)

B(-)

External Device side
Signal name

SG

Display

Display side
Terminal block
Signal name

Shield

FG

A(+)

B(-)

External Device side
Signal name

SG

Shield

FG

Ω (1/2W)

Terminal
resistance
100

User-created cable
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3D)
• 1:1 Connection

• 1: n Connection

• When the RDB terminal of CA4-ADPONL-01 to the TRMRX terminal, the termination 
resistance of 100 (1/2W) is inserted between RDA and RDB terminals on the Display.

CA4-ADPONL-01

Display

User-created cable

Signal name
RDA

SDA

SDB

SG

TRMRX

RDB

Pin
2

3

8

5

1

7

Display side
D-Sub 9 pin (plug)

A(+)

B(-)

External Device side
Signal name

SG

Shield

FG

Ω (1/2W)

Terminal
resistance
100

CA4-ADPONL-01

Display

User-created cable

Signal name
RDA

SDA

SDB

SG

TRMRX

RDB

Pin
2

3

8

5

1

7

Display side
D-Sub 9 pin (plug)

A(+)

B(-)

External Device side

Signal name

SG

Shield

FG

A(+)

B(-)

External Device side

Signal name

SG

Shield

FG

Ω (1/2W)

Terminal
resistance
100
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3E)
1:1 Connection

• 1: n Connection

• When the RDB terminal of CA3-ADPTRM-01 to the TRM terminal, the termination 
resistance of 100(1/2W) is inserted between RDA and RDB terminals on the Display.

RDB

SDB

SG

TRM

CA3-ADPCOM-01

CA3-ADPTRM-01

RDA

SDA

A(+)

B(-)

User-created cable

External Device side
Signal name

SG

Display

Display side
Terminal block
Signal name

Shield

FG

Ω (1/2W)

Terminal
resistance
100

RDB

SDB

SG

TRM

CA3-ADPCOM-01

CA3-ADPTRM-01

RDA

SDA

A(+)

B(-)

User-created cable

External Device side
Signal name

SG

Display

Display side
Terminal block
Signal name

Shield

FG

A(+)

B(-)

External Device side
Signal name

SG

Shield

FG

Ω (1/2W)

Terminal
resistance
100
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3F)
• 1:1 Connection

• 1: n Connection

100 Ω  (1/2W)

Terminal
resistance

Display side
D-Sub 9 pin (socket)

Display  

A(+)

B(-)

External Device side
Signal name

SG

Shield

FG

Ω (1/2W)

Terminal
resistance
100

Signal name

3

2

5

4

7

9
6

1

8

Pin

NC
DATA-

GND(SG)
ERA

NC

ERB
CSB

DATA+

CSA

100 Ω  (1/2W)

Terminal
resistance

Display

A(+)

B(-)

External Device side

External Device

SG

Shield

FG

A(+)

B(-)

External Device side

Signal name

SG

Shield

FG

Ω (1/2W)

Terminal
resistance
100

Display side
D-Sub 9 pin (socket)

Signal name

3

2

5

4

7

9
6

1

8

Pin

NC
DATA-

GND(SG)
ERA

NC

ERB
CSB

DATA+

CSA
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3G)
• 1:1 Connection

• 1: n Connection

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

 

Terminal
resistance*1

Display  

A(+)

B(-)

External 
Device side
Signal name

SG

Shield

FG

 

Terminal
resistance*1

 Terminal block
Display side

Signal name

SDA
RDB

SG
ERA

SDB

ERB
CSB

RDA

CSA

 
Terminal
resistance*1

Display

A(+)

B(-)

External 
Device side
Signal name

SG

Shield

FG

Shield

Ω (1/2W)

Terminal
resistance
100

 Terminal block
Display side

A(+)

B(-)

External 
Device side
Signal name

SG
FG

Signal name

SDA
RDB

SG
ERA

SDB

ERB
CSB

RDA

CSA
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3H)
• 1:1 Connection

• 1: n Connection

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 
connector. Do not use it for other devices.

• In COM on the GP-4107, the SG and FG terminals are isolated.

100Ω  (1/2W)

Terminal
resistance

Display side
D-Sub 9 pin (plug)

Display  

A(+)

B(-)

External 
Device side

Signal name

SG

Shield

FG

Ω  (1/2W)

Terminal
resistance

100
Signal namePin

3

8

1

2

5

4

6

7

9

NC

NC

GND(SG)

RS(RTS)

5V

NC

NC

LINE(+)

LINE(-)

100Ω  (1/2W)

Terminal
resistance

Display

Shield

A(+)

B(-)

External 
Device side

Signal name

SG

Shield

FG

Ω (1/2W)

Terminal
resistance
100

Display side
D-Sub 9pin (plug)

A(+)

B(-)

External 
Device side

Signal name

SG
FG

Signal namePin
3

8

1

2

5

4

6

7

9

GND(SG)

RS(RTS)

5V

NC

NC

LINE(+)

LINE(-)

NC

NC
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3I)
• 1:1 Connection

• 1: n Connection

• When the RDB terminal of PFXZCBADTM1 to the TRM terminal, the termination resistance 
of 100(1/2W) is inserted between RDA and RDB terminals on the Display.

RDB

SDB

SG

TRM

PFXZCBADTM1

RDA

SDA

A(+)

B(-)

User-created cable

External Device side
Signal name

SG

Display

Display side
Terminal block
Signal name

Shield

FG

Ω (1/2W)

Terminal
resistance
100

RDB

SDB

SG

TRM

PFXZCBADTM1

RDA

SDA

A(+)

B(-)

External Device side
Signal name

SG

Display

Display side
Terminal block
Signal name

Shield

FG

A(+)

B(-)

External Device side
Signal name

SG

Shield

FG

Ω (1/2W)

Terminal
resistance
100

User-created cable
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3J)
• 1:1 Connection

• 1: n Connection

Display 

  

A(+) 

B(-) 

External Device side 
Signal name 

SG 
FG 

Ω  (1/2W) 

Terminal 
resistance 
100 

GND 
D0 

D1 

PFXZLMCBRJR81

Display 
A(+) 

B(-) 

External Device side 

External Device 

SG 
FG 

A(+) 

B(-) 

External Device side 

Signal name 

SG 

Shield 

FG 

Ω  (1/4W) 

Terminal 
resistance 
220 

GND 
D0 

D1 

PFXZLMCBRJR81

220 Ω   (1/4W) 

Terminal 
resistance 



General MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 120

3K)
• 1:1 Connection

• 1: n Connection

100 Ω   (1/2W) 

Terminal 
resistance 

Display side 
D-Sub 9 pin (socket) 

Display 

A(+) 

B(-) 

External Device side 
Signal name 

SG 

Shield 

FG 

Ω   (1/2W) 

Terminal 
resistance 
100 

Signal name 

3 

1

5 

4 

7 

9 
6 

2

8 

Pin 

NC 
DATA- 

GND
NC 

NC
NC
NC
NC

DATA+ 

100 Ω   (1/2W) 

Terminal 
resistance 

Display 

A(+) 

B(-) 

External Device side 

External Device 

SG 

Shield 

FG 

A(+) 

B(-) 

External Device side 

Signal name 

SG 

Shield 

FG 

Ω   (1/2W) 

Terminal 
resistance 
100 

Display side 
D-Sub 9 pin (socket) 

Signal name 

3 

1

5 

4 

7 

9 
6 

2

8 

Pin 

NC 
DATA- 

GND
NC 

NC
NC

NC
NC

DATA+ 
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6.4 Cable Diagram 4

Display
(Connection Port)

Cable Remarks

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module (COM1)
ST3000*2 (COM2)
LT3000 (COM1)

4A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User created cable

The cable length 
must be 500m 
maximum.

4B User created cable

GP3000*3 (COM2)

4C

Online adapter by Pro-face
CA4-ADPONL-01

+
Connector terminal block conversion adapter by 

Pro-face
CA3-ADPTRM-01

+
User created cable

The cable length 
must be 500m 
maximum.

4D

Online adapter by Pro-face
CA4-ADPONL-01

+
User created cable

IPC*4 4E

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User created cable

The cable length 
must be 500m 
maximum.

4F User created cable

GP-4106  (COM1)
GP-4116T (COM1) 4G User created cable

The cable length 
must be 500m 
maximum.

GP-4107  (COM1)
GP-4*03T*5 (COM2)
GP-4203T (COM1) 4H User created cable

The cable length 
must be 500m 
maximum.

GP4000*6 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000*7 (COM1/2)
SP-5B00 (COM2)
ST6000*8 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*9 (COM2)
PS6000 (Basic Box) 
(COM1/2)

4I

RS-422 terminal block conversion adapter by Pro-face
PFXZCBADTM1*10

+
User created cable

The cable length 
must be 500m 
maximum.

4B User created cable
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LT-4*01TM (COM1)
LT-Rear Module (COM1) 4J

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81

The cable length 
must be 200m 
maximum.

PE-4000B*11

PS5000*11

PS6000 (Optional 
Interface)*11

4K User created cable
The cable length 
must be 500m 
maximum.

*1  All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 All GP3000 models except GP-3200 series and AGP-3302B

*4 Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 9)

*5 Except GP-4203T

*6 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7 Except SP-5B00

*8 Except ST-6200

*9 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*10 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 4A.

*11 Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
 IPC COM Port (page 9)

Display
(Connection Port)

Cable Remarks
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4A)
• 1:1 Connection

• 1: n Connection

• Turn ON the termination resistor switch on the External Device located at the end to enable 
the termination resistor (120).

Signal name

SDB

RDB
TERM

FG

CA3-ADPCOM-01

CA3-ADPTRM-01

Display

Shield

SDA

RDA

SG 4

5
6

Signal name
SG

SP
SN

Pin

User-created cable

RJ-45 connector
External Device sideDisplay side

Terminal block

User-created cable

Signal name

SDB

RDB
TERM

FG

CA3-ADPCOM-01

CA3-ADPTRM-01

Display

Shield Shield

SDA

RDA

SG 4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side

4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device sideDisplay side
Terminal block
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4B)
• 1:1 Connection

• 1: n Connection

• Turn ON the termination resistor switch on the External Device located at the end to enable 
the termination resistor (120).

Signal name

SDB7

SDA3

RDB2

4 ERA

RDA

ERB

1

9

CSB6

FG

SG5

CSA8

D-sub 9 pin (socket)
Display side

Termination 
resistance
120Ω (1/2W)

Pin

Shell

 
Display

Shield

4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side

Signal name

SDB7

SDA3

RDB2

4 ERA

RDA

ERB

1

9

CSB6

FG

SG5

CSA8

D-sub 9 pin (socket)
Display side

Termination 
resistance
120Ω (1/2W)

Pin

Shell

 
Display

Shield Shield

4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side

4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side
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4C)
• 1:1 Connection

• 1: n Connection

• Turn ON the termination resistor switch on the External Device located at the end to enable 
the termination resistor (120).

CA4-ADPONL-01

CA3-ADPTRM-01

Display

User-created cable

Signal name

SDB

RDB
TERM

FG

Shield

SDA

RDA

SG 4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device sideDisplay side
Terminal block

CA4-ADPONL-01

CA3-ADPTRM-01

Display

User-created cable

Signal name

SDB

RDB
TERM

FG

Shield Shield

SDA

RDA

SG 4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side

4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device sideDisplay side
Terminal block
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4D)
• 1:1 Connection

• 1: n Connection

• Turn ON the termination resistor switch on the External Device located at the end to enable 
the termination resistor (120).

CA4-ADPONL-01

Display

User-created cable

Signal name

SDB8

SDA3

RDB7

1 TERMRX

RDA2

FG

SG5

TERMTX9

D-sub 9 pin (plug)
Display side

Pin

Shell

Shield

4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side

CA4-ADPONL-01

Display

User-created cable

Signal name

SDB8

SDA3

RDB7

1 TERMRX

RDA2

FG

SG5

TERMTX9

D-sub 9 pin (plug)
Display side

Pin

Shell

Shield Shield

4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side

4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side
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4E)
1:1 Connection

• 1: n Connection

• Turn ON the termination resistor switch on the External Device located at the end to enable 
the termination resistor (120).

CA3-ADPCOM-01

CA3-ADPTRM-01

Display

User-created cable

Signal name

RDB

SDB
TERM

FG

Shield

RDA

SDA

SG 4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device sideDisplay side
Terminal block

CA3-ADPCOM-01

CA3-ADPTRM-01

Display

User-created cable

Signal name

RDB

SDB
TERM

FG

Shield Shield

RDA

SDA

SG 4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side

4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device sideDisplay side
Terminal block
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4F)
• 1:1 Connection

• 1: n Connection

• Turn ON the termination resistor switch on the External Device located at the end to enable 
the termination resistor (120).

Termination 
resistance
120Ω (1/2W)

DATA-2

DATA+1

7
NC3

ERA4
CSA8

FG

GND(SG)5

D-sub 9 pin (socket)

Display

Pin Signal name

Shell

Display side

ERB9
CSB6

NC

Shield

4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side

Termination 
resistance
120Ω (1/2W)

DATA-2

DATA+1

7
NC3

ERA4
CSA8

FG

GND(SG)5

D-sub 9 pin (socket)

Display

Pin Signal name

Shell

Display side

ERB9
CSB6

NC

Shield Shield

4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side

4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side
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4G)
• 1:1 Connection

• 1: n Connection

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

• Turn ON the termination resistor switch on the External Device located at the end to enable 
the termination resistor (120).

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

 

Signal name

SDB
SDA

RDB
ERA

RDA

ERB
CSB

SG

CSA

Termination 
resistance *1

 
Display

Display side
Terminal block

Shield

4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side

 

Signal name

SDB
SDA

RDB
ERA

RDA

ERB
CSB

SG

CSA

Termination 
resistance *1

 
Display

Display side
Terminal block

Shield Shield

4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side

4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side
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4H)
• 1:1 Connection

• 1: n Connection

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 
connector. Do not use it for other devices.

• Turn ON the termination resistor switch on the External Device located at the end to enable 
the termination resistor (120).

• In COM on the GP-4107, the SG and FG terminals are isolated.

Termination 
resistance
120Ω (1/2W)

4

5

SG

SP
SN

Display

Pin Signal name

6

RJ-45 connector
External Device side

ShieldD-sub 9 pin (plug)
Display side

Pin

Shell

5

3

8

1

2

4

6

7

9

Signal name

GND(SG)

LINE(-)

NC

NC

RS(RTS)

5V

NC

NC

LINE(+)

FG

Termination 
resistance
120Ω (1/2W)

4

5

SG

SP
SN

Display

Pin Signal name

6

RJ-45 connector
External Device side

4

5

SG

SP
SN

Pin Signal name

6

RJ-45 connector
External Device side

Shield ShieldD-sub 9 pin (plug)
Display side

Pin

Shell

5

3

8

1

2

4

6

7

9

Signal name

GND(SG)

LINE(-)

NC

NC

RS(RTS)

5V

NC

NC

LINE(+)

FG
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4I)
• 1:1 Connection

• 1: n Connection

• Turn ON the termination resistor switch on the External Device located at the end to enable 
the termination resistor (120).

PFXZCBADTM1

Display

Signal name

SDB

RDB
TERM

FG

Shield

SDA

RDA

SG 4

5
6

Signal name
SG

SP
SN

Pin

User-created cable

RJ-45 connector
External Device sideDisplay side

Terminal block

PFXZCBADTM1

Display

Signal name

SDB

RDB
TERM

FG

Shield Shield

SDA

RDA

SG 4

5
6

Signal name
SG

SP
SN

Pin

User-created cable

RJ-45 connector
External Device side

4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device sideDisplay side
Terminal block
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4J)
• 1:1 Connection

• 1: n Connection

• Turn ON the termination resistor switch on the External Device located at the end to enable 
the termination resistor (120).

Legend Name Notes

(1) RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81

GND

D0
D1

(1)

Display
4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side

User-created cable

GND

D0

D1

(1)

Display
4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side

Shield

4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side

Termination
resistance
220Ω (1/2W)

Termination resistance
220Ω (1/2W)



General MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 133

4K)
• 1:1 Connection

• 1: n Connection

• Turn ON the termination resistor switch on the External Device located at the end to enable 
the termination resistor (120).

Termination 
resistance
120Ω (1/2W)

DATA-1

DATA+2

7
NC3

NC4
NC8

FG

GND(SG)5

D-sub 9 pin (socket)

Display

Pin Signal name

Shell

Display side

NC9
NC6

NC

Shield

4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side

Termination 
resistance
120Ω (1/2W)

DATA-1

DATA+2

7
NC3

NC4
NC8

FG

GND(SG)5

D-sub 9 pin (socket)

Display

Pin Signal name

Shell

Display side

NC9
NC6

NC

Shield Shield

4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side

4

5
6

Signal name
SG

SP
SN

Pin
RJ-45 connector

External Device side
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6.5 Cable Diagram 5

Display
(Connection Port)

Cable Remarks

GP3000 (COM1)
GP4000*1 (COM1)
GP6000 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.
 IPC COM Port (page 9)

5A User created cable The cable length must be 
15m maximum.

GP-4105  (COM1)
GP-4115T (COM1)
GP-4115T3 (COM1) 5B User created cable The cable length must be 

15m maximum.

LT-4*01TM (COM1)
LT-Rear Module 
(COM1) 5C

RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21 The cable length must be 

5m maximum.
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5A)

5B)

5C)

Legend Name Notes

(1) RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21

Display

Shield
Signal name

RD(RXD)
SG

CS(CTS)

SD(TXD)

ER(DTR)

Pin

2
5

FG

8

3

4

Display side
D-sub 9 pin (socket)

Signal name

SD(TXD)
SG

RD(RXD)
Pin

3
5

2

External Device side
D-sub 9 pin (socket)

Shell

Display

Shield
Signal name

RD(RXD)
SG

CS(CTS)

SD(TXD)

ER(DTR)

FG

Display side
Terminal block

Signal name

SD(TXD)
SG

RD(RXD)
Pin

3
5

2

External Device side
D-sub 9 pin (socket)

GND

TXD

RXD

(1)

Display
4

5
6

Signal name
RD(RXD)

SD(TXD)
SG

Pin
D-sub 9 pin (socket)
External Device side
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6.6 Cable Diagram 6

Display
(Connection Port)

Cable Remarks

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module (COM1)
ST3000*2 (COM2)
LT3000 (COM1)
IPC*3

*1  All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 Only the COM port which can communicate by RS-422/485 (4 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 9)

6A

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
Connector terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User created cable

The cable length 
must be 500m 
maximum.

6B User created cable

GP3000*4 (COM2)

*4 All GP3000 models except GP-3200 series and AGP-3302B

6C

Online adapter by Pro-face
CA4-ADPONL-01

+
Connector terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User created cable

The cable length 
must be 500m 
maximum.

6D

Online adapter by Pro-face
CA4-ADPONL-01

+
User created cable

GP-4106  (COM1)
GP-4116T (COM1) 6E User created cable

The cable length 
must be 500m 
maximum.

GP4000*5 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000*6 (COM1/2)
SP-5B00 (COM2)
ST6000*7 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*8 (COM2)
PS6000 (Basic Box) 
(COM1/2)

*5 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*6 Except SP-5B00

6F

RS-422 terminal block conversion adapter by Pro-face
PFXZCBADTM1*9

+
User created cable

The cable length 
must be 500m 
maximum.

6B User created cable

PE-4000B*10

PS5000*10

PS6000 (Optional 
Interface)*10

6G User created cable
The cable length 
must be 500m 
maximum.
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6A)
• 1:1 Connection

• 1:n Connection

*7 Except ST-6200

*8 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*9 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 6A.

*10 Only the COM port which can communicate by RS-422/485 (4 wire) can be used.
 IPC COM Port (page 9)

CA3-ADPCOM-01

CA3-ADPTRM-01

Display

Display side
Terminal block

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

User-created cable

Signal name

RDB

SDB
SG

TRM

RDA

SDA

Termination 
resistance
330Ω (1/4W)

FG

ShieldTermination 
resistance
330Ω (1/4W)

CA3-ADPCOM-01

CA3-ADPTRM-01

Display

Display side
Terminal block

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

User-created cable

Signal name

RDB

SDB
SG

TRM

RDA

SDA

FG

Shield ShieldTermination 
resistance
330Ω (1/4W)

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

Termination 
resistance
330Ω (1/4W)

FG
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6B)
• 1:1 Connection

• 1:n Connection

Shield
Signal name

SDA

SDB
RDA

RDB

SG

Display side
D-sub 9 pin (socket)

Display

FG

SDA
RDB

SG
ERA

SDB

ERB
CSB

RDA

CSA

3

2

5

4

7

9
6

1

8

Signal namePin

Termination 
resistance
330Ω (1/4W)

Termination 
resistance
330Ω (1/4W)

External Device side
Terminal block

FGShell

Shield Shield
Signal name

SDA

SDB
RDA

RDB

SG

Display side
D-sub 9 pin (socket)

Display

FG

SDA
RDB

SG
ERA

SDB

ERB
CSB

RDA

CSA

3

2

5

4

7

9
6

1

8

Signal namePin

Termination 
resistance
330Ω (1/4W)

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG
FG

Termination 
resistance
330Ω (1/4W)

External Device side
Terminal block

FGShell
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6C)
• 1:1 Connection

• 1:n Connection

CA4-ADPONL-01

CA3-ADPTRM-01

Display

Display side
Terminal block

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

User-created cable

Signal name

RDB

SDB
SG

TRM

RDA

SDA

Termination 
resistance
330Ω (1/4W)

FG

ShieldTermination 
resistance
330Ω (1/4W)

CA4-ADPONL-01

CA3-ADPTRM-01

Display

Display side
Terminal block

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

User-created cable

Signal name

RDB

SDB
SG

TRM

RDA

SDA

FG

Shield ShieldTermination 
resistance
330Ω (1/4W)

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

Termination 
resistance
330Ω (1/4W)

FG
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6D)
• 1:1 Connection

• 1:n Connection

Shield
Signal name

SDA

SDB
RDA

RDB

SG

Display side
D-sub 9 pin (plug)

Display

FG

SDA
RDB

SG
SDB

RDA

3

7

5
8

2

Signal namePin

Termination 
resistance
330Ω (1/4W)

Termination 
resistance
330Ω (1/4W)

External Device side
Terminal block

FGShell
CA4-ADPONL-01

User-created cable

Shield Shield
Signal name

SDA

SDB
RDA

RDB

SG

Display side
D-sub 9 pin (plug)

Display

FG

SDA
RDB

SG
SDB

RDA

3

7

5
8

2

Signal namePin

Termination 
resistance
330Ω (1/4W)

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG
FG

Termination 
resistance
330Ω (1/4W)

External Device side
Terminal block

FGShell
CA4-ADPONL-01

User-created cable
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6E)
• 1:1 Connection

• 1:n Connection

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

Shield
Signal name

SDA

SDB
RDA

RDB

SG

Display side
Terminal block

Display

FG

SDA
RDB

SG
ERA

SDB

ERB
CSB

RDA

CSA

Signal name

Termination 
resistance
330Ω (1/4W)

Termination 
resistance *1

External Device side
Terminal block

Shield Shield
Signal name

SDA

SDB
RDA

RDB

SG

Display side
Terminal block

Display

FG

SDA
RDB

SG
ERA

SDB

ERB
CSB

RDA

CSA

Signal nameTermination 
resistance *1

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG
FG

Termination 
resistance
330Ω (1/4W)

External Device side
Terminal block
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6F)
• 1:1 Connection

• 1:n Connection

PFXZCBADTM1

Display

Display side
Terminal block

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

User-created cable

Signal name

RDB

SDB
SG

TRM

RDA

SDA

Termination 
resistance
330Ω (1/4W)

FG

Shield
Termination 
resistance
330Ω (1/4W)

PFXZCBADTM1

Display

Display side
Terminal block

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

User-created cable

Signal name

RDB

SDB
SG

TRM

RDA

SDA

FG

Shield Shield
Termination 
resistance
330Ω (1/4W)

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

Termination 
resistance
330Ω (1/4W)

FG
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6G)
• 1:1 Connection

• 1:n Connection

Shield
Signal name

SDA

SDB
RDA

RDB

SG

Display side
D-sub 9 pin (socket)

Display

FG

TX+
RX-

SG
NC

TX-

NC
NC

RX+

NC

2

4

5

7

1

9
6

3

8

Signal namePin

Termination 
resistance
330Ω (1/4W)

Termination 
resistance
330Ω (1/4W)

External Device side
Terminal block

FGShell

Shield Shield
Signal name

SDA

SDB
RDA

RDB

SG

Display side
D-sub 9 pin (socket)

Display

FG

TX+
RX-

SG
NC

TX-

NC
NC

RX+

NC

2

4

5

7

1

9
6

3

8

Signal namePin

Termination 
resistance
330Ω (1/4W)

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG
FG

Termination 
resistance
330Ω (1/4W)

External Device side
Terminal block

FGShell
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6.7 Cable Diagram 7

Display
(Connection Port)

Cable Remarks

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module (COM1)
ST3000*2 (COM2)
LT3000 (COM1)

7A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User created cable

The cable length 
must be 500m 
maximum.

7B User created cable

GP3000*3 (COM2)

7C

Online adapter by Pro-face
CA4-ADPONL-01

+
Connector terminal block conversion adapter by 

Pro-face
CA3-ADPTRM-01

+
User created cable

The cable length 
must be 500m 
maximum.

7D

Online adapter by Pro-face
CA4-ADPONL-01

+
User created cable

IPC*4 7E

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User created cable

The cable length 
must be 500m 
maximum.

7F User created cable

GP-4106  (COM1)
GP-4116T (COM1) 7G User created cable

The cable length 
must be 500m 
maximum.

GP-4107  (COM1)
GP-4*03T*5 (COM2)
GP-4203T (COM1) 7H User created cable

The cable length 
must be 500m 
maximum.

GP4000*6 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000*7 (COM1/2)
SP-5B00 (COM2)
ST6000*8 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*9 (COM2)
PS6000 (Basic Box) 
(COM1/2)

7I

RS-422 terminal block conversion adapter by Pro-face
PFXZCBADTM1*10

+
User created cable

The cable length 
must be 500m 
maximum.

7B User created cable
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LT-4*01TM (COM1)
LT-Rear Module (COM1) 7J

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81

The cable length 
must be 200m 
maximum.

PE-4000B*11

PS5000*11

PS6000 (Optional 
Interface)*11

7K User created cable
The cable length 
must be 500m 
maximum.

*1  All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 All GP3000 models except GP-3200 series and AGP-3302B

*4 Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 9)

*5 Except GP-4203T

*6 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7 Except SP-5B00

*8 Except ST-6200

*9 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*10 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 7A.

*11 Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
 IPC COM Port (page 9)

Display
(Connection Port)

Cable Remarks
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7A)
• 1:1 Connection

• 1: n Connection

CA3-ADPCOM-01

CA3-ADPTRM-01

Display

Display side
Terminal block

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

User-created cable

Signal name

RDB

SDB
SG

TERMRX

RDA

SDA

Termination 
resistance
110Ω (1/2W)

FG

Shield

CA3-ADPCOM-01

CA3-ADPTRM-01

Display

Display side
Terminal block

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

User-created cable

Signal name

RDB

SDB
SG

TERMRX

RDA

SDA

FG

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

Termination 
resistance
110Ω (1/2W)

FG

Shield Shield
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7B)
• 1:1 Connection

• 1: n Connection

Shield
Signal name

SDA

SDB
RDA

RDB

SG

Display side
D-sub 9 pin (socket)

Display

FG

SDA
RDB

SG
ERA

SDB

ERB
CSB

RDA

CSA

3

2

5

4

7

9
6

1

8

Signal namePin
Termination 
resistance
110Ω (1/2W)

Termination 
resistance
110Ω (1/2W)

External Device side
Terminal block

FGShell

SDA

SDB
RDA

RDB

SG
FG

Shield Shield
Signal name

SDA

SDB
RDA

RDB

SG

Display side
D-sub 9 pin (socket)

Display

FG

SDA
RDB

SG
ERA

SDB

ERB
CSB

RDA

CSA

3

2

5

4

7

9
6

1

8

Signal namePin

Termination 
resistance
110Ω (1/2W)

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG
FG

Termination 
resistance
110Ω (1/2W)

External Device side
Terminal block

FGShell
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7C)
• 1:1 Connection

• 1: n Connection

CA4-ADPONL-01

CA3-ADPTRM-01

Display

Display side
Terminal block

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

User-created cable

Signal name

RDB

SDB
SG

TERMRX

RDA

SDA

Termination 
resistance
110Ω (1/2W)

FG

Shield

CA4-ADPONL-01

CA3-ADPTRM-01

Display

Display side
Terminal block

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

User-created cable

Signal name

RDB

SDB
SG

TERMRX

RDA

SDA

FG

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

Termination 
resistance
110Ω (1/2W)

FG

Shield Shield
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7D)
• 1:1 Connection

• 1: n Connection

Shield
Signal name

SDA

SDB
RDA

RDB

SG

Display side
D-sub 9 pin (plug)

Display

FG

SDA
RDB

SG
SDB

RDA

3

7

5
8

2

Signal namePin
Termination 
resistance
110Ω (1/2W)

External Device side
Terminal block

FGShell

CA4-ADPONL-01

User-created cable

TERMRX1

Shield Shield
Signal name

SDA

SDB
RDA

RDB

SG

Display side
D-sub 9 pin (plug)

Display

FG

SDA
RDB

SG
SDB

RDA

3

7

5
8

2

Signal namePin

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG
FG

Termination 
resistance
110Ω (1/2W)

External Device side
Terminal block

FGShell

CA4-ADPONL-01

User-created cable

TERMRX1
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7E)
1:1 Connection

• 1: n Connection

CA3-ADPCOM-01

CA3-ADPTRM-01

Display

Display side
Terminal block

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

User-created cable

Signal name

RDB

SDB
SG

TERMRX

RDA

SDA

Termination 
resistance
110Ω (1/2W)

FG

Shield

CA3-ADPCOM-01

CA3-ADPTRM-01

Display

Display side
Terminal block

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

User-created cable

Signal name

RDB

SDB
SG

TERMRX

RDA

SDA

FG

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

Termination 
resistance
110Ω (1/2W)

FG

Shield Shield
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7F)
• 1:1 Connection

• 1: n Connection

Shield
Signal name

SDA

SDB
RDA

RDB

SG

Display side
D-sub 9 pin (socket)

Display

FG

NC
DATA-

GND(SG)
ERA

NC

ERB
CSB

DATA+

CSA

3

2

5

4

7

9
6

1

8

Signal namePin
Termination 
resistance
110Ω (1/2W)

Termination 
resistance
110Ω (1/2W)

External Device side
Terminal block

FGShell

Shield Shield
Signal name

SDA

SDB
RDA

RDB

SG

Display side
D-sub 9 pin (socket)

Display

FG

NC
DATA-

GND(SG)
ERA

NC

ERB
CSB

DATA+

CSA

3

2

5

4

7

9
6

1

8

Signal namePin

Termination 
resistance
110Ω (1/2W)

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG
FG

Termination 
resistance
110Ω (1/2W)

External Device side
Terminal block

FGShell



General MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 152

7G)
• 1:1 Connection

• 1: n Connection

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

Shield
Signal name

SDA

SDB
RDA

RDB

SG

Display side
Terminal block

Display

FG

SDA
RDB

SG
ERA

SDB

ERB
CSB

RDA

CSA

Signal name
Termination 
resistance
110Ω (1/2W)

Termination 
resistance *1

External Device side
Terminal block

Shield Shield
Signal name

SDA

SDB
RDA

RDB

SG

Display side
Terminal block

Display

FG

SDA
RDB

SG
ERA

SDB

ERB
CSB

RDA

CSA

Signal nameTermination 
resistance *1

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG
FG

Termination 
resistance
110Ω (1/2W)

External Device side
Terminal block
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7H)
• 1:1 Connection

• 1: n Connection

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 
connector. Do not use it for other devices.

• In COM on the GP-4107, the SG and FG terminals are isolated.

Shield
Signal name

SDA

SDB
RDA

RDB

SG

Display side
D-sub 9 pin (plug)

Display

FG

NC
LINE(-)

GND(SG)
RS(RTS)

NC

NC
NC

LINE(+)

5V

1

8

5

4

2

7
9

3

6

Signal namePin
Termination 
resistance
110Ω (1/2W)

Termination 
resistance
110Ω (1/2W)

External Device side
Terminal block

FGShell

Shield
Signal name

SDA

SDB
RDA

RDB

SG

Display side
D-sub 9 pin (plug)

Display

FG

NC
LINE(-)

GND(SG)
RS(RTS)

NC

NC
NC

LINE(+)

5V

1

8

5

4

2

7
9

3

6

Signal namePin

Termination 
resistance
110Ω (1/2W)

External Device side
Terminal block Shield

Signal name
SDA

SDB
RDA

RDB

SG
FG

Termination 
resistance
110Ω (1/2W)

External Device side
Terminal block

FGShell
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7I)
• 1:1 Connection

• 1: n Connection

PFXZCBADTM1

Display

Display side
Terminal block

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

User-created cable

Signal name

RDB

SDB
SG

TRM

RDA

SDA

Termination 
resistance
110Ω (1/2W)

FG

Shield

PFXZCBADTM1

Display

Display side
Terminal block

External Device side
Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

User-created cable

Signal name

RDB

SDB
SG

TRM

RDA

SDA

FG

Shield
External Device side

Terminal block

Signal name
SDA

SDB
RDA

RDB

SG

Termination 
resistance
110Ω (1/2W)

FG

Shield
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7J)
• 1:1 Connection

• 1: n Connection

Legend Name Notes

(1) RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81

Signal name
SDA

SDB
RDA

RDB

SG
FG

Termination 
resistance
110Ω (1/2W)

External Device side
Terminal block

Display

GND

D1

D0

(1)

SDA

SDB
RDA

RDB

SG
FG

SDA

SDB
RDA

RDB

SG
FG

GND

D1

D0

(1)

Signal name Signal name

Termination 
resistance
220Ω (1/2W)

Termination 
resistance
220Ω (1/2W)

External Device side
Terminal block

Display
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7K)
• 1:1 Connection

• 1: n Connection

Shield
Signal name

SDA

SDB
RDA

RDB

SG

Display side
D-sub 9 pin (socket)

Display

FG

NC
DATA-

SG
NC

NC

NC
NC

DATA+

NC

3

1

5

4

7

9
6

2

8

Signal namePin
Termination 
resistance
110Ω (1/2W)

Termination 
resistance
110Ω (1/2W)

External Device side
Terminal block

FGShell

Shield
Signal name

SDA

SDB
RDA

RDB

SG

Display side
D-sub 9 pin (socket)

Display

FG

NC
DATA-

SG
NC

NC

NC
NC

DATA+

NC

3

1

5

4

7

9
6

2

8

Signal namePinTermination 
resistance
110Ω (1/2W)

External Device side
Terminal block Shield

Signal name
SDA

SDB
RDA

RDB

SG
FG

Termination 
resistance
110Ω (1/2W)

External Device side
Terminal block

FGShell
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6.8 Cable Diagram 8

Display
(Connection Port)

Cable Remarks

GP3000 (COM1)
GP4000*1 (COM1)
GP6000 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.
 IPC COM Port (page 9)

8A

RS232C conversion unit by IAI Corporation
RCB-CV-MW

+
Communication cable by IAI Corporation

CB-RCA-SIO050

GP-4105  (COM1)
GP-4115T (COM1)
GP-4115T3 (COM1) 8B

User created cable
+

RS232C conversion unit by IAI Corporation
RCB-CV-MW

+
Communication cable by IAI Corporation

CB-RCA-SIO050

The cable length must be 
15m maximum.

LT-4*01TM (COM1)
LT-Rear Module 
(COM1) 8C

RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21

+
RS232C conversion unit by IAI Corporation

RCB-CV-MW
+

Communication cable by IAI Corporation
CB-RCA-SIO050

Cable length from Display 
to RS232C conversion unit 
5m or less

• RS232C conversion unit (RCB-CV-MW) and communication cable (CB-RCA-SIO050) are 
accessories of PC Interface Software (RCM-101-MW) by IAI Corporation.
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8A)

8B)

8C)

Legend Name Notes

(1) RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21

Display side
D-sub 9 pin

(socket)

External Device side
Mini-DIN connector

8 pin (plug)

RCB-CV-MW CB-RCA-SIO050

External DeviceDisplay

Display side
Terminal block

RD(RXD)
SD(TXD)
ER(DTR)

SG
RS(RTS)
CS(CTS)

External Device side
D-sub 9 pin (plug)

2
3
4
5
7
8

RD(RXD)
SD(TXD)
ER(DTR)

SG
RS(RTS)
CS(CTS)

Display

User-created cable

Shield
Signal name Signal namePin Display side

D-sub 9 pin
(socket)

External Device side
Mini-DIN connector

8 pin (plug)

RCB-CV-MW CB-RCA-SIO050

External Device

External Device
D-sub 9 pin (plug)

2
3
5

RD(RXD)
SD(TXD)

SG

Signal namePinDisplay

GND

TXD

RXD

(1)

Display side
D-sub 9 pin

(socket)

External Device side
Mini-DIN connector

8 pin (plug)

RCB-CV-MW CB-RCA-SIO050

External Device
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6.9 Cable Diagram 9

Display
(Connection Port)

Cable Remarks

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module 
(COM1)
ST3000*2 (COM2)
LT3000 (COM1)
IPC*3

*1 All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 Available only with COM ports that support RS-422/485 (4wire). (Except PE-4000B, PS5000, and PS6000)
 IPC COM Port (page 9)

9A

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
Connector terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable 

The cable length 
must be 500m or 
less.

9B User-created cable 

GP3000*1(COM2)

9C

Online adapter by Pro-face
CA4-ADPONL-01

+
Connector terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable 
The cable length 
must be 500m or 
less.

9D

Online adapter by Pro-face
CA4-ADPONL-01

+
User-created cable 

GP-4106 (COM1)
GP-4116T (COM1) 9E User-created cable

The cable length 
must be 500m or 
less.

GP4000*4 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000 (COM1/2)*5 
(COM1/2)
SP-5B00 (COM2)
ST6000*6 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*7 (COM2)
PS6000 (Basic Box) 
(COM1/2)

*4 All GP4000 models except GP-4100 Series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*5 Except SP-5B00

9F

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1*8

+
User-created cable

The cable length 
must be 500m or 
less.

9B User-created cable

PE-4000B*9

PS5000*9

PS6000 (Optional 
Interface)*9

9G User-created cable 
The cable length 
must be 500m or 
less.
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*6 Except ST-6200

*7 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*8 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 9A.

*9 Available only with COM ports that support RS-422/485 (4wire).
 IPC COM Port (page 9)

• Terminal number to be used for communication varies depending on the External 
Device. Terminal numbers corresponding to each series are shown below.

• Set the PORT2 toggle switch on the External Device to "422A 485(4)". Also, turn ON the 
switch of the terminator.

• Pay attention that pole A and pole B are reversely named for the Display and the External 
Device.

Pin
KV-L20V
KV-L21V

KV-N11L
KV-NC20L

SDB(+) 5 2

SDA(-) 3 1

RDB(+) 4 3

RDA(-) 2 4

SG 1 5
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9A)

9B)

Signal name

RDA

RDB

SDA

SDB

SG

FG

TERMRX

Display CA3-ADPCOM-01

CA3-ADPTRM-01

Shield
External Device side
   Terminal block

Signal name

SDB(+)

SDA(-)

RDB(+)

RDA(-)

SG

Pin

5

3

4

2

1

User-created cable

  Display side 
Terminal block

Signal name

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

FG

Pin

1

2

3

7

5

4

8

9

6

Shell

Pin

5

3

4

2

1

Signal name

SDB(+)

SDA(-)

RDB(+)

RDA(-)

SG

Display

Shield
External Device side
  Terminal blockD-Sub 9 pin (socket)

Display side

User-created cable
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9C)

9D)

Signal name

RDA

RDB

SDA

SDB

SG

FG

TERMRX

CA4-ADPONL-01

CA3-ADPTRM-01

Display

Shield

Signal name

SDB(+)

SDA(-)

RDB(+)

RDA(-)

SG

Pin

5

3

4

2

1

External Device side
   Terminal block

User-created cable

  Display side 
Terminal block

Signal name

RDA

RDB

SDA

SDB

SG

FG

Pin

2

7

3

8

5

Shell

Pin

5

3

4

2

1

Signal name

SDB(+)

SDA(-)

RDB(+)

RDA(-)

SG

Display
CA4-ADPONL-01

Shield
Termination
resistance

 1/4W

External Device side
  Terminal block

Termination
resistance

 1/4W

User-created cable

Display side
D-Sub 9 pin (plug)
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9E)

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

9F)

DIP Switch No. Set Value

1 OFF

2 ON

3 OFF

4 ON

Signal name

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

Pin

5

3

4

2

1

Signal name

SDB(+)

SDA(-)

RDB(+)

RDA(-)

SG

Display

Shield
External Device side
  Terminal block Terminal block

Display side

*1

*1

User-created cable

Signal name

RDA

RDB

SDA

SDB

SG

FG

TERMRX

Display

PFXZCBADTM1

Shield
External Device side
   Terminal block

Signal name

SDB(+)

SDA(-)

RDB(+)

RDA(-)

SG

Pin

5

3

4

2

1

User-created cable

  Display side 
Terminal block
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9G)

Signal name 

Rx+ 

Rx- 

Tx+ 

Tx- 

GND 

NC 

NC 

NC 

NC 

FG 

Pin 

3 

4 

2 

1 

5 

7 

8 

9 

6 

Shell 

Pin 

5 

3 

4 

2 

1 

Signal name 

SDB(+) 

SDA(-) 

RDB(+) 

RDA(-) 

SG 

Display 

Shield 
External Device side 
  Terminal block D-Sub 9 pin (socket) 

Display side 

User-created cable



General MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 165

6.10 Cable Diagram 10

Display
(Connection Port)

Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module (COM1)
ST3000*2 (COM2)
LT3000 (COM1)
IPC*3

*1  All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 Only the COM port which can communicate by RS-422/485 (4 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 9)

10A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 500m or 
less.*4

*4 When using CJ1W-CIF11, the cable length must be 50 meters or less.

10B User-created cable

GP3000*5 (COM2)

*5 All GP3000 models except GP-3200 series and AGP-3302B

10C

Online Adapter by Pro-face
CA4-ADPONL-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 500m or 
less.*4

10D

Online Adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

GP-4106  (COM1)
GP-4116T (COM1) 10E User-created cable

The cable length 
must be 500m or 
less.*4

GP4000*6 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000*7 (COM1/2)
SP-5B00 (COM2)
ST6000*8 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*9 (COM2)
PS6000 (Basic Box) 
(COM1/2)

10F

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1

*10

+
User-created cable

The cable length 
must be 500m or 
less.*4

10B User-created cable

PE-4000B*11

PS5000*11

PS6000 (Optional 
Interface)*11

10G User-created cable
The cable length 
must be 500m or 
less.*4
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*6 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7 Except SP-5B00

*8 Except ST-6200

*9 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*10 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 10A.

*11 Only the COM port which can communicate by RS-422/485 (4 wire) can be used.
 IPC COM Port (page 9)

• Please turn ON the termination resistance switch on the PLC.
• Set the 2wire/4wire toggle switch to 4wire.
• Note that pole A and pole B are reversely named for the Display and the External 

Device.
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10A)
• 1:1 connection

• 1:n connection

• When the display unit you use is an IPC, turn ON the DIP switch 6 to insert the termination 
resistance.

• The cable length must be 500m or less.

Display
CA3-ADPCOM-01

CA3-ADPTRM-01

Termination
resistance
220Ω 1/4W

Terminal
block
Signal
name

Shield
External Device side
Terminal block

Signal
name

User-created cable

SDB+

SDA-

RDB+

RDA-

FG

RDA

RDB

SDA

SDB

TERMRX

SG

FG

FG

Display
CA3-ADPCOM-01

CA3-ADPTRM-01

Terminal
block
Signal
name

Shield
External Device side
Terminal block

Signal
name

Shield
Signal
name

External Device side
Terminal block

User-created cable

Termination
resistance
220Ω 1/4W SDB+

SDA-

RDB+

RDA-

SDB+

SDA-

RDB+

RDA-

RDA

RDB

SDA

SDB

TERMRX

SG

FG

FG
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10B)
• 1:1 connection

• 1:n connection

• When the display unit you use is an IPC, turn ON the DIP switch 6 to insert the termination 
resistance.

Display

D-sub 9 pin (socket)

Pin Signal
name

Shield
External Device side
Terminal blockTermination

resistance
220Ω 1/4W

RDA

RDB

SDA

SDB

CSB

ERB

CSA

ERA

1

2

3

7

6

9

8

4

Display side

Signal name

SDA-
RDB+

SDB+

RDA-

FG

Display

D-sub 9 pin (socket) Shield External Device side
Terminal block

Pin Signal
name

Shield
External Device side

Terminal blockTermination
resistance
220Ω 1/4W

RDA

RDB

SDA

SDB

CSB

ERB

CSA

ERA

1

2

3

7

6

9

8

4

Display side

Signal name

SDA-
RDB+

SDB+

RDA-

FG

Signal name

SDA-
RDB+

SDB+

RDA-

FG
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10C)
• 1:1 connection

• 1:n connection

Display
CA4-ADPONL-01

CA3-ADPTRM-01

Terminal block
Signal
name

Shield
External Device side
Terminal block

Signal
name

User-created cable

Termination
resistance
220Ω 1/4W RDA

RDB

SDA

SDB

TERMRX

SG

FG

SDB+

SDA-

RDB+

RDA-

FG

Display
CA4-ADPONL-01

CA3-ADPTRM-01

Terminal block
Signal
name

Shield
External Device side
Terminal block

Signal
name

Shield
External Device side

Terminal block
Signal
name

User-created cable

Termination
resistance
220Ω 1/4W

RDA

RDB

SDA

SDB

TERMRX

SG

FG

SDB+

SDA-

RDB+

RDA-

FG

SDB+

SDA-

RDB+

RDA-

FG
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10D)
• 1:1 connection

• 1:n connection

Display

CA4-ADPONL-01

D-sub 9 pin (plug)

Pin Signal
name

Shield
External Device side
Terminal block

Signal
name

User-created cable

Termination
resistance
220Ω 1/4W

RDA

RDB

SDA

SDB

SDB+

SDA-

RDB+

RDA-

FG

2

7

3

8

Display

CA4-ADPONL-01

D-sub 9 pin (plug)
Signal
namePin Signal

name

Shield
External Device side
Terminal block

Signal
name

Shield
External Device side
Terminal block

User-created cable

Termination
resistance
220Ω 1/4W

RDA

RDB

SDA

SDB

SDB+

SDA-

RDB+

RDA-

FG

SDB+

SDA-

RDB+

RDA-

FG

2

7

3

8
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10E)
• 1:1 connection

• 1:n connection

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

DIP Switch No. Set Value

1 OFF

2 OFF

3 OFF

4 ON

RDB+

FG

Signal name

SDA-

SDB+

RDA-

Display

Signal
name

Shield
External Device side
Terminal block

Termination
resistance*1

RDA

RDB

SDA

SDB

CSB

ERB

CSA

ERA

 Terminal block
Display side

RDB+

FG

Display

Shield
External Device side
Terminal block

Signal
name

Shield
External Device side
Terminal block

Termination
resistance*1

RDA

RDB

SDA

SDB

CSB

ERB

CSA

ERA

 Terminal block
Display side

Signal name

SDA-

SDB+

RDA-
RDB+

FG

Signal name

SDA-

SDB+

RDA-
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10F)
• 1:1 connection

• 1:n connection

Display

PFXZCBADTM1

Termination
resistance
220Ω 1/4W

Terminal
block
Signal
name

Shield
External Device side
Terminal block

Signal
name

User-created cable

SDB+

SDA-

RDB+

RDA-

FG

RDA

RDB

SDA

SDB

TERMRX

SG

FG

Display

PFXZCBADTM1

Terminal
block
Signal
name

Shield
External Device side
Terminal block

Signal
name

Shield
Signal
name

External Device side
Terminal block

User-created cable

Termination
resistance
220Ω 1/4W SDB+

SDA-

RDB+

RDA-

FG

SDB+

SDA-

RDB+

RDA-

FG

RDA

RDB

SDA

SDB

TERMRX

SG

FG
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10G)
• 1:1 connection

• 1:n connection

Display

D-sub 9 pin (socket)

Pin Signal
name

Shield
External Device side
Terminal blockTermination

resistance
220Ω 1/4W

Rx+

Rx+

Tx+

Tx-

NC

NC

NC

NC

3

4

2

1

6

9

8

7

Display side

Signal name

SDA-
RDB+

SDB+

RDA-

FG

Display

D-sub 9 pin (socket) Shield External Device side
Terminal block

Pin Signal
name

Shield
External Device side

Terminal blockTermination
resistance
220Ω 1/4W

Rx+

Rx-

Tx+

Tx-

NC

NC

NC

NC

3

4

2

1

6

9

8

7

Display side

Signal name

SDA-
RDB+

SDB+

RDA-

FG

Signal name

SDA-
RDB+

SDB+

RDA-

FG
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6.11 Cable Diagram 11

Display
(Connection Port)

Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module 
(COM1)
ST3000*2 (COM2)
LT3000 (COM1)

11A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 500m or 

less.

11B User-created cable

GP3000*3 (COM2)

11C

Online Adapter by Pro-face
CA4-ADPONL-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 500m or 

less.

11D

Online Adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

IPC*4 11E

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length 
must be 500m or 

less.

11F User-created cable

GP-4106  (COM1)
GP-4116T (COM1) 11G User-created cable

The cable length 
must be 500m or 

less.

GP-4107  (COM1)
GP-4*03T*5 (COM2)
GP-4203T (COM1) 11H User-created cable

The cable length 
must be 500m or 

less.

GP4000*6 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000*7 (COM1/2)
SP-5B00 (COM2)
ST6000*8 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*9 (COM2)
PS6000 (Basic Box) 
(COM1/2)

11I

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1

*10

+
User-created cable

The cable length 
must be 500m or 

less.

11B User-created cable
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LT-4*01TM (COM1)
LT-Rear Module 
(COM1) 11J

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81

The cable length 
must be 500m or 

less.

PE-4000B*11

PS5000*11

PS6000 (Optional 
Interface)*11

11K User-created cable
The cable length 
must be 500m or 

less.

*1  All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 All GP3000 models except GP-3200 series and AGP-3302B

*4 Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 9)

*5 Except GP-4203T

*6 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7 Except SP-5B00

*8 Except ST-6200

*9 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*10 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 11A.

*11 Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
 IPC COM Port (page 9)

Display
(Connection Port)

Cable Notes
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11A)

• 1:1 connection

• 1:n connection

CA3-ADPTRM-01

CA3-ADPCOM-01

Termination
resistance
220Ω RDA

RDB

SDA

SDB

SG

FG

B(+)

A(-)

FG

Display

Display side
Terminal block

External Device side
Terminal block

Signal name

Signal name

Shield

User-created cable

CA3-ADPTRM-01

CA3-ADPCOM-01

Termination
resistance
220Ω RDA

RDB

SDA

SDB

SG

FG

B(+)

A(-)

FG

Display

Display side
Terminal block

External Device side
Terminal block

Signal name

Signal name

Shield

User-created cable

B(+)

A(-)

FG

External Device side
Terminal block

Signal name

Shield
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11B)

• 1:1 connection

• 1:n connection

Termination
resistance
220Ω RDA

RDB

SDA

SDB

SG

ERA

B(+)

A(-)

FG

Display

Display side
D-sub 9 pin (socket)

External Device side
Terminal block

Signal name

1

2

3

7

5

4

CSA

ERB

CSB

FG

8

9

6

Shell

Pin

Signal name

Shield

Termination
resistance
220Ω RDA

RDB

SDA

SDB

SG

ERA

B(+)

A(-)

FG

Display

External Device side
Terminal block1

2

3

7

5

4

CSA

ERB

CSB

FG

8

9

6

Shell

Signal namePin

Signal name

Shield
Display side

D-sub 9 pin (socket)

B(+)

A(-)

FG

External Device side
Terminal block

Signal name

Shield
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11C)

• 1:1 connection

• 1:n connection

CA3-ADPTRM-01

CA4-ADPONL-01

Termination
resistance
220Ω RDA

RDB

SDA

SDB

SG

FG

B(+)

A(-)

FG

Display

Display side
Terminal block

External Device side
Terminal block

Signal name

Signal name

Shield

User-created cable

CA3-ADPTRM-01

CA4-ADPONL-01

Termination
resistance
220Ω RDA

RDB

SDA

SDB

SG

FG

B(+)

A(-)

FG

Display

Display side
Terminal block

External Device side
Terminal block

Signal name

Signal name

Shield

User-created cable

B(+)

A(-)

FG

External Device side
Terminal block

Signal name

Shield
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11D)

• 1:1 connection

• 1:n connection

Termination
resistance
220Ω RDA

RDB

SDA

SDB

SG

FG

B(+)

A(-)

FG

Display

External Device side
Terminal block

Signal name

Signal name

Shield

User-created cable

Display side
D-sub 9 pin (plug)

2

7

3

8

5

Shell

Pin

CA4-ADPONL-01

CA4-ADPONL-01

Termination
resistance
220Ω

B(+)

A(-)

FG

Display

External Device side
Terminal block

Signal name

Shield

User-created cable

Display side
D-sub 9 pin (plug)

B(+)

A(-)

FG

External Device side
Terminal block

Signal name

Shield

RDA

RDB

SDA

SDB

SG

FG

Signal name

2

7

3

8

5

Shell

Pin
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11E)

• 1:1 connection

• 1:n connection

CA3-ADPTRM-01

CA3-ADPCOM-01

Termination
resistance
220Ω RDA

RDB

SDA

SDB

SG

FG

B(+)

A(-)

FG

Display

Display side
Terminal block

External Device side
Terminal block

Signal name Signal name

Shield

User-created cable

CA3-ADPTRM-01

CA3-ADPCOM-01

Termination
resistance
220Ω RDA

RDB

SDA

SDB

SG

FG

B(+)

A(-)

FG

Display

Display side
Terminal block

External Device side
Terminal block

Signal name Signal name

Shield Shield

User-created cable

B(+)

A(-)

FG

External Device side
Terminal block

Signal name
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11F)

• 1:1 connection

• 1:n connection

Termination
resistance
220Ω DATA+

DATA-

NC

NC

SG(GND)

ERA

Display
1

2

3

7

5

4

CSA

ERB

CSB

FG

8

9

6

Shell

Signal namePin

Display side
D-sub 9 pin (socket)

B(+)

A(-)

FG

External Device side
Terminal block

Signal name

Shield

Termination
resistance
220Ω DATA+

DATA-

NC

NC

SG(GND)

ERA

Display
1

2

3

7

5

4

CSA

ERB

CSB

FG

8

9

6

Shell

Signal namePin

Display side
D-sub 9 pin (socket)

B(+)

A(-)

FG

External Device side
Terminal block

Signal name

Shield Shield

B(+)

A(-)

FG

External Device side
Terminal block

Signal name
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11G)

• 1:1 connection

• 1:n connection

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

DIP Switch No. Set Value

1 OFF

2 OFF

3 OFF

4 ON

Termination
resistance *1 RDA

RDB

SDA

SDB

SG

ERA

Display

CSA

ERB

CSB

Signal name

Display side
Terminal block

B(+)

A(-)

FG

External Device side
Terminal block

Signal name

Shield

RDA

RDB

SDA

SDB

SG

ERA

Display

CSA

ERB

CSB

Signal name

Display side
Terminal block

B(+)

A(-)

FG

External Device side
Terminal block

Signal name

Shield Shield

B(+)

A(-)

FG

External Device side
Terminal block

Signal nameTermination
resistance *1
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11H)

• 1:1 connection

• 1:n connection

Termination
resistance
220Ω LINE+

LINE-

SG(GND)

NC

NC

RS(RTS)

Display
3

8

5

1

2

4

5V

NC

NC

FG

6

7

9

Shell

Signal namePin

Display side
D-sub 9 pin (socket)

B(+)

A(-)

FG

External Device side
Terminal block

Signal name

Shield

Termination
resistance
220Ω LINE+

LINE-

SG(GND)

NC

NC

RS(RTS)

Display
3

8

5

1

2

4

5V

NC

NC

FG

6

7

9

Shell

Signal namePin

Display side
D-sub 9 pin (socket)

B(+)

A(-)

FG

External Device side
Terminal block

Signal name

Shield Shield

B(+)

A(-)

FG

External Device side
Terminal block

Signal name
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11I)

• 1:1 connection

• 1:n connection

PFXZCBADTM1

Termination
resistance
220Ω RDA

RDB

SDA

SDB

SG

FG

B(+)

A(-)

FG

Display

Display side
Terminal block

External Device side
Terminal block

Signal name

Signal name

Shield

User-created cable

PFXZCBADTM1

Termination
resistance
220Ω RDA

RDB

SDA

SDB

SG

FG

B(+)

A(-)

FG

Display

Display side
Terminal block

External Device side
Terminal block

Signal name

Signal name

Shield

User-created cable

B(+)

A(-)

FG

External Device side
Terminal block

Signal name

Shield
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11J)

• 1:1 connection

• 1:n connection

Number Name Notes

(1)
RJ45 RS-485 Cable (5m) by Pro-face

PFXZLMCBRJR81

Display

(1)

D1
D0

GND

B(+)

A(-)

FG

External Device side
Terminal block

Signal name

Display

(1)

D1
D0

GND

B(+)

A(-)

FG

External Device side
Terminal block

Signal name

Shield

B(+)

A(-)

FG

External Device side
Terminal block

Signal name
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11K)

• 1:1 connection

• 1:n connection

Termination
resistance
220Ω DATA+

DATA-

NC

NC

GND

NC

Display
2

1

3

7

5

4

NC

NC

NC

FG

8

9

6

Shell

Signal namePin

Display side
D-sub 9 pin (socket)

B(+)

A(-)

FG

External Device side
Terminal block

Signal name

Shield

B(+)

A(-)

FG

External Device side
Terminal block

Signal name

Shield Shield

B(+)

A(-)

FG

External Device side
Terminal block

Signal nameTermination
resistance
220Ω DATA+

DATA-

NC

NC

GND

NC

Display
2

1

3

7

5

4

NC

NC

NC

FG

8

9

6

Shell

Signal namePin

Display side
D-sub 9 pin (socket)
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6.12 Cable Diagram 12

12A)

Display
(Connection Port)

Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
GP6000 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.
 IPC COM Port (page 9)

12A User-created cable The cable length must 
be 15m or less.

GP-4105  (COM1)
GP-4115T (COM1)
GP-4115T3 (COM1) 12B User-created cable The cable length must 

be 15m or less.

LT-4*01TM (COM1)
LT-Rear Module 
(COM1) 12C

RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21 The cable length must 

be 5m or less.

SG

Signal name

1

2

3

Pin Signal name

SG

4 FG

Shield

Display

External Device side
Terminal block

RD(RXD)

SD(TXD)

RS(RTS)

CS(CTS)

SD(TXD)

RD(RXD)

2

3

5

Pin

7

8

D-sub 9 pin (socket)
Display side
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12B)

12C)

Legend Name Note

(1)
RJ45 RS-232C Cable (5m) by Pro-face

PFXZLMCBRJR21

SG

Signal name

1

2

3

Pin Signal name

SG

4 FG

Shield

Display

Terminal block
External Device side

Terminal block

RD(RXD)

SD(TXD)

RS(RTS)

Display side

CS(CTS)

SD(TXD)

RD(RXD)

Display

GND

TXD

RXD

(1)

1

2

3

Pin Signal name

SG

4 FG

External Device side
Terminal block

SD(TXD)

RD(RXD)
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6.13 Cable Diagram 13

13A)

Display
(Connection Port)

Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
GP6000 (COM1)
SP5000*2 (COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.
 IPC COM Port (page 9)

13A User-created cable The cable length must 
be 15m or less.

GP-4105  (COM1)
GP-4115T (COM1)
GP-4115T3 (COM1) 13B User-created cable The cable length must 

be 15m or less.

LT-4*01TM (COM1)
LT-Rear Module 
(COM1) 13C

RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21 The cable length must 

be 5m or less.

SG

Signal name

1

2

3

4

5

Pin Signal name

SG

6

2

3

5

7

8

Pin

FG

Shield

Display

D-sub 9 pin (socket)
External Device side

Terminal block

RD(RXD)

SD(TXD)

RS(RTS)

Display side

CS(CTS)

SD(TXD)

RD(RXD)

RS(RTS)

CS(CTS)
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13B)

13C)

Legend Name Note

(1)
RJ45 RS-232C Cable (5m) by Pro-face

PFXZLMCBRJR21

SG

Signal name

1

2

3

4

5

Pin Signal name

SG

6 FG

Shield

Display

Terminal block
External Device side

Terminal block

RD(RXD)

SD(TXD)

RS(RTS)

Display side

CS(CTS)

SD(TXD)

RD(RXD)

RS(RTS)

CS(CTS)

Display

GND

TXD

RXD

(1)

1

2

3

4

5

Pin Signal name

SG

6 FG

External Device side
Terminal block

SD(TXD)

RD(RXD)

RS(RTS)

CS(CTS)
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6.14 Cable Diagram 14

14A)

Display 
(Connection Port)

Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
GP6000 (COM1)
SP5000 (COM1/2)*2 
(COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 Series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.
 IPC COM Port (page 9)

14A User-created cable The cable length must be 3m 
or less.

GP-4105 (COM1)
GP-4115T (COM1) 
GP-4115T3 (COM1)

14B User-created cable The cable length must be 3m 
or less.

LT-4*01TM (COM1)
LT-Rear Module 
(COM1) 14C

RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21 The cable length must be 3m 

or less.

2

3

4

5

6

7

8

SD

RD

SG

Display

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield Signal name

DR(DSR)

SD(TXD)

ER(DTR)

SG

RD(RXD)

CS(CTS)

RS(RTS)

FG

Display side
External Device side
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14B)

14C)

Number Name Notes

(1)
RJ45 RS-232C Cable (5m) by Pro-face

PFXZLMCBRJR21

SD

RD

SG

Display

Display side 
Terminal block

Signal name Shield Signal name

DR(DSR)

SD(TXD)

ER(DTR)

SG

RD(RXD)

CS(CTS)

RS(RTS)

External Device side

SD

RD

SG

Signal name

External Device side

Display

GND
TXD

RXD

(1)
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6.15 Cable Diagram 15

15A)

Display 
(Connection Port)

Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
GP6000 (COM1)
SP5000 (COM1/2)*2 
(COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 Series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.
 IPC COM Port (page 9)

15A User-created cable The cable length must be 15m 
or less.

GP-4105 (COM1)
GP-4115T (COM1) 
GP-4115T3 (COM1)

15B User-created cable The cable length must be 15m 
or less.

2

3

4

5

6

7

8

SD

RD

RS

CS

SG

Display

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield

Signal name

DR(DSR)

SD(TXD)

ER(DTR)

SG

RD(RXD)

CS(CTS)

RS(RTS)

FG

Display side  External 
Device side



General MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 194

15B)

SD

RD

RS

CS

SG

Display

Display side 
Terminal block

Signal name

Shield

Signal name

DR(DSR)

SD(TXD)

ER(DTR)

SG

RD(RXD)

CS(CTS)

RS(RTS)

  External
Device side
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6.16 Cable Diagram 16

16A) 

Display 
(Connection Port)

Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
GP6000 (COM1)
SP5000 (COM1/2)*2 
(COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 Series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.
 IPC COM Port (page 9)

16A User-created cable (When using the COM.1 port)

The cable length must be 
15m or less.16B User-created cable (When using the COM.2 port)

GP-4105 (COM1)
GP-4115T (COM1) 
GP-4115T3 (COM1)

16C User-created cable (When using the COM.1 port) The cable length must be 
15m or less.16D User-created cable (When using the COM.2 port)

LT-4*01TM (COM1)
LT-Rear Module 
(COM1)

16E
RJ45 RS-232C Cable (5m) by Pro-face

PFXZLMCBRJR21
(When using the COM.1 port) The cable length must be 

5m or less.

16F
RJ45 RS-232C Cable (5m) by Pro-face

PFXZLMCBRJR21
(When using the COM.2 port)

2

3

4

5

6

7

8

S1

R1

S2

R2

SG

Display

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield

Signal name

DR(DSR)

SD(TXD)

ER(DTR)

SG

RD(RXD)

CS(CTS)

RS(RTS)

FG

       Display side  External 
Device side
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16B) 

16C) 

16D) 

2

3

4

5

6

7

8

S1

R1

S2

R2

SG

Display

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield

Signal name

DR(DSR)

SD(TXD)

ER(DTR)

SG

RD(RXD)

CS(CTS)

RS(RTS)

FG

 External
Device side

Display side

S1

R1

S2

R2

SG

Display

Display side 
Terminal block

Signal name

Shield

Signal name

DR(DSR)

SD(TXD)

ER(DTR)

SG

RD(RXD)

CS(CTS)

RS(RTS)

 External 
Device side

S1

R1

S2

R2

SG

Display

Signal name

Shield

Signal name

Display side 
Terminal block

DR(DSR)

SD(TXD)

ER(DTR)

SG

RD(RXD)

CS(CTS)

RS(RTS)

 External 
Device side



General MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 197

16E) 

16F) 

Number Name Notes

(1)
RJ45 RS-232C Cable (5m) by Pro-face

PFXZLMCBRJR21

Number Name Notes

(1)
RJ45 RS-232C Cable (5m) by Pro-face

PFXZLMCBRJR21

S1

R1

S2

R2

SG

Signal name

 External 
Device side

Display

GND

TXD

RXD

(1)

S1

R1

S2

R2

SG

Signal name

 External
Device side

Display

GND
TXD

RXD

(1)
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6.17 Cable Diagram 17

17A)

Display 
(Connection Port)

Cable Notes

GP3000 (COM1)
GP4000*1 (COM1)
GP6000 (COM1)
SP5000 (COM1/2)*2 
(COM1/2)
SP-5B00 (COM1)
ST3000 (COM1)
ST6000 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000 (COM1)
LT3000 (COM1)
IPC*3

PC/AT

*1 All GP4000 models except GP-4100 Series and GP-4203T

*2 Except SP-5B00

*3 Only the COM port which can communicate by RS-232C can be used.
 IPC COM Port (page 9)

17A User-created cable The cable length must be 15m 
or less.

GP-4105 (COM1)
GP-4115T (COM1) 
GP-4115T3 (COM1)

17B User-created cable The cable length must be 15m 
or less.

LT-4*01TM (COM1)
LT-Rear Module 
(COM1) 17C

RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRJR21 The cable length must be 5m or 

less.

2

3

4

5

6

7

8

+

-

SD

RD

SG

Display

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield

Signal name

DR(DSR)

SD(TXD)

ER(DTR)

SG

RD(RXD)

CS(CTS)

RS(RTS)

FG

External Device side
Display side
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17B)

17C)

Number Name Notes

(1)
RJ45 RS-232C Cable (5m) by Pro-face

PFXZLMCBRJR21

+

-

SD

RD

SG

Display

Display side 
Terminal block

Signal name

Shield

Signal name

DR(DSR)

SD(TXD)

ER(DTR)

SG

RD(RXD)

CS(CTS)

RS(RTS)

External Device side

+

-

SD

RD

SG

Signal name

External Device side

Display

GND
TXD

RXD

(1)
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6.18 Cable Diagram 18

Display 
(Connection Port)

Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module (COM1)
ST3000*2 (COM2)
LT3000 (COM1)

18A

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length must 
be 1200m or less.

18B User-created cable

GP3000*3 (COM2)

18C

Online adapter by Pro-face
CA4-ADPONL-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length must 
be 1200m or less.

18D

Online adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

IPC*4 18E

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length must 
be 1200m or less.

18F User-created cable
GP-4106 (COM1)
GP-4116T (COM1) 18G User-created cable The cable length must 

be 1200m or less.
GP-4107 (COM1)
GP-4*03T*5 (COM2)
GP-4203T (COM1)

18H User-created cable The cable length must 
be 1200m or less.

GP4000*6 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000 (COM1/2)*7 
(COM1/2)
SP-5B00 (COM2)
ST6000*8 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*9 (COM2)
PS6000 (Basic Box) 
(COM1/2)

18I

RS-422 terminal block conversion adapter by Pro-face
PFXZCBADTM1*10

+
User-created cable

The cable length must 
be 1200m or less.

18B User-created cable

LT-4*01TM (COM1)
LT-Rear Module (COM1) 18J

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81 The cable length must 

be 200m or less.
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PE-4000B*11

PS5000*11

PS6000 (Optional 
Interface)*11

18K User-created cable The cable length must 
be 1200m or less.

*1  All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3  All GP3000 models except GP-3200 series and AGP-3302B

*4 Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 9)

*5 Except GP-4203T

*6 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7 Except SP-5B00

*8 Except ST-6200

*9 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*10 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 18A.

*11 Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
 IPC COM Port (page 9)

Display 
(Connection Port)

Cable Notes
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18A) 

• 1:1 Connection

• 1:n Connection

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 of 
the External Device to ON.

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 of 
the External Device which terminates the connection to ON.

CA3-ADPCOM-01

: ON
CA3-ADPTRM-01

RDA

RDB

SDA

SDB

SG

FG

+

-

SD

RD

SG
120 1/2W 

Display

Termination
resistance

Signal name

Shield
Signal
name

Termination
resistance

User-created cable

Terminal block
Display side     External 

 Device side

: OFF ON

RDA

RDB

SDA

SDB

SG

FG

+

-

SD

RD

SG

+

-

SD

RD

SG

CA3-ADPCOM-01

CA3-ADPTRM-01

120 1/2W 

Display

Termination
resistance

Signal name

Shield
Signal
name

Termination
resistance :Termination

resistance

Shield
Signal
name

User-created cable

Terminal block
Display side     External 

 Device side
    External 
 Device side
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18B) 

• 1:1 Connection

• 1:n Connection

 

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 of 
the External Device to ON.

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 of 
the External Device which terminates the connection to ON.

: ON

1

2

3

7

5

4

8

9

6

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

FG

+

-

SD

RD

SG

120 1/2W 

Display

Termination
resistance

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield
Signal
name

Termination
resistance

Display side     External 
 Device side

+

-

SD
RD

SG

:ON

+

-

SD
RD

SG

:OFF

1

2

3

7

5

4

8

9

6

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

FG

120 1/2W 

Display

Termination
resistance

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield

Termination
resistance

Signal
name

Signal
name

Termination
resistance

Shield
Display side     External 

 Device side
    External 
 Device side
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18C) 

• 1:1 Connection

• 1:n Connection

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 of 
the External Device to ON.

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 of 
the External Device which terminates the connection to ON.

RDA

RDB

SDA

SDB

TERMRX

SG

FG

:ON

+

-

SD
RD

SG

CA4-ADPONL-01

CA3-ADPTRM-01

Display

Signal name

Shield
Signal
name

Termination
resistance

User-created cable

Terminal block
Display side     External 

 Device side

CA4-ADPONL-01

CA3-ADPTRM-01

RDA

RDB

SDA

SDB

TERMRX

SG

FG

+

-

SD

RD

SG

+

-

SD

RD

SG

Display

Signal name

Shield
Signal
name

Signal
name

Shield

: OFF
Termination
resistance : ON

Termination
resistance

User-created cable

   External 
 Device side

    External 
 Device sideTerminal block

 Display side
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18D) 

• 1:1 Connection

• 1:n Connection

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 of 
the External Device to ON.

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 of 
the External Device which terminates the connection to ON.

CA4-ADPONL-01
2

7

3

8

1

9

5

RDA

RDB

SDA

SDB

TERMRX

TERMTX

SG

FG

+

-

RD

SD

SG

Display

D-sub 9 pin (plug)

Pin Signal name

Shell

Shield
Signal
name

:ONTermination
resistance

User-created cable

Display side     External 
 Device side

2

7

3

8

1

9

5

RDA

RDB

SDA

SDB

TERMRX

TERMTX

SG

FG

+

-

SD

RD

SG

+

-

SD

RD

SG

CA4-ADPONL-01
Display

D-sub 9 pin (plug)

Pin Signal name

Shell

Shield
Signal
name

:OFFTermination
resistance :ONTermination

resistance

Shield
Signal
name

User-created cable

Display side     External 
 Device side

    External 
 Device side
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18E) 

• 1:1 Connection

• 1:n Connection

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 of 
the External Device to ON.

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 of 
the External Device which terminates the connection to ON.

CA3-ADPCOM-01

: ON
CA3-ADPTRM-01

RDA

RDB

SDA

SDB

SG

FG

+

-

SD

RD

SG
120 1/2W 

Display

Termination
resistance

Signal name

Shield
Signal
name

Termination
resistance

User-created cable

Terminal block
Display side     External 

 Device side

: OFF ON

RDA

RDB

SDA

SDB

SG

FG

+

-

SD

RD

SG

+

-

SD

RD

SG

CA3-ADPCOM-01

CA3-ADPTRM-01

120 1/2W 

Display

Termination
resistance

Signal name

Shield
Signal
name

Termination
resistance :Termination

resistance

Shield
Signal
name

User-created cable

Terminal block
Display side     External 

 Device side
    External 
 Device side
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18F) 

• 1:1 Connection

• 1:n Connection

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 of 
the External Device to ON.

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 of 
the External Device which terminates the connection to ON.

: ON

1

2

3

7

5

4

8

9

6

DATA+

DATA-

NC

NC

GND(SG)

ERA

CSA

ERB

CSB

FG

+

-

SD

RD

SG

120 1/2W 

Display

Termination
resistance

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield
Signal
name

Termination
resistance

Display side     External 
 Device side

+

-

SD
RD

SG

:ON

+

-

SD
RD

SG

:OFF

1

2

3

7

5

4

8

9

6

DATA+

DATA-

NC

NC

GND(SG)

ERA

CSA

ERB

CSB

FG

120 1/2W 

Display

Termination
resistance

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield

Termination
resistance

Signal
name

Signal
name

Termination
resistance

Shield
Display side     External 

 Device side
    External 
 Device side
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18G) 

• 1:1 Connection

• 1:n Connection

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.   

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 of 
the External Device to ON.

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 of 
the External Device which terminates the connection to ON.

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

: ON

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

+

-

SD

RD

SG

Display

Termination
resistance*1

Display side 
Terminal block

Signal name

Shield
Signal
name

Termination
resistance

    External 
 Device side

+

-

SD
RD

SG

:ON

+

-

SD
RD

SG

:OFF

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

Display

Termination
resistance*1

  Display side
Terminal block

Signal name

Shield

Termination
resistance

Signal
name

Signal
name

Termination
resistance

Shield
    External 
 Device side

    External 
 Device side
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18H) 

• 1:1 Connection

• 1:n Connection

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 
connector. Do not use it for other devices.

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 
of the External Device to ON.

• In COM on the GP-4107, the SG and FG terminals are isolated.

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 
connector. Do not use it for other devices.

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 
of the External Device which terminates the connection to ON.

• In COM on the GP-4107, the SG and FG terminals are isolated.

: ON

+

-

SD

RD

SG

120 1/2W 

Display

Termination
resistance Pin Signal name

Shield
Signal
name

Termination
resistance

Display side
D-Sub 9pin (plug)

3

8

1

2

5

4

6

7

9

Shell

NC

NC

GND(SG)

RS(RTS)

5V

NC

NC

FG

LINE(+)

LINE(-)

    External 
 Device side

+

-

SD
RD

SG

:ON

+

-

SD
RD

SG

:OFF

120 1/2W 

Display

Termination
resistance Pin Signal name

Shield

Termination
resistance

Signal
name

Signal
name

Termination
resistance

Shield
Display side

D-Sub 9pin (plug)

3

8

1

2

5

4

6

7

9

Shell

NC

NC

GND(SG)

RS(RTS)

5V

NC

NC

FG

LINE(+)

LINE(-)

    External 
 Device side

    External 
 Device side
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18I) 

• 1:1 Connection

• 1:n Connection

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 of 
the External Device to ON.

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 of 
the External Device which terminates the connection to ON.

: ON
PFXZCBADTM1

RDA

RDB

SDA

SDB

SG

FG

+

-

SD

RD

SG
120 1/2W 

Display

Termination
resistance

Signal name

Shield
Signal
name

Termination
resistance

User-created cable

Terminal block
Display side     External 

 Device side

: OFF ON

RDA

RDB

SDA

SDB

SG

FG

+

-

SD

RD

SG

+

-

SD

RD

SG
PFXZCBADTM1

120 1/2W 

Display

Termination
resistance

Signal name

Shield
Signal
name

Termination
resistance :Termination

resistance

Shield
Signal
name

User-created cable

Terminal block
Display side     External 

 Device side
    External 
 Device side
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18J) 

• 1:1 Connection

• 1:n Connection

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 of 
the External Device to ON.

Number Name Notes

(1)
RJ45 RS-485 Cable (5m) by Pro-face

PFXZLMCBRJR81

: ON

+

-

SD

RD

SG

Signal
name

Termination
resistance

    External 
 Device side

Display

D0

D1

(1)

+

-

SD
RD

SG

:OFF

+

-

SD
RD

SG

:OFFTermination
resistance

Signal
name

Signal
name

Termination
resistance

Shield
    External 
 Device side

    External 
 Device side

Display

D0

D1

(1)

User-created Cable

220Ω(1/4W)

Termination
resistance

220Ω(1/4W)

Termination
resistance
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18K) 

• 1:1 Connection

• 1:n Connection

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 of 
the External Device to ON.

• Use the DIP switch in the communication cassette to set the termination resistance. Set SW1-1 of 
the External Device which terminates the connection to ON.

: ON

2

1

3

7

5

4

8

9

6

DATA+

DATA-

NC

NC

NC

NC

NC

NC

GND

FG

+

-

SD

RD

SG

120 1/2W 

Display

Termination
resistance

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield
Signal
name

Termination
resistance

Display side     External 
 Device side

+

-

SD
RD

SG

:ON

+

-

SD
RD

SG

:OFF

2

1

3

7

5

4

8

9

6

DATA+

DATA-

NC

NC

NC

NC

NC

NC

GND

FG

120 1/2W 

Display

Termination
resistance

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield

Termination
resistance

Signal
name

Signal
name

Termination
resistance

Shield
Display side     External 

 Device side
    External 
 Device side
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6.19 Cable Diagram 19

Display 
(Connection Port)

Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module (COM1)
ST3000*2 (COM2)
LT3000 (COM1)

19A

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length must 
be 1200m or less.

19B User-created cable

GP3000*3 (COM2)

19C

Online adapter by Pro-face
CA4-ADPONL-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length must 
be 1200m or less.

19D

Online adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

IPC*4 19E

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length must 
be 1200m or less.

19F User-created cable
GP-4106 (COM1)
GP-4116T (COM1) 19G User-created cable The cable length must 

be 1200m or less.
GP-4107 (COM1)
GP-4*03T*5 (COM2)
GP-4203T (COM1)

19H User-created cable The cable length must 
be 1200m or less.

GP4000*6 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000 (COM1/2)*7 
(COM1/2)
SP-5B00 (COM2)
ST6000*8 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
ET6000*9 (COM2)
PS6000 (Basic Box) 
(COM1/2)

19I

RS-422 terminal block conversion adapter by Pro-face
PFXZCBADTM1*10

+
User-created cable

The cable length must 
be 1200m or less.

19B User-created cable

LT-4*01TM (COM1)
LT-Rear Module (COM1) 19J

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81 The cable length must 

be 200m or less.



General MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 214

PE-4000B*11

PS5000*11

PS6000 (Optional 
Interface)*11

19K User-created cable The cable length must 
be 1200m or less.

*1  All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3  All GP3000 models except GP-3200 series and AGP-3302B

*4 Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 9)

*5 Except GP-4203T

*6 All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7 Except SP-5B00

*8 Except ST-6200

*9 Due to the COM port specifications, flow control is not possible. Omit wiring the control pins on the Display
side of the cable diagram.

*10 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 19A.

*11 Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
 IPC COM Port (page 9)

Display 
(Connection Port)

Cable Notes
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19A) 

• 1:1 Connection

• 1:n Connection

• Set the termination resistance selector switch of the External Device which terminates the 
connection to ON.

CA3-ADPCOM-01

CA3-ADPTRM-01

RDA

RDB

SDA

SDB

SG

FG

+

-

120 1/2W 

Display

Termination
resistance

Terminal block

Signal name Shield Signal
name

User-created cable

Display side     External 
 Device side

Termination
resistance : ON

CA3-ADPCOM-01

CA3-ADPTRM-01

RDA

RDB

SDA

SDB

SG

FG

+

-

+

-

120 1/2W 

Display

Termination
resistance

Terminal block

Signal name Shield ShieldSignal
name

Signal
name

User-created cable

Display side     External 
 Device side

    External 
 Device side

Termination
resistance : ON

Termination
resistance : OFF
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19B) 

• 1:1 Connection

• 1:n Connection

• Set the termination resistance selector switch of the External Device which terminates the 
connection to ON.

1

2

3

7

5

4

8

9

6

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

FG

+

-

120 1/2W 

Display

Termination
resistance

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield Signal
name

User-created cable

Display side     External 
 Device side

Termination
resistance : ON

1

2

3

7

5

4

8

9

6

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

FG

+

-

+

-

120 1/2W 

Display

Termination
resistance

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield ShieldSignal
name

Signal
name

User-created cable

Display side     External 
 Device side

    External 
 Device side

Termination
resistance : ON

Termination
resistance : OFF
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19C) 

• 1:1 Connection

• 1:n Connection

• Set the termination resistance selector switch of the External Device which terminates the 
connection to ON.

RDA

RDB

SDA

SDB

TERMRX

SG

FG

CA4-ADPONL-01

CA3-ADPTRM-01

+

-
Display

Terminal block

Signal name
Shield Signal

name

User-created cable

Display side     External 
 Device side

Termination
resistance : ON

CA4-ADPONL-01

CA3-ADPTRM-01

RDA

RDB

SDA

SDB

TERMRX

SG

FG

+

-

+

-
Display

Terminal block

Signal name
Shield ShieldSignal

name
Signal
name

User-created cable

Display side     External 
 Device side

    External 
 Device side

Termination
resistance : ON

Termination
resistance : OFF
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19D) 

• 1:1 Connection

1:n Connection

• Set the termination resistance selector switch of the External Device which terminates the 
connection to ON.

CA4-ADPONL-01
2

7

3

8

1

9

5

RDA

RDB

SDA

SDB

TERMRX

TERMTX

SG

FG

+

-Display

D-sub 9 pin (plug)

Pin Signal name

Shell

Shield
External Device side
Terminal block

Signal
name

User-created cable

Display side

Termination
resistance : ON

2

7

3

8

1

9

5

RDA

RDB

SDA

SDB

TERMRX

TERMTX

SG

FG

+

-

+

-

CA4-ADPONL-01

Display

D-sub 9 pin (plug)

Pin Signal name

Shell

Shield
External Device side
Terminal block

Signal
name

Signal
name

External Device side
Terminal blockShield

User-created cable

Display side

Termination
resistance : ON

Termination
resistance : OFF
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19E) 

• 1:1 Connection

• 1:n Connection

• Set the termination resistance selector switch of the External Device which terminates the 
connection to ON.

CA3-ADPCOM-01

CA3-ADPTRM-01

RDA

RDB

SDA

SDB

SG

FG

+

-

120 1/2W 

Display

Termination
resistance

Terminal block

Signal name Shield Signal
name

User-created cable

Display side     External 
 Device side

Termination
resistance : ON

CA3-ADPCOM-01

CA3-ADPTRM-01

RDA

RDB

SDA

SDB

SG

FG

+

-

+

-

120 1/2W 

Display

Termination
resistance

Signal name Shield ShieldSignal
name

Signal
name

User-created cable

Terminal block
Display side     External 

 Device side
    External 
 Device side

Termination
resistance : ON

Termination
resistance : OFF



General MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 220

19F) 

• 1:1 Connection

• 1:n Connection

• Set the termination resistance selector switch of the External Device which terminates the 
connection to ON.

1

2

3

7

5

4

8

9

6

DATA+

DATA-

NC

NC

GND(SG)

ERA

CSA

ERB

CSB

FG

+

-

120 1/2W 

Display

Termination
resistance

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield Signal
name

User-created cable

Display side     External 
 Device side

Termination
resistance : ON

1

2

3

7

5

4

8

9

6

DATA+

DATA-

NC

NC

GND(SG)

ERA

CSA

ERB

CSB

FG

+

-

+

-

120 1/2W 

Display

Termination
resistance

D-sub 9 pin (socket)

Pin Signal name

Shell

Shield ShieldSignal
name

Signal
name

User-created cable

Display side     External 
 Device side

    External 
 Device side

Termination
resistance : ON

Termination
resistance : OFF
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19G) 

• 1:1 Connection

• 1:n Connection

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.

• Set the termination resistance selector switch of the External Device which terminates the 
connection to ON.

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

+

-

Display

Termination
resistance*1

Display side 
Terminal block

Signal name Shield Signal
name

User-created cable

    External 
 Device side

Termination
resistance : ON

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

+

-

+

-

Display

Termination
resistance*1 Signal name

Shield ShieldSignal
name

Signal
name

User-created cable

Display side 
Terminal block

    External 
 Device side

    External 
 Device side

Termination
resistance : ON

Termination
resistance : OFF
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19H) 

• 1:1 Connection

• 1:n Connection

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 
connector. Do not use it for other devices.

• Set the termination resistance selector switch of the External Device which terminates the con-
nection to ON.

• In COM on the GP-4107, the SG and FG terminals are isolated.

+

-

120 1/2W 

Display

Termination
resistance Pin Signal name Shield Signal

name

User-created cable

Display side
D-Sub 9pin (plug)

3

8

1

2

5

4

6

7

9

Shell

NC

NC

GND(SG)

RS(RTS)

5V

NC

NC

FG

LINE(+)

LINE(-)

    External 
 Device side

Termination
resistance : ON

+

-

+

-

120 1/2W 

Display

Termination
resistance Pin Signal name

Shield ShieldSignal
name

Signal
name

Display side
D-Sub 9pin (plug)

3

8

1

2

5

4

6

7

9

Shell

NC

NC

GND(SG)

RS(RTS)

5V

NC

NC

FG

LINE(+)

LINE(-)

User-created cable

    External 
 Device side

    External 
 Device side

Termination
resistance : ON

Termination
resistance : OFF
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19I)

• 1:1 Connection

• 1:n Connection

• Set the termination resistance selector switch of the External Device which terminates the 
connection to ON.

PFXZCBADTM1

RDA

RDB

SDA

SDB

SG

FG

+

-

120 1/2W 

Display

Termination
resistance

Terminal block

Signal name Shield Signal
name

User-created cable

Display side     External 
 Device side

Termination
resistance : ON

PFXZCBADTM1

RDA

RDB

SDA

SDB

SG

FG

+

-

+

-

120 1/2W 

Display

Termination
resistance

Terminal block

Signal name Shield ShieldSignal
name

Signal
name

User-created cable

Display side     External 
 Device side

    External 
 Device side

Termination
resistance : ON

Termination
resistance : OFF
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19J) 

• 1:1 Connection

• 1:n Connection

• Set the termination resistance selector switch of the External Device which terminates the 
connection to ON.

Number Name Notes

(1)
RJ45 RS-485 Cable (5m) by Pro-face

PFXZLMCBRJR81

+

-

Signal
name

    External 
 Device side

Display

D0

D1

(1) Termination
resistance : ON

+

-

+

-

ShieldSignal
name

Signal
name

User-created cable

    External 
 Device side

    External 
 Device side

Display

D0

D1

(1)

220Ω(1/4W)

Termination
resistance

220Ω(1/4W)

Termination
resistance
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19K) 

• 1:1 Connection

• 1:n Connection

• Set the termination resistance selector switch of the External Device which terminates the 
connection to ON.

2 

1 

3 

7 

5 

4 

8 

9 

6 

DATA+ 

DATA- 

NC 

NC 

NC 

NC 

NC 

NC 

GND 

FG 

+ 

- 

120 1 / 2 W  

Display 

Termination 
resistance 

D-sub 9 pin (socket) 

Pin Signal name 

Shell 

Shield Signal 
name 

User-created cable 

Display side     External  
 Device side 

Termination
resistance : ON

2 

1 

3 

7 

5 

4 

8 

9 

6 

DATA+ 

DATA- 

NC 

NC 

NC 

NC 

NC 

NC 

GND 

FG 

+ 

- 

+ 

- 

120 1 / 2 W  

Display 

Termination 
resistance 

D-sub 9 pin (socket) 

Pin Signal name 

Shell 

Shield Shield Signal 
name 

Signal 
name 

User-created cable 

Display side     External  
 Device side 

    External  
 Device side 

Termination
resistance : ON

Termination
resistance : OFF
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6.20 Cable Diagram 20

Display
(Connection Port)

Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module (COM1)
ST3000*2 (COM2)
LT3000 (COM1)
IPC*3

*1 All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 Only the COM port which can communicate by RS-422/485 (4 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 9)

20A

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

Cable length: 
500m or less

20B User-created cable

GP3000*4 (COM2)

*4 All GP3000 models except GP-3200 series and AGP-3302B

20C

Online adapter by Pro-face
CA4-ADPONL-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
Cable length: 
500m or less

20D

Online adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

GP-4106 (COM1)
GP-4116T (COM1) 20E User-created cable Cable length: 

500m or less

GP4000*5 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000 (COM1/2)*6 
(COM1/2)
SP-5B00 (COM2)
ST6000*7 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
PS6000 (Basic Box) 
(COM1/2)

*5 All GP4000 models except GP-4100 Series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*6 Except SP-5B00

20F

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1*8

+
User-created cable

Cable length: 
500m or less

20B User-created cable

PE-4000B*9

PS5000*9

PS6000 (Optional 
Interface)*9

20G User-created cable Cable length: 
500m or less
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*7 Except ST-6200

*8 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 20A.

*9 Only the COM port which can communicate by RS-422/485 (4 wire) can be used.
 IPC COM Port (page 9)
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20A)

• 1:1 Connection

• 1:n Connection

• Please set the terminating resistor switch of the External Device to the "100" position.

• Please set the terminating resistor switch to the "100" position only on the last External 
Device in the chain.

External Device side
Terminal Block

TERM

RDA

RDB

SDA

SDB

SG

FG

Signal name

Display side
Terminal Block

Shield

CA3-ADPTRM-01

CA3-ADPCOM-01
Display

User-created cable

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

External Device side
Terminal Block

External Device side
Terminal Block

TERM

RDA

RDB

SDA

SDB

SG

FG

Signal name

Display side
Terminal Block

Shield
Shield

CA3-ADPTRM-01

CA3-ADPCOM-01
Display

User-created cable

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

SDA2 (TXD2+)

SDB2 (TXD2-)

RDA2 (RXD2+)

RDB2 (RXD2-)

SG (GND)
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20B)

• 1:1 Connection

• 1:n Connection

• Please set the terminating resistor switch of the External Device to the "100" position.

• Please set the terminating resistor switch to the "100" position only on the last External 
Device in the chain.

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

FG

Signal name
1

2

3

7

5

4

8

9

6

Shell

Pin

Display side
D-Sub 9pin (socket)

External Device side
Terminal Block

Shield
Termination

resistance
100Ω (1/2W)

Display

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

External Device side
Terminal Block

External Device side
Terminal Block

Shield
Shield

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

FG

Signal name
1

2

3

7

5

4

8

9

6

Shell

Pin

Display side
D-Sub 9pin (socket)Termination

resistance
100Ω (1/2W)

Display

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

SDA2 (TXD2+)

SDB2 (TXD2-)

RDA2 (RXD2+)

RDB2 (RXD2-)

SG (GND)
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20C)

• 1:1 Connection

• 1:n Connection

• Please set the terminating resistor switch of the External Device to the "100" position.

• Please set the terminating resistor switch to the "100" position only on the last External 
Device in the chain.

External Device side
Terminal Block

TERM

RDA

RDB

SDA

SDB

SG

FG

Signal name

Display side
Terminal Block

Shield

CA3-ADPTRM-01

CA4-ADPONL-01
Display

User-created cable

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

External Device side
Terminal Block

External Device side
Terminal Block

TERM

RDA

RDB

SDA

SDB

SG

FG

Signal name

Display side
Terminal Block

Shield
Shield

CA3-ADPTRM-01

CA4-ADPONL-01
Display

User-created cable

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

SDA2 (TXD2+)

SDB2 (TXD2-)

RDA2 (RXD2+)

RDB2 (RXD2-)

SG (GND)
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20D)

• 1:1 Connection

• 1:n Connection

• Please set the terminating resistor switch of the External Device to the "100" position.

• Please set the terminating resistor switch to the "100" position only on the last External 
Device in the chain.

TERMRX

RDA

RDB

SDA

SDB

SG

TERMTX

FG

Signal name
1

2

7

3

8

5

9

Shell

Pin

Display side
D-Sub 9pin (plug)

CA4-ADPONL-01
Display

External Device side
Terminal Block

Shield

User-created cable

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

External Device side
Terminal Block

External Device side
Terminal Block

Shield
Shield

CA4-ADPONL-01
Display

TERMRX

RDA

RDB

SDA

SDB

SG

TERMTX

FG

Signal name
1

2

7

3

8

5

9

Shell

Pin

Display side
D-Sub 9pin (plug)

User-created cable

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

SDA2 (TXD2+)

SDB2 (TXD2-)

RDA2 (RXD2+)

RDB2 (RXD2-)

SG (GND)
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20E)

• 1:1 Connection

• 1:n Connection

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.    

• Please set the terminating resistor switch of the External Device to the "100" position.

• Please set the terminating resistor switch to the "100" position only on the last External 
Device in the chain.

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

Signal name

Display side
Terminal block

External Device side
Terminal Block

ShieldTermination
resistance*1

Display

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

External Device side
Terminal Block

External Device side
Terminal Block

Shield
Shield

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

Signal name

Display side
Terminal block 

Termination
resistance*1

Display

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

SDA2 (TXD2+)

SDB2 (TXD2-)

RDA2 (RXD2+)

RDB2 (RXD2-)

SG (GND)
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20F)

• 1:1 Connection

• 1:n Connection

• Please set the terminating resistor switch of the External Device to the "100" position.

• Please set the terminating resistor switch to the "100" position only on the last External 
Device in the chain.

External Device side 
Terminal Block 

TERM 

RDA 

RDB 

SDA 

SDB 

SG 

FG 

Signal name 

Display side 
Terminal Block 

Shield 
Display

User-created cable 

Signal name 

SDA1 (TXD1+) 

SDB1 (TXD1-) 

RDA1 (RXD1+) 

RDB1 (RXD1-) 

SG (GND) 

PFXZCBADTM1

External Device side 
Terminal Block 

External Device side 
Terminal Block 

TERM 

RDA 

RDB 

SDA 

SDB 

SG 

FG 

Signal name 

Display side 
Terminal Block 

Shield 
Shield Display

User-created cable 

Signal name 

SDA1 (TXD1+) 

SDB1 (TXD1-) 

RDA1 (RXD1+) 

RDB1 (RXD1-) 

SG (GND) 

Signal name 

SDA1 (TXD1+) 

SDB1 (TXD1-) 

RDA1 (RXD1+) 

RDB1 (RXD1-) 

SG (GND) 

SDA2 (TXD2+) 

SDB2 (TXD2-) 

RDA2 (RXD2+) 

RDB2 (RXD2-) 

SG (GND) 

PFXZCBADTM1
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20G)

• 1:1 Connection

• 1:n Connection

• Please set the terminating resistor switch of the External Device to the "100" position.

• Please set the terminating resistor switch to the "100" position only on the last External 
Device in the chain.

Rx+

Rx-

Tx+

Tx-

GND

NC

NC

NC

NC

FG

Signal name
3

4

2

1

5

7

8

9

6

Shell

Pin

Display side
D-Sub 9pin (socket)

External Device side
Terminal Block

Shield
Termination

resistance
100Ω (1/2W)

Display

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

External Device side
Terminal Block

External Device side
Terminal Block

Shield
Shield

Rx+

Rx-

Tx+

Tx-

GND

NC

NC

NC

NC

FG

Signal name
3

4

2

1

5

7

8

9

6

Shell

Pin

Display side
D-Sub 9pin (socket)Termination

resistance
100Ω (1/2W)

Display

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

SDA2 (TXD2+)

SDB2 (TXD2-)

RDA2 (RXD2+)

RDB2 (RXD2-)

SG (GND)



General MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 235

6.21 Cable Diagram 21

Display
(Connection Port)

Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module (COM1)
ST3000*2 (COM2)
LT3000 (COM1)

21A

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

Cable length: 
500m or less

21B User-created cable

GP3000*3 (COM2)

21C

Online adapter by Pro-face
CA4-ADPONL-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
Cable length: 
500m or less

21D

Online adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

IPC*4
21E

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

Cable length: 
500m or less

21F User-created cable

GP-4106 (COM1)
GP-4116T (COM1) 21G User-created cable Cable length: 

500m or less

GP-4107 (COM1)
GP-4*03T*5 (COM2)
GP-4203T (COM1)

21H User-created cable Cable length: 
500m or less

GP4000*6 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000 (COM1/2)*7 
(COM1/2)
SP-5B00 (COM2)
ST6000*8 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
PS6000 (Basic Box) 
(COM1/2)

21I

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1*9

+
User-created cable

Cable length: 
500m or less

21B User-created cable

LT-4*01TM (COM1)
LT-Rear Module (COM1) 21J

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81 Cable length: 

200m or less
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PE-4000B*10

PS5000*10

PS6000 (Optional 
Interface)*10

21K User-created cable Cable length: 
500m or less

*1 All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 All GP3000 models except GP-3200 series and AGP-3302B

*4 Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 9)

*5 Except GP-4203T

*6 All GP4000 models except GP-4100 Series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7 Except SP-5B00

*8 Except ST-6200

*9 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 21A.

*10 Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
 IPC COM Port (page 9)

Display
(Connection Port)

Cable Notes
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21A)

• 1:1 Connection

• 1:n Connection

• Please set the terminating resistor switch of the External Device to the "100" position.

• Please set the terminating resistor switch to the "100" position only on the last External 
Device in the chain.

External Device side
Terminal Block

TERM

RDA

RDB

SDA

SDB

SG

FG

Signal name

Display side
Terminal Block

Shield

CA3-ADPTRM-01

CA3-ADPCOM-01
Display

User-created cable

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

External Device side
Terminal Block

External Device side
Terminal Block

TERM

RDA

RDB

SDA

SDB

SG

FG

Signal name

Display side
Terminal Block

Shield
Shield

CA3-ADPTRM-01

CA3-ADPCOM-01
Display

User-created cable

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

SDA2 (TXD2+)

SDB2 (TXD2-)

RDA2 (RXD2+)

RDB2 (RXD2-)

SG (GND)
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21B)

• 1:1 Connection

• 1:n Connection

• Please set the terminating resistor switch of the External Device to the "100" position.

• Please set the terminating resistor switch to the "100" position only on the last External 
Device in the chain.

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

FG

Signal name
1

2

3

7

5

4

8

9

6

Shell

Pin

Display side
D-Sub 9pin (socket)

Shield

External Device side
Terminal Block

Termination
resistance

100Ω (1/2W)

Display

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

External Device side
Terminal Block

External Device side
Terminal Block

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

FG

Signal name
1

2

3

7

5

4

8

9

6

Shell

Pin

Display side
D-Sub 9pin (socket)

Termination
resistance

100Ω (1/2W)
Shield Shield

Display

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

SDA2 (TXD2+)

SDB2 (TXD2-)

RDA2 (RXD2+)

RDB2 (RXD2-)

SG (GND)
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21C)

• 1:1 Connection

• 1:n Connection

• Please set the terminating resistor switch of the External Device to the "100" position.

• Please set the terminating resistor switch to the "100" position only on the last External 
Device in the chain.

External Device side
Terminal Block

TERM

RDA

RDB

SDA

SDB

SG

FG

Signal name

Display side
Terminal Block

Shield

CA3-ADPTRM-01

CA4-ADPONL-01
Display

User-created cable

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

External Device side
Terminal Block

External Device side
Terminal Block

TERM

RDA

RDB

SDA

SDB

SG

FG

Signal name

Display side
Terminal Block

Shield
Shield

CA3-ADPTRM-01

CA4-ADPONL-01
Display

User-created cable

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

SDA2 (TXD2+)

SDB2 (TXD2-)

RDA2 (RXD2+)

RDB2 (RXD2-)

SG (GND)
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21D)

• 1:1 Connection

• 1:n Connection

• Please set the terminating resistor switch of the External Device to the "100" position.

• Please set the terminating resistor switch to the "100" position only on the last External 
Device in the chain.

TERMRX

RDA

RDB

SDA

SDB

SG

TERMTX

FG

Signal name
1

2

7

3

8

5

9

Shell

Pin

Display side
D-Sub 9pin (plug)

CA4-ADPONL-01
Display

External Device side
Terminal Block

Shield

User-created cable

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

External Device side
Terminal Block

External Device side
Terminal Block

CA4-ADPONL-01
Display

TERMRX

RDA

RDB

SDA

SDB

SG

TERMTX

FG

Signal name
1

2

7

3

8

5

9

Shell

Pin

Display side
D-Sub 9pin (plug)

Shield Shield

User-created cable

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

SDA2 (TXD2+)

SDB2 (TXD2-)

RDA2 (RXD2+)

RDB2 (RXD2-)

SG (GND)
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21E)

• 1:1 Connection

• 1:n Connection

• Please set the terminating resistor switch of the External Device to the "100" position.

• Please set the terminating resistor switch to the "100" position only on the last External 
Device in the chain.

External Device side
Terminal Block

TERM

RDA

RDB

SDA

SDB

SG

FG

Signal name

Display side
Terminal Block

Shield

CA3-ADPTRM-01

CA3-ADPCOM-01
Display

User-created cable

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

External Device side
Terminal Block

TERM

RDA

RDB

SDA

SDB

SG

FG

Signal name

Display side
Terminal Block

Shield

CA3-ADPTRM-01

CA3-ADPCOM-01
Display

User-created cable

External Device side
Terminal Block

Shield Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

SDA2 (TXD2+)

SDB2 (TXD2-)

RDA2 (RXD2+)

RDB2 (RXD2-)

SG (GND)
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21F)

• 1:1 Connection

• 1:n Connection

• Please set the terminating resistor switch of the External Device to the "100" position.

• Please set the terminating resistor switch to the "100" position only on the last External 
Device in the chain.

DATA+

DATA-

NC

NC

GND(SG)

ERA

CSA

ERB

CSB

FG

Signal name
1

2

3

7

5

4

8

9

6

Shell

Pin

Display side
D-Sub 9pin (socket)

Shield

External Device side
Terminal Block

Termination
resistance

100Ω (1/2W)

Display

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

External Device side
Terminal Block

DATA+

DATA-

NC

NC

GND(SG)

ERA

CSA

ERB

CSB

FG

Signal name
1

2

3

7

5

4

8

9

6

Shell

Pin

Display side
D-Sub 9pin (socket)

Termination
resistance

100Ω (1/2W)
Shield

Display

External Device side
Terminal Block

Shield Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

SDA2 (TXD2+)

SDB2 (TXD2-)

RDA2 (RXD2+)

RDB2 (RXD2-)

SG (GND)



General MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 243

21G)

• 1:1 Connection

• 1:n Connection

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the 
rear of the Display as shown in the table below.  

• Please set the terminating resistor switch of the External Device to the "100" position.

• Please set the terminating resistor switch to the "100" position only on the last External 
Device in the chain.

DIP Switch No. Set Value

1 OFF

2 OFF

3 ON

4 ON

RDA 

RDB 

SDA 

SDB 

SG 

ERA 

CSA 

ERB 

CSB 

Signal name 

Display side 
Terminal block  

Shield 

External Device side
Terminal Block 

Termination 
resistance*1 

Display 

Signal name 

SDA1 (TXD1+) 

SDB1 (TXD1-) 

RDA1 (RXD1+) 

RDB1 (RXD1-) 

SG (GND) 

External Device side
Terminal Block

External Device side
Terminal Block

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

Signal name

Display side
Terminal block 

Termination
resistance*1

Shield Shield

Display

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

SDA2 (TXD2+)

SDB2 (TXD2-)

RDA2 (RXD2+)

RDB2 (RXD2-)

SG (GND)
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21H)

• 1:1 Connection

• 1:n Connection

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 
connector. Do not use it for other devices.

• Please set the terminating resistor switch of the External Device to the "100" position.
• In COM on the GP-4107, the SG and FG terminals are isolated.

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 
connector. Do not use it for other devices.

• Please set the terminating resistor switch to the "100" position only on the last External 
Device in the chain.

• In COM on the GP-4107, the SG and FG terminals are isolated.

Signal namePin

Display side
D-Sub 9pin (plug)

Shield

External Device side
Terminal Block

Termination
resistance

100Ω (1/2W)

Display

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

3

8

1

2

5

4

6

7

9

Shell

NC

NC

GND(SG)

RS(RTS)

5V

NC

NC

FG

LINE(+)

LINE(-)

External Device side
Terminal Block

Signal namePin

Display side
D-Sub 9pin (plug)

Termination
resistance

100Ω (1/2W)
Shield

Display

External Device side
Terminal Block

Shield Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

SDA2 (TXD2+)

SDB2 (TXD2-)

RDA2 (RXD2+)

RDB2 (RXD2-)

SG (GND)

NC

NC
GND(SG)

RS(RTS)
5V

NC

NC

FG

3

8

1

2

5

4

6

7

9

Shell

LINE(+)

LINE(-)
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21I)

• 1:1 Connection

• 1:n Connection

• Please set the terminating resistor switch of the External Device to the "100" position.

• Please set the terminating resistor switch to the "100" position only on the last External 
Device in the chain.

External Device side 
Terminal Block 

TERM 

RDA 

RDB 

SDA 

SDB 

SG 

FG 

Signal name 

Display side 
Terminal Block 

Shield 
Display

User-created cable 

Signal name 

SDA1 (TXD1+) 

SDB1 (TXD1-) 

RDA1 (RXD1+) 

RDB1 (RXD1-) 

SG (GND) 

PFXZCBADTM1

External Device side 
Terminal Block 

External Device side 
Terminal Block 

TERM 

RDA 

RDB 

SDA 

SDB 

SG 

FG 

Signal name 

Display side 
Terminal Block 

Shield 
Shield 

Display

User-created cable 

Signal name 

SDA1 (TXD1+) 

SDB1 (TXD1-) 

RDA1 (RXD1+) 

RDB1 (RXD1-) 

SG (GND) 

Signal name 

SDA1 (TXD1+) 

SDB1 (TXD1-) 

RDA1 (RXD1+) 

RDB1 (RXD1-) 

SG (GND) 

SDA2 (TXD2+) 

SDB2 (TXD2-) 

RDA2 (RXD2+) 

RDB2 (RXD2-) 

SG (GND) 

PFXZCBADTM1
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21J)

• 1:1 Connection

• 1:n Connection

• Please set the terminating resistor switch of the External Device to the "100" position.

Number Name Notes

(1)
RJ45 RS-485 Cable (5m) by Pro-face

PFXZLMCBRJR81

External Device side
Terminal Block 

Signal name 

SDA1 (TXD1+) 

SDB1 (TXD1-) 

RDA1 (RXD1+) 

RDB1 (RXD1-) 

SG (GND) 

Display

GND

D0

D1

(1)

External Device side 
Terminal Block 

External Device side 
Terminal Block 

Shield Signal name 

SDA1 (TXD1+) 

SDB1 (TXD1-) 

RDA1 (RXD1+) 

RDB1 (RXD1-) 

SG (GND) 

Signal name 

SDA1 (TXD1+) 

SDB1 (TXD1-) 

RDA1 (RXD1+) 

RDB1 (RXD1-) 

SG (GND) 

SDA2 (TXD2+) 

SDB2 (TXD2-) 

RDA2 (RXD2+) 

RDB2 (RXD2-) 

SG (GND) 

Display

GND

D0

D1

(1)

User-created Cable

Termination
resistance

220Ω(1/4W)

Termination
resistance
220Ω(1/4W)
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21K)

• 1:1 Connection

• 1:n Connection

• Please set the terminating resistor switch of the External Device to the "100" position.

• Please set the terminating resistor switch to the "100" position only on the last External 
Device in the chain.

DATA+

DATA-

NC

NC

GND

NC

NC

NC

NC

FG

Signal name
2

1

3

7

5

4

8

9

6

Shell

Pin

Display side
D-Sub 9pin (socket)

Shield

External Device side
Terminal Block

Termination
resistance

100Ω (1/2W)

Display

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

External Device side
Terminal Block

DATA+

DATA-

NC

NC

GND

NC

NC

NC

NC

FG

Signal name
2

1

3

7

5

4

8

9

6

Shell

Pin

Display side
D-Sub 9pin (socket)

Termination
resistance

100Ω (1/2W)
Shield

Display

External Device side
Terminal Block

Shield Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

Signal name

SDA1 (TXD1+)

SDB1 (TXD1-)

RDA1 (RXD1+)

RDB1 (RXD1-)

SG (GND)

SDA2 (TXD2+)

SDB2 (TXD2-)

RDA2 (RXD2+)

RDB2 (RXD2-)

SG (GND)



General MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 248

6.22 Cable Diagram 22

Display
(Connection Port)

Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module (COM1)
ST3000*2 (COM2)
LT3000 (COM1)
IPC*3

*1 All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 Only the COM port which can communicate by RS-422/485 (4 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 9)

22A

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

Cable length: 500m 
or less

22B User-created cable

GP3000*4 (COM2)

*4 All GP3000 models except GP-3200 series and AGP-3302B.

22C

Online adapter by Pro-face
CA4-ADPONL-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
Cable length: 500m 
or less

22D

Online adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

GP-4106 (COM1)
GP-4116T (COM1) 22E User-created cable Cable length: 500m 

or less

GP4000*5 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000 (COM1/2)*6 
(COM1/2)
SP-5B00 (COM2)
ST6000*7 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
PS6000 (Basic Box) 
(COM1/2)

*5 All GP4000 models except GP-4100 Series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*6 Except SP-5B00

22F

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1*8

+
User-created cable

Cable length: 500m 
or less

22B User-created cable

PE-4000B*9

PS5000*9

PS6000 (Optional 
Interface)*9

22G User-created cable Cable length: 500m 
or less
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Recommended cables and connectors

22A)

22B)

*7 Except ST-6200

*8 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 22A.

*9 Only the COM port which can communicate by RS-422/485 (4 wire) can be used.
 IPC COM Port (page 9)

Item Type Manufacturer

10BASE-T cable SGLPEV-T 0.5mmx4P*1

*1 Do not use pin number 2 or 8.

Mitsubishi Electric Corporation

RJ45 connector 5-554720-3 Tyco Electronics AMP K.K.

SDA

SDB

RDA

RDB

SG

External Device side

RJ45 connector

Signal name

5

4

3

6

1

Pin

RDA

RDB

SDA

SDB

SG

FG

Signal name

Display side

Terminal Block

CA3-ADPTRM-01

CA3-ADPCOM-01

Display

User-created cable

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

FG

Signal name

1

2

3

7

5

4

8

9

6

Shell

Pin

Display side

D-Sub 9pin (socket)

SDA

SDB

RDA

RDB

SG

Signal name

5

4

3

6

1

Pin

External Device side

RJ45 connector

Display
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22C)

22D)

22E)

SDA

SDB

RDA

RDB

SG

External Device side

RJ45 connector

Signal name

5

4

3

6

1

Pin

RDA

RDB

SDA

SDB

SG

FG

Signal name

Display side

Terminal Block

User-created cable

CA3-ADPTRM-01

CA4-ADPONL-01

Display

TERMRX

RDA

RDB

SDA

SDB

SG

TERMTX

FG

Signal name

1

2

7

3

8

5

9

Shell

Pin

Display side

D-Sub 9pin (plug)

SDA

SDB

RDA

RDB

SG

Signal name

5

4

3

6

1

Pin

External Device side

RJ45 connector

CA4-ADPONL-01

Display

User-created cable

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

Signal name

Display side
Terminal block

SDA

SDB

RDA

RDB

SG

Signal name

5

4

3

6

1

Pin

External Device side
RJ45 connector

Display
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22F)

22G)

SDA

SDB

RDA

RDB

SG

External Device side
RJ45 connector

Signal name

5

4

3

6

1

Pin

RDA

RDB

SDA

SDB

SG

FG

Signal name

Display side
Terminal Block

Display

User-created cable

PFXZCBADTM1

Rx+

Rx-

Tx+

Tx-

GND

NC

NC

NC

NC

FG

Signal name

3

4

2

1

5

7

8

9

6

Shell

Pin

Display side
D-Sub 9pin (socket)

SDA

SDB

RDA

RDB

SG

Signal name

5

4

3

6

1

Pin

External Device side
RJ45 connector

Display
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6.23 Cable Diagram 23

Display
(Connection Port)

Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module 
(COM1)
ST3000*2 (COM2)
LT3000 (COM1)

23A

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length must 
be 500m or less.

23B User-created cable

GP3000*3 (COM2)

23C

Online adapter by Pro-face
CA4-ADPONL-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
The cable length must 
be 500m or less.

23D

Online adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

IPC*4
23E

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length must 
be 500m or less.

23F User-created cable

GP-4106 (COM1)
GP-4116T (COM1) 23G User-created cable The cable length must 

be 500m or less.

GP-4107 (COM1)
GP-4*03T*5 (COM2)
GP-4203T (COM1)

23H User-created cable The cable length must 
be 500m or less.

GP4000*6 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000 (COM1/2)*7 
(COM1/2)
SP-5B00 (COM2)
ST6000*8 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
PS6000 (Basic Box) 
(COM1/2)

23I

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1*9

+
User-created cable

The cable length must 
be 500m or less.

23B User-created cable
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LT-4*01TM (COM1)
LT-Rear Module 
(COM1) 23J

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81 The cable length must 

be 200m or less.

PE-4000B*10

PS5000*10

PS6000 (Optional 
Interface)*10

23K User-created cable The cable length must 
be 500m or less.

*1 All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 All GP3000 models except GP-3200 series and AGP-3302B

*4 Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 9)

*5 Except GP-4203T

*6 All GP4000 models except GP-4100 Series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7 Except SP-5B00

*8 Except ST-6200

*9 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 23A.

*10 Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
 IPC COM Port (page 9)

Display
(Connection Port)

Cable Notes
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23A)

• 1:1 Connection

• 1:n Connection

Display
RDA

RDB

SDA

SDB

SG

FG

CA3-ADPTRM-01

CA3-ADPCOM-01

YB(+)

YA(-)

COM

External Device
Terminal block

Display side
Terminal block

ShieldSignal
name

Signal
name

User-created cable

Display
RDA

RDB

SDA

SDB

SG

FG

CA3-ADPTRM-01

CA3-ADPCOM-01

YB(+)

YA(-)

COM

External Device
Terminal block

Display side
Terminal block

ShieldSignal
name

Signal
name

YB(+)

YA(-)

COM

External Device
Terminal blockShield

Signal
name

User-created cable
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23B) 

• 1:1 Connection

• 1:n Connection

External Device

Display side

Shield
Signal
name

Signal
name

1

2

3

7

5

4

8

9

6

Shell

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

FG

YB(+)

YA(-)

COM

Pin

D-sub 9 pin (socket)

Terminal block

Display

External Device

Display side

Shield
Signal
name

Signal
name

1

2

3

7

5

4

8

9

6

Shell

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

FG

YB(+)

YA(-)

COM

Pin

D-sub 9 pin (socket)

Terminal block
External Device

Shield
Signal
name

YB(+)

YA(-)

COM

Terminal block

Display
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23C)

• 1:1 Connection

• 1:n Connection

Display
RDA

RDB

SDA

SDB

SG

FG

CA3-ADPTRM-01

CA4-ADPONL-01

YB(+)

YA(-)

COM

External Device
Terminal block

Display side
Terminal block

ShieldSignal
name

Signal
name

User-created cable

Display
RDA

RDB

SDA

SDB

SG

FG

CA3-ADPTRM-01

CA4-ADPONL-01

YB(+)

YA(-)

COM

External Device
Terminal block

Display side
Terminal block

ShieldSignal
name

Signal
name

YB(+)

YA(-)

COM

External Device
Terminal blockShield

Signal
name

User-created cable
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23D)

• 1:1 Connection

• 1:n Connection

Display
RDA

RDB

SDA

SDB

SG

TERMTX

FG

CA4-ADPONL-01

External Device

Display side

ShieldSignal
name

Signal
name

2

7

3

8

5

9

Shell

YB(+)

YA(-)

COM

Pin

D-sub 9 pin (plug)

Terminal block

User-created cable

Display
RDA

RDB

SDA

SDB

SG

TERMTX

FG

CA4-ADPONL-01

External Device

Display side

ShieldSignal
name

Signal
name

2

7

3

8

5

9

Shell

YB(+)

YA(-)

COM

Pin

D-sub 9 pin (plug)

Terminal block
External Device

Shield
Signal
name

YB(+)

YA(-)

COM

Terminal block

User-created cable
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23E)

• 1:1 Connection

• 1:n Connection

Display
RDA

RDB

SDA

SDB

SG

FG

CA3-ADPTRM-01

CA3-ADPCOM-01 YB(+)

YA(-)

COM

External Device
Terminal block

Display side
Terminal block

ShieldSignal
name

Signal
name

User-created cable

Display
RDA

RDB

SDA

SDB

SG

FG

CA3-ADPTRM-01

CA3-ADPCOM-01 YB(+)

YA(-)

COM

External Device
Terminal block

Display side
Terminal block

ShieldSignal
name

Signal
name

YB(+)

YA(-)

COM

External Device
Terminal block

Shield Signal
name

User-created cable
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23F)

• 1:1 Connection

• 1:n Connection

External DeviceDisplay side

Shield
Signal
name

Signal
name

1

2

3

7

5

4

8

9

6

Shell

DATA+

DATA-

NC

NC

GND(SG)

ERA

CSA

ERB

CSB

FG

YB(+)

YA(-)

COM

Pin

D-sub 9 pin (socket) Terminal block

Display

External DeviceDisplay side

Shield
Signal
name

Signal
name

1

2

3

7

5

4

8

9

6

Shell

DATA+

DATA-

NC

NC

GND(SG)

ERA

CSA

ERB

CSB

FG

YB(+)

YA(-)

COM

Pin

D-sub 9 pin (socket) Terminal block
External Device

Shield
Signal
name

YB(+)

YA(-)

COM

Terminal block

Display
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23G) 

• 1:1 Connection

• 1:n Connection

External DeviceShield
Signal
name

Signal
name

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

YB(+)

YA(-)

COM

Terminal block

Display

Display side 
Terminal block

External DeviceShield
Signal
name

Signal
name

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

YB(+)

YA(-)

COM

Terminal block
External Device

Shield
Signal
name

YB(+)

YA(-)

COM

Terminal block

Display

Display side 
Terminal block
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23H)

• 1:1 Connection

• 1:n Connection

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 
connector. Do not use it for other devices.

• In COM on the GP-4107, the SG and FG terminals are isolated.

External Device

Shield
Signal
name

YB(+)

YA(-)

COM

Terminal block

Display

Pin Signal name

NC

NC

GND(SG)

RS(RTS)

5V

NC

NC

FG

LINE(+)

LINE(-)

3

8

1

2

5

4

6

7

9

Shell

Display side
D-Sub 9pin (plug)

External Device

Shield
Signal
name

YB(+)

YA(-)

COM

Terminal block
External Device

Shield
Signal
name

YB(+)

YA(-)

COM

Terminal block

Display

Pin Signal name

NC

NC

GND(SG)

RS(RTS)

5V

NC

NC

FG

LINE(+)

LINE(-)

3

8

1

2

5

4

6

7

9

Shell

Display side
D-Sub 9pin (plug)
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23I)

• 1:1 Connection

• 1:n Connection

Display
RDA

RDB

SDA

SDB

SG

FG

PFXZCBADTM1
YB(+)

YA(-)

COM

External Device
Terminal block

Display side
Terminal block

ShieldSignal
name

Signal
name

User-created cable

Display
RDA

RDB

SDA

SDB

SG

FG

PFXZCBADTM1
YB(+)

YA(-)

COM

External Device
Terminal block

Display side
Terminal block

ShieldSignal
name

Signal
name

YB(+)

YA(-)

COM

External Device
Terminal blockShield

Signal
name

User-created cable
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23J)

• 1:1 Connection

• 1:n Connection

Number Name Notes

(1)
RJ45 RS-485 Cable (5m) by Pro-face

PFXZLMCBRJR81

External Device

Signal
name

YB(+)

YA(-)

COM

Terminal block

Display

GND

D0

D1

(1)

External Device

Signal
name

YB(+)

YA(-)

COM

Terminal block
External Device

Shield
Signal
name

YB(+)

YA(-)

COM

Terminal block

Display

GND

D0

D1

(1)

User-created Cable



General MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 264

23K)

• 1:1 Connection

• 1:n Connection

External DeviceDisplay side

Shield
Signal
name

Signal
name

2

1

3

7

5

4

8

9

6

Shell

DATA+

DATA-

NC

NC

GND

NC

NC

NC

NC

FG

YB(+)

YA(-)

COM

Pin

D-sub 9 pin (socket) Terminal block

Display

External DeviceDisplay side

Shield
Signal
name

Signal
name

2

1

3

7

5

4

8

9

6

Shell

DATA+

DATA-

NC

NC

GND

NC

NC

NC

NC

FG

YB(+)

YA(-)

COM

Pin

D-sub 9 pin (socket) Terminal block
External Device

Shield
Signal
name

YB(+)

YA(-)

COM

Terminal block

Display
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6.24 Cable Diagram 24

Display
(Connection Port)

Cable Notes

GP3000*1 (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module 
(COM1)
ST3000*2 (COM2)
LT3000 (COM1)

24A

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length must 
be 500m or less.

24B User-created cable

GP3000*3 (COM2)

24C

Online adapter by Pro-face
CA4-ADPONL-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
The cable length must 
be 500m or less.

24D

Online adapter by Pro-face
CA4-ADPONL-01

+
User-created cable

IPC*4
24E

COM port conversion adapter by Pro-face
CA3-ADPCOM-01

+
Terminal block conversion adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable

The cable length must 
be 500m or less.

24F User-created cable

GP-4106 (COM1)
GP-4116T (COM1) 24G User-created cable The cable length must 

be 500m or less.

GP-4107 (COM1)
GP-4*03T*5 (COM2)
GP-4203T (COM1)

24H User-created cable The cable length must 
be 500m or less.

GP4000*6 (COM2)
GP-4201T (COM1)
GP6000 (COM2)
SP5000 (COM1/2)*7 
(COM1/2)
SP-5B00 (COM2)
ST6000*8 (COM2)
ST-6200 (COM1)
STM6000 (COM1)
STC6000 (COM1)
PS6000 (Basic Box) 
(COM1/2)

24I

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1*9

+
User-created cable

The cable length must 
be 500m or less.

24B User-created cable
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LT-4*01TM (COM1)
LT-Rear Module 
(COM1) 24J

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRJR81 The cable length must 

be 200m or less.

PE-4000B*10

PS5000*10

PS6000 (Optional 
Interface)*10

24K User-created cable The cable length must 
be 500m or less.

*1 All GP3000 models except AGP-3302B

*2 Except AST-3211A and AST-3302B

*3 All GP3000 models except GP-3200 series and AGP-3302B

*4 Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000,
and PS6000)
 IPC COM Port (page 9)

*5 Except GP-4203T

*6 All GP4000 models except GP-4100 Series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7 Except SP-5B00

*8 Except ST-6200

*9 When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 24A.

*10 Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
 IPC COM Port (page 9)

Display
(Connection Port)

Cable Notes
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24A)

• 1:1 Connection

• 1:n Connection

Display
RDA

RDB

SDA

SDB

SG

FG

CA3-ADPTRM-01

CA3-ADPCOM-01

5

4

2

External Device
RJ45 port

Display side
Terminal block

ShieldSignal
name

Pin

YB(+)

YA(-)

SG

Signal
name

User-created cable

Display
RDA

RDB

SDA

SDB

SG

FG

CA3-ADPTRM-01

CA3-ADPCOM-01

Display side
Terminal block

ShieldSignal
name

Shield

User-created cable

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name
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24B) 

• 1:1 Connection

• 1:n Connection

Display side

Shield
Signal
name

1

2

3

7

5

4

8

9

6

Shell

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

FG

Pin

D-sub 9 pin (socket)

Display 5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

Display side

Shield
Signal
name

1

2

3

7

5

4

8

9

6

Shell

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

FG

Pin

D-sub 9 pin (socket)

Shield

Display 5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name
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24C)

• 1:1 Connection

• 1:n Connection

Display
RDA

RDB

SDA

SDB

SG

FG

CA3-ADPTRM-01

CA4-ADPONL-01

Display side
Terminal block

ShieldSignal
name

User-created cable

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

Display
RDA

RDB

SDA

SDB

SG

FG

CA3-ADPTRM-01

CA4-ADPONL-01

Display side
Terminal block

ShieldSignal
name

Shield

User-created cable

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name



General MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 270

24D)

• 1:1 Connection

• 1:n Connection

Display
RDA

RDB

SDA

SDB

SG

TERMTX

FG

CA4-ADPONL-01

Display side

ShieldSignal
name

2

7

3

8

5

9

Shell

Pin

D-sub 9 pin (plug)

User-created cable

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

Display
RDA

RDB

SDA

SDB

SG

TERMTX

FG

CA4-ADPONL-01

Display side

ShieldSignal
name

2

7

3

8

5

9

Shell

Pin

D-sub 9 pin (plug)

Shield

User-created cable

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name
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24E)

• 1:1 Connection

• 1:n Connection

Display
RDA

RDB

SDA

SDB

SG

FG

CA3-ADPTRM-01

CA3-ADPCOM-01

Display side
Terminal block

ShieldSignal
name

User-created cable

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

Display
RDA

RDB

SDA

SDB

SG

FG

CA3-ADPTRM-01

CA3-ADPCOM-01

Display side
Terminal block

ShieldSignal
name

Shield

User-created cable

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name
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24F)

• 1:1 Connection

• 1:n Connection

Display side

Shield
Signal
name

1

2

3

7

5

4

8

9

6

Shell

DATA+

DATA-

NC

NC

GND(SG)

ERA

CSA

ERB

CSB

FG

Pin

D-sub 9 pin (socket)

Display

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

Display side

Shield
Signal
name

1

2

3

7

5

4

8

9

6

Shell

DATA+

DATA-

NC

NC

GND(SG)

ERA

CSA

ERB

CSB

FG

Pin

D-sub 9 pin (socket)

Shield

Display

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name



General MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 273

24G) 

• 1:1 Connection

• 1:n Connection

Shield
Signal
name

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

Display

Display side 
Terminal block

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

Shield
Signal
name

RDA

RDB

SDA

SDB

SG

ERA

CSA

ERB

CSB

Shield

Display

Display side 
Terminal block

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name
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24H)

• 1:1 Connection

• 1:n Connection

• The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS 
connector. Do not use it for other devices.

• In COM on the GP-4107, the SG and FG terminals are isolated.

Shield

Display

Pin Signal name

NC

NC

GND(SG)

RS(RTS)

5V

NC

NC

FG

LINE(+)

LINE(-)

3

8

1

2

5

4

6

7

9

Shell

Display side
D-Sub 9pin (plug)

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

Shield Shield

Display

Pin Signal name

NC

NC

GND(SG)

RS(RTS)

5V

NC

NC

FG

LINE(+)

LINE(-)

3

8

1

2

5

4

6

7

9

Shell

Display side
D-Sub 9pin (plug)

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name
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24I)

• 1:1 Connection

• 1:n Connection

Display
RDA

RDB

SDA

SDB

SG

FG

PFXZCBADTM1

Display side
Terminal block

ShieldSignal
name

User-created cable

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

Display
RDA

RDB

SDA

SDB

SG

FG

PFXZCBADTM1

Display side
Terminal block

ShieldSignal
name

Shield

User-created cable

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name
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24J)

• 1:1 Connection

• 1:n Connection

Number Name Notes

(1)
RJ45 RS-485 Cable (5m) by Pro-face

PFXZLMCBRJR81

Display

GND

D0

D1

(1)

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

Shield
Display

GND

D0

D1

(1)

User-created Cable

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name
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24K)

• 1:1 Connection

• 1:n Connection

Shield

Display

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

Display side

Signal
name

2

1

3

7

5

4

8

9

6

Shell

DATD+

DATA-

NC

NC

GND

NC

NC

NC

NC

FG

Pin

D-sub 9 pin (socket)

Shield

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
nameShield

Display

5

4

2

External Device
RJ45 port

Pin

YB(+)

YA(-)

SG

Signal
name

Display side

Signal
name

2

1

3

7

5

4

8

9

6

Shell

DATD+

DATA-

NC

NC

GND

NC

NC

NC

NC

FG

Pin

D-sub 9 pin (socket)
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7 Supported Device

Range of supported device address is shown in the table below. Please note that the actually supported range of 

the devices varies depending on the External Device to be used. Please check the actual range in the manual of 

your External Device.

7.1 MODBUS Series

: This address can be specified as system data area.

Device Bit Address Word Address
32
bits

Remarks

Coil 000001 - 065536 000001 - 065521

or

*1

*1 Whether the data is stored as higher or lower is determined by the [Double Word word order] setting in [Device
Setting].
"5.1 Setup Items in GP-Pro EX" (page 79)

 

Discrete Input 100001 - 165536 100001 - 165521  *2

*2 Write disable.

Input Register ----- 300001 - 365536  *2

Holding Register 400001,00 - 
465536,15 400001 - 465536  *3

*3 An access method at the time of Bit Set varies depending on the [Rest of the bits in this word] setting of [Device
Setting].

"Clear"........................................

"Do not clear"............................. 400001,00 - 465536,15

Input Register ----- D300001 - D365535  *2

Holding Register D400001,00 - 
D465535,31 D400001 - D465535  *4

*4 An access method at the time of Bit Set varies depending on the [Rest of the bits in this word] setting of [Device
Setting].

"Clear"........................................

"Do not clear"............................. D400001,00 - D465535,31

• GP-Pro EX simulation does not synchronize the coil bit address and word address values.



General MODBUS SIO Master Driver

GP-Pro EX Device/PLC Connection Manual 279

 IEC61131 Syntax Address Description
The following table compares IEC61131 and MODBUS syntax address descriptions.

Device

MODBUS Syntax IEC61131 Syntax

Format

0-based 1-based

Format Range
First 

element
Range

First 
element

Range
First 

element

Coil 000001+i i = 0 to 
65535 000001 %Mi i = 0 to 

65535 %M00000 i = 1 to 
65536 %M00001

Discrete Input 100001+i i = 0 to 
65535 100001 - - - - -

Input Register 
(Word) 300001+i i = 0 to 

65535 300001 - - - - -

Input Register 
(Word bit) 300001+i,j

i = 0 to 
65535
j = 0 to 
15

300001,00 - - - - -

Holding 
Register 
(Word)

400001+i i = 0 to 
65535 400001 %MWi i = 0 to 

65535 %MW00000 i = 1 to 
65536 %MW00001

Holding Register 
(Word bit) 400001+i,j

i = 0 to 
65535
j = 0 to 
15

400001,00 %Mwi:
Xj

i = 0 to 
65535
j=0 to 15

%MW00000
:X00

i = 1 to 
65536
j=0 to 15

%MW00001
:X00

Input Register 
(D Word) D300001+i i = 0 to 

65534 D300001 - - - - -

Input Register 
(D Word bit) D300001+i,j

i = 0 to 
65534
j = 0 to 
31

D300001,00 - - - - -

Holding 
Register (D 
Word)

D400001+i i = 0 to 
65534 D400001 %MDi i = 0 to 

65534 %MD00000 i = 1 to 
65535 %MD00001

Holding Register 
(D Word bit) D400001+i,j

i = 0 to 
65534
j = 0 to 
31

D400001,00 %MDi:Xj
i = 0 to 
65534
j=0 to 31

%MD00000
:X00

i = 1 to 
65535
j=0 to 31

%MD00001
:X00

• The addresses 100000 and 300000 cannot be accessed using IEC61131 syntax.
• If you apply IEC61131 syntax to a project that has a discrete input or input register already set, 

the addresses become "-Undefined-" and invalid.

• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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7.2 MICRO-EHV Series

: This address can be specified as system data area.

Device Bit Address Word Address
32
bits

Address notation 
in External Device

Remarks

Coil 000257 - 000288 000257 - 000273

*1

*1 Whether the data is stored as higher or lower is determined by the [Double Word word order] setting in [Device
Setting]. Set to [Low word first(L/H)].
"5.1 Setup Items in GP-Pro EX" (page 79)

Y0100 - Y0131  

Discrete Input 100001 - 100047 100001 - 100002 X0000 - X0046  *2

*2 Write disable.

Input Register ----- 300001 - 302048 WM000 - WM7FF  *2

Holding Register 400001.00 - 
432768.15 400001 - 432768 WR0000 - 

WR7FFF  

Input Register ----- D300001 - 
D302047 DM000 - DM7FE  *2

Holding Register D400001.00 - 
D432767.31

D400001 - 
D432767

DR0000 - 
DR7FFE  

• GP-Pro EX simulation does not synchronize the coil bit address and word address values.
• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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7.3 FX3S Series

: This address can be specified as system data area.

Device Bit Address Word Address
32
bits

Address notation in 
External Device

Remarks

Holding Register 400001,00 - 
403000,15 400001 - 403000 

*1

D0000 - D2999

Holding Register 408001,00 - 
408512,15 408001 - 408511 D8000 - D8511

Holding Register 441281,00 -  
441418,15 441281 - 441418 TN000 - TN137

Holding Register 441793,00 - 
441824,15 441793 - 441824 CN00 - CN31

Holding Register 441993,00 - 
442104,15 441993 - 442104 CN200 - CN255

Holding Register 442105,00 - 
442200,15 442105 - 442200 M0000 - M1535

Holding Register 442585,00 - 
442616,15 442585 - 442616 M8000 - M8511

Holding Register 442617,00 - 
442632,15 442617 - 442632 S000 - S255

Holding Register 442873,00 - 
442881,15 442873 - 442881 TS000 - TS137

Holding Register 442905,00 - 
442906,15 442905 - 442906 CS00 - CS31

Holding Register 442917,00 - 
442920,15 442917 - 442920 CS200 - CS255

Holding Register 442921,00 - 
442921,15 442921 - 442921 Y00 - Y15

Input Register 300001,00 - 
303000,15 300001 - 303000 D0000 - D2999

Input Register 308001,00 - 
308512,15 308001 - 308511 D8000 - D8511

Input Register 341281,00 - 
341418,15 341281 - 341418 TN000 - TN137

Input Register 341793,00 - 
341824,15 341793 - 341824 CN00 - CN31

Input Register 341993,00 - 
342104,15 341993 - 342104 CN200 - CN255

Input Register 342105,00 - 
342200,15 342105 - 342200 M0000 - M1535

Input Register 342585,00 - 
342616,15 342585 - 342616 M8000 - M8511

Input Register 342617,00 - 
342632,15 342617 - 342632 S000 - S255
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Input Register 342873,00 - 
342881,15 342873 - 342881

*1

TS000 - TS137

Input Register 342905,00 - 
342906,15 342905 - 342906 CS00 - CS31

Input Register 342917,00 - 
342920,15 342917 - 342920 CS200 - CS255

Input Register 342921,00 - 
342921,15 342921 - 342921 Y00 - Y15

Input Register 342937,00 - 
342937,15 342937 - 342937 X00 - X17

Holding Register D400001,00 - 
D402999,31

D400001 - 
D402999

D0000 - 
D2999(DWord 

address)

Holding Register D408001,00 - 
D408511,31

D408001 - 
D408511

D8000 - 
D8511(DWord 

address)

Input Register D300001,00 - 
D302999,31

D300001 - 
D302999

D0000 - 
D2999(DWord 

address)

Input Register D308001,00 - 
D308511,31

D308001 - 
D308511

D8000 - 
D8511(DWord 

address)

Coil 000001 - 001536 000001 - 001521 M0000 - M1535

Coil 007681 - 008192 007681 - 008177 M8000 - M8511

Coil 008193 - 008448 008193 - 008433 S000 - S255

Coil 012801 - 012833 012801 - 012817 C00 - C31

Coil 012289 - 012426 012289 - 012411 T000 - T137

Coil 013001 - 013056 013001 - 013033 C200 - C255

Coil 013057 - 013070 13057 Y000 - Y015

Discrete Input 100001 - 101536 100001 - 101521 M0000 - M1535

Discrete Input 107681 - 108192 107681 - 108177 M8000 - M8511

Discrete Input 108193 - 108448 108193 - 108433 S000 - S255

Discrete Input 012801 - 012833 012801 - 012817 C00 - C31

Discrete Input 112289 - 112426 112801 - 112832 T000 - T137

Discrete Input 113001 - 113056 112801 - 112817 C200 - C255

Discrete Input 113057 - 113070 113057 Y000 - Y015

Discrete Input 113313 - 113328 113313 X000 - X017

*1 Whether the data is stored as higher or lower is determined by the [Double Word word order] setting in [Device
Setting]. Set to [Low word first(L/H)].
"5.1 Setup Items in GP-Pro EX" (page 79)

Device Bit Address Word Address
32
bits

Address notation in 
External Device

Remarks
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• GP-Pro EX simulation does not synchronize the coil bit address and word address values.
• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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7.4 MSEP-LC

: This address can be specified as system data area.

Device Bit Address Word Address
32
bits

Address notation in 
External Device

Remarks

Holding Register 405137.00 - 
405200.15 405137 - 405200

*1

*1 Whether the data is stored as higher or lower is determined by the [Double Word word order] setting in [Device
Setting]. Set to [Low word first(L/H)].
"5.1 Setup Items in GP-Pro EX" (page 79)

D0000 - D0063

Holding Register 405265.00 - 
405296.15 405265 - 405296 SD0000 - SD0031 *2

Holding Register 404097.00 - 
404098.15 404097 - 404098 IX0000 - IX0001

Holding Register 404129.00 - 
404132.15 404129 - 404132

X0000 - X003F *2

Coil 004097 - 004160 004097 - 004145

Holding Register 404161.00 - 
404164.15 404161 - 404164

Y0000 - Y003F *2

Coil 004609 - 004672 004609 - 004657

Holding Register 404353.00 - 
404544.15 404353 - 404544

M0000 - M3071
Coil 007681 - 010752 007681 - 010737

Holding Register 404865.00 - 
404872.15 404865 - 404872

SM0000 - SM0127 *2

Coil 015873 - 016000 015873 - 015985

Holding Register 404881.00 - 
404882.15 404881 - 404882

TS0000 - TS0031 *2

Coil 016129 - 016160 016129 - 016145

Holding Register 404945.00 - 
404946.15 404945 - 404946

TC0000 - TC0031 *2

Coil 017153 - 017184 017153 - 017169

Holding Register 405329 - 405360 405329 - 405360 TV0000 - TV0031 *2

Holding Register 405393 - 405424 405393 - 405424 TP0000 - TP0031 *2

Holding Register 405009.00 - 
405010.15 405009 - 405010

CS0000 - CS0031 *2

Coil 018177 - 018208 018177 - 018193

Holding Register 405073.00 - 
405074.15 405073 - 405074

CC0000 - CC0031 *2

Coil 019201 - 019232 019201 - 019217

Holding Register 405521.00 - 
405552.15 405521 - 405552 CV0000 - CV0031 *2

Holding Register 405457.00 - 
405488.15 405457 - 405488 CP0000 - CP0031 *2
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*2 Write disable.

• GP-Pro EX simulation does not synchronize the coil bit address and word address values.
• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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7.5 RCON Series

: This address can be specified as system data area.

Device Bit Address Word Address
32
bits

Remarks

Device0:
Coil 000001 - 065536 000001 - 065521

Device1:
Discrete Input 100001 - 165536 100001 - 165521  *1

*1 Write disable.

Device3:
Input register ----- 300001 - 365536  *1

Device4:
Holding register 400001.00 - 465536.15 400001 - 465536  

• GP-Pro EX simulation does not synchronize the coil bit address and word address values.
• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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7.6 KV-7000, KV-8000 Series

: This address can be specified as system data area.

Device Bit Address Word Address
32
bits

Remarks

Coil 00000 - 65535 -----

Input 00000 - 65535 -----  *1

*1 Write disable.

Holding register ----- 00000 - 65535  

Input register ----- 00000 - 65535 *1

• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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7.7 CP Series

: This address can be specified as system data area.

Device MODBUS Address
Address Specified in 

Modbus-RTU 
Commands

Corresponding CP2E 
I/O Memory Address

Discrete Input ----- ----- -----

Coil 0001 - 2048 0000 - 2047 W000.00 - W127.15

Input register ----- ----- -----

Holding register

0001 - 4096 0000 - 4095 D0000 - D4095*1

*1 CP2E-E-type

0001 - 8192 0000 - 8191 D0000 - D8191*2

*2 CP2E-S-type

00001 - 16384 00000 - 16383 D00000 - D16383*3

*3 CP2E-N-type

• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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7.8 FP0H Series

: This address can be specified as system data area.

Device MODBUS Reference No.
Data on BUS 

(Hexadecimal)
FP0H Device No.

Coil
000001 - 001760 0000 - 06DF Y0000 - Y109F

002049 - 010240 0800 - 27FF R0000 - R511F

Input 100001 - 101760 0000 - 06DF X0000 - X109F

Holding register 400001 - 465533 0000 - FFFC DT00000 - DT65532

Input register
300001 - 300128 0000 - 007F WL000 - WL127

302001 - 302256 07D0 - 08CF LD000 - LD255

• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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7.9 FR-A800, FR-F800, A800Pluse Series

: This address can be specified as system data area.

Device Bit Address Word Address
32
bits

Remarks

Device0:
Coil ----- -----

or

Device1:
Discrete Input ----- -----  *1

*1 Write disable.

Device3:
Input register ----- -----  *1

Device4:
Holding register 400001 - 409999 400001 - 409999  *2

*2 If the inverter type is FR-A820-0.4k-1, the maximum address will be 45499.

• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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7.10 FR-E800 Series

: This address can be specified as system data area.

Device Bit Address Word Address
32
bits

Remarks

Device0:
Coil ----- -----

or

Device1:
Discrete Input ----- -----  *1

*1 Write disable.

Device3:
Input register ----- -----  *1

Device4:
Holding register 400001 - 409999 400001 - 409999  *2

*2 If the inverter type is FR-A820-0.4k-1, the maximum address will be 405999.

• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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7.11 ACD-13A, ACR-13A Series

: This address can be specified as system data area.

Device Bit Address Word Address
32
bits

Remarks

Holding register 400002,00 - 408280,15 400002 - 408280

• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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7.12 BCD2R00-06, BCR2R00-06

: This address can be specified as system data area.

Device Bit Address Word Address
32
bits

Remarks

Input register 300257,00 - 300276,15 300257 - 300276

Holding register 400002,00 - 404144,15 400002 - 404144

• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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7.13 BCS2R00-06

: This address can be specified as system data area.

Device Bit Address Word Address
32
bits

Remarks

Input register 300257,00 - 300276,15 300257-300276

Holding register 400002,00 - 404123,15 400002-404123

• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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7.14 PCA1 Series

: This address can be specified as system data area.

Device Bit Address Word Address
32
bits

Remarks

Holding register 400002,00 - 432513,15 400002 - 432513

• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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7.15 PCB1 Series

: This address can be specified as system data area.

Device Bit Address Word Address
32
bits

Remarks

Data item 400002,00 - 436878,15 400002 - 436878

• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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7.16 QTC1-4 Series

: This address can be specified as system data area.

Device Bit Address Word Address
32
bits

Remarks

Holding register 400001,00 - 401325,15 400001 - 401325

• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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7.17 QMC1 Series

: This address can be specified as system data area.

Device Bit Address Word Address
32
bits

Remarks

Holding register 400001,00 - 464128,15 400001 - 464128

• Refer to the GP-Pro EX Reference Manual for system data area.

Cf. GP-Pro EXReference Manual "LS Area (Direct Access Method Area)"

• Refer to the precautions on manual notation for icons in the table.

"Manual Symbols and Terminology"
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8 Device Code and Address Code

Use device code and address code when you set "Device Type & Address" for the address type of the data display 

or other devices.

Device Device Name
Device Code

(HEX)
Address Code

Coil 0 0080 Value of (word address -1) divided by 16

Discrete Input 1 0081 Value of (word address -1) divided by 16

Input Register 3 0001 Value of (word address - 1)

Holding Register 4 0000 Value of (word address - 1)

Input Register D3 0002 Value of (word address -1) divided by 2

Holding Register D4 0003 Value of (word address -1) divided by 2
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9 Error Messages

Error messages are displayed on the screen of Display as follows: "No. : Device Name: Error Message (Error 

Occurrence Area)". Each description is shown below.

Display Examples of Error Messages

"RHAA035: PLC1: Error has been responded for device write command (Error Code: 2[02H])"

 Error Codes Specific to the External Device
Please refer to the manual of the External Device for error codes specific to the External Device.

General MODBUS error codes are shown below.

Item Description

No. Error Number.

Device Name Name of the External Device where an error has occurred. The Device name is the title of 
the External Device set with GP-Pro EX.(Initial value [PLC1])

Error Message Displays messages related to an error that has occurred.

Error Occurrence Area

Displays the IP address or device address of the External Device where an error has 
occurred, or error codes received from the External Device.

• IP address is displayed as "IP address (Decimal): MAC address (Hex)".
• Device address is displayed as "Address: Device address".
• Received error codes are displayed as "Decimal [Hex]".

• Refer to your External Device manual for details on received error codes.
• Refer to "Display-related errors" in "Maintenance/Troubleshooting Guide" for details on the 

error messages common to the driver.

Error Code
(HEX)

Description

01 Does not support the corresponding Function Code.

02 The specified data address does not exist.

03 Data value error.
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 Error Messages Specific to the External Device

Error Number Error Message Description

RHxx128 (Node Name): (Device Address) can't be read 
because of the limitation of the Read boundary

When reading the coil or discrete input as a 
word address while the boundary is less 
than 16 bits, or accessing the input or 
holding register as a double word while the 
boundary is set to 1 word, an error will be 
displayed.

RHxx129
(Node Name): (Device Address) can't be 
written because of the limitation of the Write 
boundary

When writing the coil as a word address 
while the boundary is less than 16 bits, or 
accessing the holding register as a double 
word while the boundary is set to 1 word, 
an error will be displayed.

RHxx130 (Node Name): (Device Address) is not defined 
on Function Code and Max Query setting

When accessing the device out of the 
defined area, an error will be displayed.

RHxx131
(Node Name): (Device Address) can't be read 
because of the limitation of the Device Range 
setting

When reading the coil or discrete input as a 
word address while the range is less than 16 
bits, or accessing the input or holding 
register as a double word while the range is 
set to 1 word, an error will be displayed.

RHxx132
(Node Name): (Device Address) can't be 
written because of the limitation of the Device 
Range setting

When writing the coil as a word address 
while the range is less than 16 bits, or 
accessing the holding register as a double 
word while the range is set to 1 word, an 
error will be displayed.
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